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Copyright and Trademark Notice 
Thecus and other names of Thecus products are registered trademarks of Thecus 
Technology Corp. Microsoft, Windows, and the Windows logo are registered 
trademarks of Microsoft Corporation. Apple, iTunes and Apple OS X are registered 
trademarks of Apple Computers, Inc. All other trademarks and brand names are 
the property of their respective owners. Specifications are subject to change 
without notice. 
 
Copyright © 2008 Thecus Technology Corporation. All rights reserved. 
 

About This Manual 
All information in this manual has been carefully verified to ensure its correctness. 
In case of an error, please provide us with your feedback.  Thecus Technology 
Corporation reserves the right to modify the contents of this manual without 
notice. 
 
Product name: Thecus N8800 
Manual Version: 1.02 
Release Date: December 2008 
 

Limited Warranty 
Thecus Technology Corporation guarantees all components of Thecus N8800 are 
thoroughly tested before they leave the factory and should function normally 
under general usage.  In case of any system malfunctions, Thecus Technology 
Corporation and its local representatives and dealers are responsible for repair 
without cost to the customer if the product fails within the warranty period and 
under normal usage. Thecus Technology Corporation is not responsible for any 
damage or loss of data deemed to be caused by its products. It is highly 
recommended that users conduct necessary back-up practices. 
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Safety Warnings 
 
For your safety, please read and follow the following safety warnings: 
 

 Read this manual thoroughly before attempting to set up your N8800. 
 

 Your N8800 is a complicated electronic device. DO NOT attempt to repair it 
under any circumstances. In the case of malfunction, turn off the power 
immediately and have it repaired at a qualified service center. Contact 
your vendor for details. 

 
 DO NOT allow anything to rest on the power cord and DO NOT place the 
power cord in an area where it can be stepped on. Carefully place 
connecting cables to avoid stepping or tripping on them. 

 
 Your N8800 can operate normally under temperatures between 0°C and 
40°C, with relative humidity of 20% – 85%. Using the N8800 under 
extreme environmental conditions could damage the unit. 

 
 Ensure that the N8800 is provided with the correct supply voltage (AC 
100V ~ 240V, 50/60 Hz, 3A). Plugging the N8800 to an incorrect power 
source could damage the unit. 

 
 Do NOT expose the N8800 to dampness, dust, or corrosive liquids. 

 
 Do NOT place the N8800 on any uneven surfaces. 

 
 DO NOT place the N8800 in direct sunlight or expose it to other heat 
sources. 

 
 DO NOT use chemicals or aerosols to clean the N8800. Unplug the power 
cord and all connected cables before cleaning.  

 
 DO NOT place any objects on the N8800 or obstruct its ventilation slots to 
avoid overheating the unit. 

 
 Keep packaging out of the reach of children. 

 
 If disposing of the device, please follow your local regulations for the safe 
disposal of electronic products to protect the environment. 
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Chapter 1: Introduction 

Overview 
Thank you for choosing the Thecus N8800 IP Storage Server. The Thecus N8800 
is an easy-to-use storage server that allows a dedicated approach to storing and 
distributing data on a network. Data reliability is ensured with RAID features that 
provide data security and recovery—over one Terabyte of storage is available 
using RAID 5 and RAID 6. Gigabit Ethernet ports enhance network efficiency, 
allowing the N8800 to take over file management functions, increase application 
and data sharing and provide faster data response. The N8800 offers data 
mobility with a disk roaming feature that lets you hot swap working hard drives 
for use in another N8800, securing the continuity of data in the event of hardware 
failure. The N8800 allows data consolidation and sharing between Windows 
(SMB/CIFS), UNIX/Linux, and Apple OS X environments. The N8800’s user-
friendly GUI supports multiple languages. 

Product Highlights 

File Server 
First and foremost, the N8800 allows you to store and share files over an IP 
network. With a Network Attached Storage (NAS) device, you can centralize your 
files and share them easily over your network. With the easy-to-use web-based 
interface, users on your network can access these files in a snap. 
 
To learn about the Web User Interface, go to Chapter 6: Using the N8800 > 
Using WebDisk. 

FTP Server 
With the built-in FTP Server, friends, clients, and customers can upload and 
download files to your N8800 over the Internet with their favorite FTP programs. 
You can create user accounts so that only authorized users have access.  
 
To set up the FTP Server, refer to Chapter 5: Additional Feature Setup > FTP 
Server. 

Backup Server 
Don’t leave precious data to chance. With advanced backup capabilities, you can 
easily upload mission critical files to the N8800, and even automate your backup 
tasks for true peace-of-mind. 
 
To find out how to backup your files with the N8800, refer to Chapter 6: Using 
the N8800 > File Backup. 

Printer Server 
With the N8800’s Printer Server, you can easily share an IPP printer with other 
PCs connected to your network.  
 
To set up the Printer Server, refer to Chapter 5: Additional Feature Setup > 
Printer Server. 
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Multiple RAID 
N8800 supports multiple RAID volumes on one system. So, you can create RAID 
0 for your non-critical data, and create RAID 5 for mission-critical data. Create 
the RAID levels depending on your needs.   
 
To configure RAID modes on the N8800, refer to Chapter 4: System 
Management > Storage Management > RAID List. 

Dual Mode Support 
N8800 is not only a file server, but it also supports iSCSI initiators. Your server 
can access N8800 as a direct-attached-storage over the LAN or Internet. There is 
no easier way to expand the capacity of your current application servers. All the 
storage needs can be centrally managed and deployed. This brings ultimate 
flexibility to users. 
 
To set up an iSCSI volume, refer to Chapter 4: System Management > 
Storage Management > Space Allocation > Allocating Space for iSCSI 
Volume. 

Superior Power Management 
N8800 supports schedule power on/off. With this feature, administrator can set at 
what time to turn on or off the system. This feature is a big plus for people who 
want to conserve energy. Wake-On-LAN enables administrator to remotely turn 
on the system without even leaving their own seat. 
 
To schedule system on and off, refer to Chapter 4: System Management > 
System Settings > Reboot and Shutdown System > Scheduled Power 
On/Off. 
 
 

Package Contents 
Your N8800 package should contain the following items: 
 
z QIG 
z CD-Title 
z Ethernet Cable 
z Screw Kit 
z Rack slider 
 
Please check to see if your package is complete. If you find that some items are 
missing, contact your dealer. 



Front Panel 
The Thecus N8800’s front panel has the device’s controls, indicators, and hard 
disk trays: 
 

 
 

Front Panel 
Item Description 
1.Power Button • Power on/off N8800 
2.Power LED • Solid green: System is power on.  
3.Reboot Button • Press to system reboot 
4.System fan 
alarm LED 

• Solid red: system fan failure notification 

5. Mute button • Mute the system fan alarm. 
6.USB Port 
 

• USB 2.0 port for compatible USB devices, such as USB disks, 
USB printers, and USB wireless dongles* 

 
Note: For supported USB wireless dongles, please contact 
http://esupport.thecus.com/support  

7.Up Button ▲ • Push to scroll up when using the LCD display 

8.Down Button ▼ • Push to enter USB copy operation screen  

9.Enter Button ↵ • Push to enter LCD operate password for basic system setting  

10.Escape Button 
ESC 

• Push to leave the current LCD menu 
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http://esupport.thecus.com/support


Hard Disk Trays 
Each of the N8800’s hard disk trays has a lock, a latch, and two LED indicators: 
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Hard Disk Trays 
Item Description 
1.HDD Power LED • Solid blue: hard disk is powered on 
2.HDD 
Access/Error LED 

• Blinking green: system is accessing data on the hard disk 

3.Lock • Use the lock to physically secure the hard disk to the unit 
4.Latch • Use to open and remove or close and secure the tray 
5.Handle • Pull out HDD tray 

 

Rear Panel  
The Thecus ’s rear panel features ports and connectors. 
 

 
 

 Back Panel 
Item Description 
1.Power Connector • Connect the included power cords to these connectors 
2.Power Switch • Switch for power supply 
3.eSATA Port • eSATA port for high-speed storage expansion 
4.USB Port • USB 2.0 port for compatible USB devices, such as USB disks, 

and USB printers 
5.Serial Port • This port is for external UPS device 
6.WAN Port • WAN port for connecting to an Ethernet network through a 

switch or router 
7.LAN Port • LAN port for connecting to an Ethernet network through a switch 

or router  

4 53
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 Chapter 2: Hardware Installation 

Overview 
Your N8800 is designed for easy installation. To help you get started, the 
following chapter will help you quickly get your N8800 up and running. Please 
read it carefully to prevent damaging your unit during installation. 

Before You Begin 
Before you begin, be sure to take the following precautions: 
 

1. Read and understand the Safety Warnings outlined in the beginning of 
the manual. 

 
2. If possible, wear an anti-static wrist strap during installation to prevent 

static discharge from damaging the sensitive electronic components on the 
N8800. 

 
3. Be careful not to use magnetized screwdrivers around the N8800’s 

electronic components. 

Hard Disk Installation 
The N8800 supports seven standard 3.5” Serial ATA (SATA) hard disks. To install 
a hard disk into the N8800, follow the steps below: 
 

1. Remove a hard disk tray from the N8800. 
 
2. Slide the new SATA hard disk into the tray and fasten the screws. 

 
3. Insert the hard disk and tray back into the N8800 until it snaps into place 

and lock it with a key if desired. 
 

4. The LED blinks green when the hard disk is accessed.  
 

If your HDD was part of a RAID 1 or RAID 5 array previously, it 
automatically rebuilds. If you replace all the drives with higher capacity 
drives, you will need to go to Administrator login and format the drives. 

NOTE  
 
 

 
 
 

12 



Cable Connections 
To connect the N8800 to your network, follow the steps below: 
 

1. Connect an Ethernet cable from your network to the WAN port on the back 
panel of the N8800. 
 

 
 

 
2. Connect the provided power cord into the universal power socket on the 

back panel. Plug the other end of the cord into a surge protector socket. 
Press the power supply switch to turn on the power supply.  

   

 
 

 
3. Press the power button on the Front Panel to boot up the N8800.  
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Checking System Status 
After making connections on the N8800 and powering up, check whether the 
system status is normal or has trouble by observing indicators on the front panel 
and hard disk trays. 
 

System Status Normal 
The system status is normal if: 
 

1. The Power LED on the Front Panel glows green. 
2. The HDD Power LED on each HDD tray glows blue (assuming all disks are 

installed). 
3. The default IP address of the WAN port is 192.168.1.100 on LCD. 

 

 

System Trouble 
The system has trouble if: 
 

1. Disk Busy LED glows red. 

 
 

If the system has trouble, please refer to Chapter 8: Troubleshooting. 
 
 
 

There are no user serviceable parts inside the N8800. Please contact 
your distributor for service. WARNING  
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 Chapter 3: First Time Setup 

Overview 
Once the hardware is installed, physically connected to your network, and 
powered on, you can configure the N8800 so that it is accessible to your network 
users. There are two ways to set up your N8800: using the Thecus Setup 
Wizard or the LCD display. Follow the steps below for initial software setup. 

Thecus Setup Wizard 
The handy Thecus Setup Wizard makes configuring N8800 a snap. To configure 
the N8800 using the Setup Wizard, perform the following steps: 
 

1. Insert the installation CD into your CD-ROM drive (the host PC must be 
connected to the network). 

 
2. The Setup Wizard should launch automatically. If not, please browse your 

CD-ROM drive and double click on Setup.exe. 
 

 
 
 
 
 
 

 

NOTE 
 
For MAC OS X users, double click on Thecus Setup 

 
 Wizard 1.1.99.dmg 

 
 

3. The Setup Wizard will start and automatically detect all Thecus storage 
devices on your network. If none are found, please check your connection 
and refer to Chapter 8: Troubleshooting for assistance. 

 

 
 

4. Select the N8800 that you like to configure. 
 

5. Login with the administrator account and password. The default account 
and password are both “admin”.  

 
 

 
 
 

15 



 

 
 
 

6. Name your N8800 and configure the network IP address. If your switch or 
router is configured as a DHCP Server, configuring the N8800 to 
automatically obtain an IP address is recommended. You may also use a 
static IP address and enter the DNS Server address manually.  

 
 

 
 

7. Change the default administrator password. 
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8. Finished! Access the N8800 Web Administrator Interface by pressing the 

Start Browser button. You can also configure another N8800 at this point 
by clicking the Setup Other Device button. Press Exit to exit the wizard. 

 
 

NOTE The Thecus Setup Wizard is designed for installation on systems 
running Windows XP/2000 or Mac OSX or later. Users with other 
operating systems will need to install the Thecus Setup Wizard on a 
host machine with one of these operating systems before using the 
unit.  

 
 
 
 
 

LCD Operation 
The N8800 is equipped with an LCD on the front for easy status display and setup. 
There are four buttons on the front panel to control the LCD functions. 
 

LCD Controls 
Use the Up (▲), Down (▼), Enter (↵) and Escape (ESC) keys to select various 
configuration settings and menu options for N8800 configuration.  
 
The following table illustrates the keys on the front control panel: 
 
LCD Controls 
Icon Function Description 
▲ Up Button Select the previous configuration settings option. 
▼ Down Button USB copy confirmation display. 
↵ Enter Enter the selected menu option, sub-menu, or parameter setting. 
ESC Escape Escape and return to the previous menu. 

 
There are two modes of operation for the LCD: Display Mode and Management 
Mode. 

Display Mode 
During normal operation, the LCD will be in Display Mode. 
 
Display Mode 
Item Description 
Host Name Current host name of the system. 
WAN Current WAN IP setting.  
LAN Current LAN IP setting. 
Link Aggregation Current Link Aggregation status (N8800 only) 
System Fan1 Current system fan 1 status. 
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System Fan2 Current system fan 2 status. 
CPU Fan Current CPU fan status 
2006/06/16 12:00 Current system time. 
Disk Info Current status of disk slot has been installedh 
RAID Current RAID status. 

 
The N8800 will rotate these messages every one-two seconds on the LCD display. 

USB Copy 
The USB Copy function enables you to copy files stored on USB devices such as 
USB disks and digital cameras to the N8800 with a press of a button. To use USB 
copy, follow the steps below: 
 

1. Plug your USB device into an available USB port on the Front Panel. 
 
2. In Display Mode, press the Down Button (▼). 

 
3. The LCD will display “USB Copy?”  

 
4. Press Enter (↵) and the N8800 will start copying USB disks connected to 

the front USB port. 
 

5. All of data will be copied into system folder named “USBcopy”.  

Management Mode 
During setup and configuration, the LCD will be in Management Mode. 
 
To enter into Management Mode, press Enter (↵) and an “Enter Password” 
prompt will show on the LCD. 
 
At this time, the administrator has to enter the correct LCD password. System will 
check whether the correct LCD password has been entered. The default LCD 
password is “0000”. If correct password is entered, you will enter into the 
Management Mode menu. 
 
Management Mode 
Item Description 
WAN Setting IP address and netmask of your WAN ports. 
LAN Setting IP address and netmask of your LAN ports. 
Link Agg. Setting Select Load Balance or Failover. (N8800 only) 
Change Admin Passwd Change administrator’s password for LCD operation. 
Reset to Default Reset system to factory defaults. 
Exit Exit Management Mode and return to Display Mode. 

 
You can also change your LCD password using the Web Administration 
Interface by navigating to System > Administrator Password. For 
more on the Web Administration Interface, see Chapter 4: System 
Management. 

NOTE  
 

Typical Setup Procedure 
From the Web Administration Interface, you can begin to setup your N8800 for 
use on your network. Setting up the N8800 typically follows the five steps 
outlined below. 
 
For more on how to use the Web Administration Interface, see Chapter 4: 
System Management > Web Administration Interface. 
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Step 1: Network Setup 
From the Web Administration Interface, you can configure the network settings of 
the N8800 for your network. You can access the Network menu from the menu 
bar.  
For details on how to configure your network settings, refer to Chapter 4: 
System Management > Network Management. 
 

Step 2: RAID Creation 
Next, administrators can configure their preferred RAID setting and build their 
RAID volume. You can access RAID settings from the menu bar of the Web 
Administration Interface by navigating to Storage > RAID. 
 
For more information on configuring RAID, see Chapter 4: System 
Management > RAID Configuration. 
 
Don’t know which RAID level to use? Find out more about the different RAID 
levels from Appendix C: RAID Basics. 

Step 3: Create Local Users or Setup Authentication 
Once the RAID is ready, you can begin to create local users for the N8800, or 
choose to setup authentication protocols such as Active Directory (AD). 
 
For more on managing users, go to Chapter 4: System Management > User 
and Group Management. 
 
For more information on configuring Active Directory, see Chapter 4: System 
Management > User and Group Management > ADS/NT Configuration. 
 
For information about the benefits of Active Directory, see Appendix D: Active 
Directory Basics. 

Step 4: Create Folders and Set Up ACLs 
Once users are introduced into your network, you can begin to create various 
folders on the N8800 and control user access to each using Folder Access Control 
Lists.  
 
More information on managing folders, see Chapter 4: System Management > 
Folder Management. 
 
To find out about configuring Folder Access Control Lists, see Chapter 4: System 
Management > Folder Management > Folder Access Control List (ACL). 
 

Step 5: Start Services 
Finally, you can start to setup the different services of the N8800 for the users on 
your network. You can find out more about each of these services by clicking 
below: 
 
SMB/CIFS 
 
Apple File Protocol (AFP) 
 
Network File System (NFS) 
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File Transfer Protocol (FTP) 
 
iTunes Server 
 
Media Server 
 
Printer Server 
 
Download Manager 
 
Photo Server 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Chapter 4: System Management 

Overview 
The N8800 provides an easily accessible Web Administration Interface. With it, 
you can configure and monitor the N8800 anywhere on the network. 
 

Web Administration Interface 
Make sure your network is connected to the Internet. To access the N8800 Web 
Administration Interface: 
 

1. Type the N8800’s IP address into your browser. (Default IP address is 
http://192.168.1.100)   

 
 

Your computer’s network IP address must be on the same subnet as 
the N8800. If the N8800 has default IP address of 192.168.1.100, your 
managing PC IP address must be 192.168.1.x, where x is a number 
between 1 and 254, but not 100. 

NOTE  
 
 
 

2. Login to the system using the administrator user name and password. The 
factory defaults are:  

 
User Name: admin 
Password: admin 
 
If you changed your password in the setup wizard, use the new password. 

 
Once you are logged in as an administrator, you will see the Web 
Administration Interface. From here, you can configure and monitor virtually 
every aspect of the N8800 from anywhere on the network. 

Menu Bar 
The Menu Bar is where you will find all of the information screens and system 
settings of the N8800. The various settings are placed in the following groups on 
the menu bar: 
 
Menu Bar 
Item Description 
Status Current system status of the N8800. 
Storage Information and settings for storage devices installed into the 

N8800.  
Network Information and settings for network connections, as well as 

various services of the N8800. 
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Accounts Allows configuration of users and groups. 
System Various N8800 system settings and information. 
Language Choose your preferred language here. 

 
Moving your cursor over any of these items will display the dropdown menu 
selections for each group. 
 
In the following sections, you will find detailed explanations of each function, and 
how to configure your N8800. 
 
 

Language Selection 
The N8800 supports multiple languages, 
including: 
 

• English 
• French 
• German 
• Italian 
• Traditional Chinese 
• Simplified Chinese 
• Japanese 
• Korean 
• Spanish 

 
On the menu bar, click Language and the 
Change Language screen appears. This 
screen allows you to select preferred 
language for the N8800. Press Apply to 
confirm your selection. 
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Status Menu 
The Status Menu on the menu bar allows you to see various aspects of the 
N8800. From here, you can discover the status of the N8800, and even find out 
other details like firmware version and up time.  

Product Information 
Once you login, you will first see the basic 
Product Information screen providing 
Manufacturer, Product No., Firmware 
Version, and Up Time information. 
 
 
 
 
 
 
 
 
 
 
 

Product Information 
Item Description 
Manufacturer Displays the name of the system manufacturer. 
Product No. Shows the model number of the system. 
Firmware version Shows the current firmware version. 
Up time Displays the total run time of the system. 

 
To access this screen again, navigate to Status > About. 

System/Service Status 
From the Status menu, choose the System 
item, and the System Status and Service 
Status screens appear. These screens 
provide basic system and service status 
information. 
 
 
 
 
 
 
System Status 
Item Description 
CPU Loading (%) Displays current CPU workload of the N8800. 
CPU Fan Speed Displays current CPU fan status.  
System Fan1 Speed Displays the current status of the system fan 1. 
System Fan2 Speed Displays the current status of the system fan 2. 
Up Time Shows how long the system has been running. 

 
Service Status 
Item Description 
AFP Status The status of the Apple Filing Protocol server. 
NFS Status The status of the Network File Service Server. 
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SMB/CIFS Status The status of the SMB/CIFS server. 
FTP Status The status of the FTP server. 
Media Server The status of the Media Server 
Nsync Status The status of the Nsync server. 
UPnP Status The status of the UPnP service. 
SNMP The status of the SNMP service. 

System Information 
From Status menu, choose the Info 
item, and the System Information 
screen appears. You can change the 
system information that appears on 
the Login page by entering the new 
information here and pressing Apply 
to confirm. 
 
 
 
 
 
 
 
System Information 
Item Description 
System Description Shows the system description that would also appear on the 

Login page. 

Printer Status 
From the Status menu, choose the 
Printer item, and the Printer 
Information screen appears. This 
screen provides the following 
information about the USB printer 
connected to the USB port. 
 
 
 
 
 
 
 
 
 
 
 
Printer Status 
Item Description 
Manufacturer Displays the name of the USB printer manufacturer. 
Model Displays the model of the USB printer. 
Status Displays the status of the USB printer. 
Remove document 
from Queue 

Click to remove all documents from printer queue 

Restart Printer service Click to restart printer service 
 
If a corrupt print job is sent to a printer, printing may suddenly fail. If your print 
jobs seem to be locked up, pressing the Remove All Documents button to clear 
the print queue may resolve the issue. 
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For information on how to set up the Printer Server, refer to Chapter 5: 
Additional Feature Setup > Printer Server. 
 

UPS Settings 
The N8800 can also support various 
uninterruptible power supply units, 
providing extra data security and 
accessibility in the case of a power failure. 
 
From the Status menu, choose the UPS 
item and the UPS Setting screen appears. 
Make any changes you wish, and press 
Apply to confirm changes. See the 
following table for a detailed description of 
each item. 
 
 
 
 
 
UPS Settings 
Item Description 
UPS Monitoring Enable or disable UPS monitoring. 
Manufacturer Choose the UPS manufacturer and model number 

from the dropdowns. 
Battery Status Current status of the UPS battery 
Power Current status of the power being supplied to the 

UPS 
Seconds between power failure and 
first notification 

Delay between power failure and first notification 
in seconds. 

Seconds between subsequent power 
failure notifications 

Delay between subsequent notifications in 
seconds. 

Shutdown the system when the 
battery charge is less than 

Amount of UPS battery remaining before system 
should auto-shutdown. 

Apply Press Apply to save your changes. 
 
For a list of supported UPS units, see Appendix E: UPS Compatibility List. 
 

Wake-Up On Lan (WOL) 
The N8800 has the ability to be awoken 
from sleep mode via WAN port.  
 
From the Status menu, choose the 
WOL item, and the Wake-up On Lan 
Configuration screen appears. From 
here, you can Enable or Disable. 
 
 
 
 
Wake-up On Lan Configuration 
Item Description 
WOL Servic Enable or Disable WOL service 
Apply Click Apply to save changes. 

 
 
 

25 



 

Power Management 
Using the N8800’s Power 
Management, you can save energy 
and money by scheduling the 
N8800 to turn itself on and off 
during certain times of the day. 
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From the Status menu, choose the 
Power Mgmt item and the 
Schedule Power On/Off screen 
appears.  
 
To designate a schedule for the 
N8800 to turn on and off, first 
enable the feature by checking the 
Enable Schedule Power On/Off 
checkbox.  
 
Then, simply choose an on and off 
time for each day of the week that 
you would like to designate a schedule by using the various dropdowns.  
 
Finally, click Apply to save your changes. 
 
Example - Monday: On: 8:00; Off: 16:00 
System will turn on at 8:00 AM on Monday, and off at 16:00 on Monday. System 
will turn on for the rest of the week. 
 
If you choose an on time, but do not assign an off time, the system will turn on 
and remain on until a scheduled off time is reached, or if the unit is shutdown 
manually. 
 
Example - Monday: On: 8:00 
System will turn on at 8:00 AM on Monday, and will not shut down unless 
powered down manually. 
 
You may also choose two on times or two off times on a particular day, and the 
system will act accordingly. 
 
Example - Monday: Off: 8:00; Off: 16:00 
System will turn off at 8:00 AM on Monday. System will turn off at 16:00 PM on 
Monday, if it was on. If the system was already off at 16:00 PM on Monday, 
system will stay off. 



Storage Management 
The Storage Menu displays the status of storage devices installed in the N8800, 
and includes storage configuration options such as RAID and disk settings, folder 
configuration, and Nsync settings.  

Disks Information 
From the Storage menu, 
choose the Disks item 
and the Disks 
Information screen 
appears. From here, you 
can see various items 
about installed SATA hard 
disks. Blank lines indicate 
that a SATA hard disk is 
not currently installed in 
that particular disk slot.  
 
 
 
 
 
 
 
Disks Information 
Item Description 
Disk No. Indicates disk location. 
Capacity Shows the SATA hard disk capacity. 
Model Displays the SATA hard disk model name. 
Firmware Shows the SATA hard disk firmware version. 
Status Indicates the status of the disk. Can read OK, Warning, or 

Failed. 
Total Capacity Shows the total SATA hard disk capacity. 
Disk Power 
Management 

The administrator can set the disk to power down after a period 
of inactivity. 

 When
on the har
consid

 the Status shows Warning, it usually means there are bad sectors 
d disk. It is shown only as a precaution and you should 

er changing the drives. 
NOTE 

 
 

S.M.A.R.T. Information 
On the Disks Information screen, the status 
of each disk will be displayed in the Status 
column. Clicking on an OK or Warning link 
will display the S.M.A.R.T Information 
window for that particular disk.  
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S.M.A.R.T. Information 
Item Description 
Tray Number Tray the hard disk is installed in. 
Model Model name of the installed hard disk. 
Power ON Hours Count of hours in power-on state. The raw value of this attribute 

shows total count of hours (or minutes, or seconds, depending 
on manufacturer) in power-on state. 

Temperature Celsius The current temperature of the hard disk in degrees Celsius 
Reallocated Sector 
Count 

Count of reallocated sectors. When the hard drive finds a 
read/write/verification error, it marks this sector as "reallocated" 
and transfers data to a special reserved area (spare area). 
This process is also known as remapping and "reallocated" 
sectors are called remaps. This is why, on a modern hard disks, 
you can not see "bad blocks" while testing the surface - all bad 
blocks are hidden in reallocated sectors. However, the more 
sectors that are reallocated, the more a decrease (up to 10% or 
more) can be noticed in disk read/write speeds. 

Current Pending 
Sector 

Current count of unstable sectors (waiting for remapping). The 
raw value of this attribute indicates the total number of sectors 
waiting for remapping. Later, when some of these sectors are 
read successfully, the value is decreased. If errors still occur 
when reading sectors, the hard drive will try to restore the data, 
transfer it to the reserved disk area (spare area), and mark this 
sector as remapped. If this attribute value remains at zero, it 
indicates that the quality of the corresponding surface area is 
low. 

Back Press Back to go back to the Disks Information screen. 
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RAID Information 
From the Storage menu, choose the RAID item and the RAID List screen 
appears.  
 
This screen lists the RAID volumes currently residing on the N8800. From this 
screen, you can get information about the status of your RAID volumes, as well 
as the capacities allocated for data and iSCSI. There is also a graph which 
represents how the RAID volume is currently allocated. 
 
To configure your RAID settings, press the RAID Config button to go to the 
RAID Configuration screen. 
 
RAID Information 
Item Description 
Select Used to select the current RAID volume. 
Master RAID The RAID volume currently designated as the Master RAID 

volume. 
ID ID of the current RAID volume.  

NOTE: All RAID IDs must be unique. 
RAID Level Shows the current RAID configuration. 
Status Indicates status of the RAID. Can read either Healthy, 

Degraded, or Damaged. 
Disks Used Hard disks used to form the current RAID volume. 
Total Capacity Total capacity of the current RAID. 
Data Capacity Indicates the used capacity and total capacity used by user 

data. 

NOTE If the R
disk dr
warni
bad sec
possi

eallocated Sector Count or Current Pending Sector of a hard 
ive is not zero, the status of the disk will show “Warning”. This 

ng is only used to alert the system administrator that there are 
tors on the disk, and they should replace those disks as soon as 

ble. 



iSCSI Capacity Indicates the capacity allocated to iSCSI. 
RAID Config Press this to configure RAID volumes. 
Space Allocation Press this to adjust the space allocated for data and iSCSI. 

RAID Configuration 
On the RAID List screen, press the RAID Config button to go to the RAID 
Configuration screen. In addition to RAID disk information and status, this 
screen lets you make RAID configuration settings.  
 
For more information on RAID, see Appendix C: RAID Basics. 
 
 

RAID Level 
You can set the storage volume as JBOD, RAID 0, RAID 1, RAID 5, RAID 6 or 
RAID 10. RAID configuration is usually required only when you first set up the 
device. A brief description of each RAID setting follows: 
 
RAID Levels 
Level Description 
JBOD The storage volume is a single HDD with no RAID support. JBOD 

requires a minimum of 1 disk. 
RAID 0 Provides data striping but no redundancy. Improves 

performance but not data safety. RAID 0 requires a minimum of 
2 disks. 

RAID 1 Offers disk mirroring. Provides twice the read rate of single 
disks, but same write rate. RAID 1 requires a minimum of 2 
disks. 

RAID 5 Data striping and stripe error correction information provided. 
RAID 5 requires a minimum of 3 disks. RAID 5 can sustain one 
failed disk. 

RAID 6 Two independent parity computations must be used in order to 
provide protection against double disk failure. Two different 
algorithms are employed to achieve this purpose. RAID 6 
requires a minimum of 4 disks. RAID 6 can sustain two failed 
disks. 

RAID 10 RAID 10 has high reliability and high performance. RAID 10 is 
implemented as a striped array whose segments are RAID 1 
arrays. It has the fault tolerance of RAID 1 and the performance 
of RAID 0. RAID 10 requires 4 disks. RAID 10 can sustain two 
failed disks. 
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RAID Configuration 
Using RAID Settings, you can select stripe size, choose which disks are RAID 
disks or the Spare Disk. . 
 
RAID Configurations 
Item Description 
RAID Check the boxes of the hard drives you wish to add to the 

storage volume. 
Master RAID Check a box to designate this as the Master RAID volume. See 

the NOTE below for more information. 
Disk No. Number assigned to the installed hard disks. 

If the adm
remov

inistrator improperly removes a hard disk that should not be 
ed when RAID status is Degraded, all data will be lost. WARNING 



Capacity (MB) Capacity of the installed hard disks. 
Model Model number of the installed hard disks. 
Status Status of the installed hard disks. 
Member If this is checked, current hard disk is a part of a RAID volume. 
Spare If this is checked, current hard disk is designated as a spare for 

a RAID volume. 
Stripe Size This sets the stripe size to maximize performance of sequential 

files in a storage volume. Keep the 64K setting unless you 
require a special file storage layout in the storage volume. A 
larger stripe size is better for large files. 

Used Percentage The percentage of the RAID volume that will be used to store 
data. 

Apply Press this button to configure a file system and create the RAID 
storage volume. 

Remove Click to remove the RAID volume. All user data, and iSCSI data 
will be removed. 

Back Press this button to exit without saving changes. 
Expand Press this button to configure a file system and create the RAID 

storage volume. 
Migration Press this button to migrate RAID level. 

Creating a RAID 
To create a RAID volume, follow the steps below: 
 

1. On the RAID Information screen, click New. 
 
2. On the RAID Configuration screen, set the RAID storage space as JBOD, 

RAID 0, RAID 1, RAID 5, RAID 6, or RAID 10 — see Appendix C: 
RAID Basics for a detailed description of each. 

 
3. Specify a RAID ID.  

 
4. If this RAID volume is meant to be the Master RAID volume, tick the 

Master RAID checkbox. 
 

NOTE In a multiple RAID configuration, one RAID volume must be 
designated as the Master RAID volume. The Master RAID volume will 
store all installed modules. If the Master RAID is changed to another 
location (i.e. assigning HDD 2 to be the Master RAID volume after 
HDD 1 had been previously assigned), then all modules must be 
reinstalled. In addition, all system folders that were contained on the 
Master RAID volume will be invisible. Reassigning this volume to be 
the Master RAID will make these folders visible again. 

 
 
 
 
 
 
 

5. Tick the checkboxes under the “member” heading of the hard disks you 
wish to use to create a RAID.  

 
6. Specify a stripe size — 64K is the default setting.  

 
7. Specify the percentage allocated for user data. The remaining space will 

be made available for iSCSI target. 
 

8. Selected the file system you like to have for this RAID volume.  
 
 Select ZFS file system while snapshot is needed. It is only one ZFS file 

system allowed to be created per system.  
ZFS file system is only accessible by CIFS/SMB, not for AFP and NFS 
users.  

NOTE  
 
 

9. Press Apply to build the RAID storage volume. 
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NOTE 
Building a RAID storage space may take time, dep
hard drives and RAID mode. 

 ending on the size of 

 
 

WARNING 
Creating RAID destroys all data in the current RAID  volume. The data is 
unrecoverable.  

 
With a RAID 1, RAID 5, RAID 6, or RAID 10 volume, you can also add a spare 
disk after the RAID is created. See Chapter 7: Tips and Tricks > Adding a 
Spare Disk for details. 
 

Expanding a RAID 
To expand a RAID 1, RAID 5, RAID 6, or RAID 10 volume, follow the steps below: 
 

1. Replace one of the hard drives in the RAID volume and allow it to 
automatically rebuild. 

 
2. Once rebuilt, you can continue to replace any remaining disks in the RAID 

array.  
 

3. When you are done replacing hard drives, log on to Web Management. 
Navigate to Storage > RAID to open the RAID List screen.  

 
4. On the RAID List screen, select the RAID volume by clicking on its radio 

button, and click RAID Config to open the RAID Configuration screen. 
 
5. On the RAID Configuration screen, click Expand. 

 

Migrating a RAID 
Once a RAID volume has been created, you 
may want to move it to other physical drives 
or change the RAID array all together. To 
migrate a RAID 0, RAID 1, or RAID 5 
volume, follow the steps below: 
 

1. From the RAID Configuration screen, 
click Migrate RAID. 

 
2. A list of possible RAID migration 

configurations will be listed. Select 
the desired migration scheme and 
click OK. 

 
3. The system will begin migrating the RAID volume. 

 
NOTE 

Migrating a RAID volume could take several hours to complete 
 
 
 
Below is a table listing of possible RAID migration schemes: 

   ToÎ 
 

Ð From 
RAID 0  RAID 5  

RAID 0  [RAID 0] HDDx2 to [RAID 0] HDDx3 
[RAID 0] HDDx2 to [RAID 0] HDDx4 

[RAID 0] HDDx2 to [RAID 5] HDDx3  
[RAID 0] HDDx2 to [RAID 5] HDDx4  
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[RAID 0] HDDx2 to [RAID 0] HDDx5
[RAID 0] HDDx2 to [RAID 0] HDDx6
[RAID 0] HDDx2 to [RAID 0] HDDx7 
[RAID 0] HDDx2 to [RAID 0] HDDx8 
[RAID 0] HDDx3 to [RAID 0] HDDx4 
[RAID 0] HDDx3 to [RAID 0] HDDx5
[RAID 0] HDDx3 to [RAID 0] HDDx6
[RAID 0] HDDx3 to [RAID 0] HDDx7 
[RAID 0] HDDx3 to [RAID 0] HDDx8 
[RAID 0] HDDx4 to [RAID 0] HDDx5
[RAID 0] HDDx4 to [RAID 0] HDDx6
[RAID 0] HDDx4 to [RAID 0] HDDx7
[RAID 0] HDDx3 to [RAID 0] HDDx8 
[RAID 0] HDDx5 to [RAID 0] HDDx6
[RAID 0] HDDx5 to [RAID 0] HDDx7
[RAID 0] HDDx5 to [RAID 0] HDDx8 
[RAID 0] HDDx6 to [RAID 0] HDDx7 
[RAID 0] HDDx6 to [RAID 0] HDDx8
[RAID 0] HDDx7 to [RAID 0] HDDx8 

[RAID 0] HDDx2 to [RAID 5] HDDx5 
[RAID 0] HDDx2 to [RAID 5] HDDx6 
[RAID 0] HDDx2 to [RAID 5] HDDx7 
[RAID 0] HDDx2 to [RAID 5] HDDx8  
[RAID 0] HDDx3 to [RAID 5] HDDx4  
[RAID 0] HDDx3 to [RAID 5] HDDx5 
[RAID 0] HDDx3 to [RAID 5] HDDx6 
[RAID 0] HDDx3 to [RAID 5] HDDx7  
[RAID 0] HDDx3 to [RAID 5] HDDx8  
[RAID 0] HDDx4 to [RAID 5] HDDx5 
[RAID 0] HDDx4 to [RAID 5] HDDx6 
[RAID 0] HDDx4 to [RAID 5] HDDx7 
[RAID 0] HDDx4 to [RAID 5] HDDx8 
[RAID 0] HDDx5 to [RAID 5] HDDx6 
[RAID 0] HDDx5 to [RAID 5] HDDx7 
[RAID 0] HDDx5 to [RAID 5] HDDx8 
[RAID 0] HDDx6 to [RAID 5] HDDx7  
[RAID 0] HDDx6 to [RAID 5] HDDx8 
[RAID 0] HDDx7 to [RAID 5] HDDx8 

RAID 1  

[RAID 1] HDDx2 to [RAID 0] HDDx2 
[RAID 1] HDDx2 to [RAID 0] HDDx3 
[RAID 1] HDDx2 to [RAID 0] HDDx4 
[RAID 1] HDDx2 to [RAID 0] HDDx5
[RAID 1] HDDx2 to [RAID 0] HDDx6
[RAID 1] HDDx2 to [RAID 0] HDDx7
[RAID 1] HDDx2 to [RAID 0] HDDx8
[RAID 1] HDDx3 to [RAID 0] HDDx3
[RAID 1] HDDx3 to [RAID 0] HDDx4
[RAID 1] HDDx3 to [RAID 0] HDDx5
[RAID 1] HDDx3 to [RAID 0] HDDx6
[RAID 1] HDDx3 to [RAID 0] HDDx7
[RAID 1] HDDx3 to [RAID 0] HDDx8
[RAID 1] HDDx4 to [RAID 0] HDDx4
[RAID 1] HDDx4 to [RAID 0] HDDx5
[RAID 1] HDDx4 to [RAID 0] HDDx6
[RAID 1] HDDx4 to [RAID 0] HDDx7
[RAID 1] HDDx4 to [RAID 0] HDDx8
[RAID 1] HDDx5 to [RAID 0] HDDx5
[RAID 1] HDDx5 to [RAID 0] HDDx6
[RAID 1] HDDx5 to [RAID 0] HDDx7
[RAID 1] HDDx5 to [RAID 0] HDDx8
[RAID 1] HDDx6 to [RAID 0] HDDx6
[RAID 1] HDDx6 to [RAID 0] HDDx7
[RAID 1] HDDx6 to [RAID 0] HDDx8
[RAID 1] HDDx7 to [RAID 0] HDDx7 
[RAID 1] HDDx7 to [RAID 0] HDDx8

[RAID 1] HDDx2 to [RAID 5] HDDx3  
[RAID 1] HDDx2 to [RAID 5] HDDx4  
[RAID 1] HDDx2 to [RAID 5] HDDx5 
[RAID 1] HDDx2 to [RAID 5] HDDx6 
[RAID 1] HDDx2 to [RAID 5] HDDx7 
[RAID 1] HDDx2 to [RAID 5] HDDx8 
[RAID 1] HDDx3 to [RAID 5] HDDx3 
[RAID 1] HDDx3 to [RAID 5] HDDx4 
[RAID 1] HDDx3 to [RAID 5] HDDx5 
[RAID 1] HDDx3 to [RAID 5] HDDx6 
[RAID 1] HDDx3 to [RAID 5] HDDx7 
[RAID 1] HDDx3 to [RAID 5] HDDx8 
[RAID 1] HDDx4 to [RAID 5] HDDx4 
[RAID 1] HDDx4 to [RAID 5] HDDx5 
[RAID 1] HDDx4 to [RAID 5] HDDx6 
[RAID 1] HDDx4 to [RAID 5] HDDx7 
[RAID 1] HDDx4 to [RAID 5] HDDx8 
[RAID 1] HDDx5 to [RAID 5] HDDx5 
[RAID 1] HDDx5 to [RAID 5] HDDx6 
[RAID 1] HDDx5 to [RAID 5] HDDx7 
[RAID 1] HDDx5 to [RAID 5] HDDx8 
[RAID 1] HDDx6 to [RAID 5] HDDx6 
[RAID 1] HDDx6 to [RAID 5] HDDx7 
[RAID 1] HDDx6 to [RAID 5] HDDx8 
[RAID 1] HDDx7 to [RAID 5] HDDx7  
[RAID 1] HDDx7 to [RAID 5] HDDx8 

RAID 5  X  

[RAID 5] HDDx3 to [RAID 5] HDDx4  
[RAID 5] HDDx3 to [RAID 5] HDDx5 
[RAID 5] HDDx3 to [RAID 5] HDDx6 
[RAID 5] HDDx3 to [RAID 5] HDDx7  
[RAID 5] HDDx3 to [RAID 5] HDDx8  
[RAID 5] HDDx4 to [RAID 5] HDDx5 
[RAID 5] HDDx4 to [RAID 5] HDDx6 
[RAID 5] HDDx4 to [RAID 5] HDDx7 
[RAID 5] HDDx4 to [RAID 5] HDDx8 
[RAID 5] HDDx5 to [RAID 5] HDDx6 
[RAID 5] HDDx5 to [RAID 5] HDDx7 
[RAID 5] HDDx5 to [RAID 5] HDDx8 
[RAID 5] HDDx6 to [RAID 5] HDDx7 
[RAID 5] HDDx6 to [RAID 5] HDDx8 



 

Deleting a RAID 
To delete a RAID volume, follow the steps below: 
 

1. On the RAID List screen, select the RAID volume by clicking on its radio 
button, and click RAID Config to open the RAID Configuration screen. 

 
2. On the RAID Configuration screen, click Remove RAID. 

 
3. The confirmation screen appear, you will have to input “Yes” with exactly 

wording case to complete “Remove RAID” operation  
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Space Allocation 

WARNING 
Removing RAID destroys all data in the current RAID volume. The data 
is unrecoverable. 

You may specify the space allocated for iSCSI volume.  
 
To do this, under the Storage menu, click RAID and the RAID List window 
appears. Select the RAID volume you wish to reallocate by clicking on its radio 
button, and click Space Allocation. The RAID Information and Volume 
Allocation List windows will appear. 
 
The Volume Allocation List displays the space allocated for iSCSI volumes on the 
current RAID volume. The N8800 supports up to 5 iSCSI volumes in each RAID 
volume. 
 
Volume Allocation List 
Item Description 
Modify Click this to modify the allocated space. 
Del Click this to delete the allocated space. 
Type Type of volume. Can be either USB or iSCSI. 
Name Name assigned to the volume. 
Capacity Capacity of the allocated space. 
iSCSI Target Click to allocate space to iSCSI volume. 

Allocating Space for iSCSI Volume 
To allocate space for an iSCSI volume on the current RAID volume, follow the 
steps below: 
 

1. Under the Volume Allocation List, click iSCSI Target. 
 



 
  
 The Create iSCSI Volume screen appears. 

 
Create iSCSI Volume 
Item Description 
RAID ID ID of current RAID volume. 
Unused Percentage and amount of unused space on current RAID 

volume. 
Allocation Percentage and amount of space allocated to iSCSI 

volume. 
iSCSI Target Service Enable or Disable the iSCSI Target service. 
Authentication You may choose CHAP authentication or choose None. 
Target Name Name of the iSCSI Target. This name will be used by the 

Stackable NAS function to identify this export share. 
Year Select the current year from the dropdown. 
Month Select the current month from the dropdown. 
Username Enter a username. 
Password Enter a password. 
Password Confirm Reenter the chosen password 
IQN The iSCSI Qualified Name 
Initiator Information Shows the name and status of iSCSI initiators logged on 

the system 
OK Click OK to save changes. 
Back Click Back to exit without saving. 

 
2. Designate the percentage to be allocated from the Allocation dropdown. 
 
3. Enable the iSCSI Target Service by selecting Enable. 

 
4. Choose to enable CHAP authentication or choose None.  

 
5. Enter a Target Name. This will be used by the Stackable NAS function 

to identify this export share. 
 
6. Choose the current year from the Year dropdown. 

 
7. Choose the current month from the Month dropdown. 
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8. If you’ve enabled CHAP authentication, enter a username and a 
password. Confirm your chosen password be reentering it in the 
Password Confirm box. 

 
9. Click OK to create the iSCSI volume. 

 
 

Stackable NAS 
The N8800’s capacity can be expanded even further using the stackable function. 
With it, users can expand the capacity of their network storage systems with up 
to 5 other stack target volumes which are located in different systems. These can 
be stacked through single network access like SMB or AFP acting as a share folder 
type. 
 
For detailed instructions on how to use this feature, please refer to the Stackable 
User Guide. 
 

Snapshot 
The N8800 is capable for snapshot version control supported. To have snapshot 
to work on the file system creation for RAID volume has to be “ZFS”. For more 
information how to using snapshot, please refer to next section “Folder 
management”.  
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Folder Management 
From the Storage menu, choose 
Folder, and the Folder screen 
appears. This screen allows you to 
create and configure folders on the 
N8800 volume. 
 
 
 
 
 
 
 
 
 
 
 
 
Folder 
Item Description 
Folder name Displays the name of the folder. 
Description Provides a description of the folder. 
NFS Share Press NFS Share to configure which hosts on the network are 

allowed to access this folder using NFS.  
With “ZFS” file system selected RAID volume, it is un-
configurable.  

ACL Press ACL (Access Control List) to configure which users have 
access to this folder. 

Edit Press Edit to enter the Edit screen and modify the folder’s 
name and description. 

Snapshot Press Snap to open snapshot configuration screen, the button 
will be only configurable with “ZFS” file system selected RAID 
volume.  

Del Press Del to delete the folder. A prompt appears asking to 
confirm the deletion. 

Add Press Add to enter the Add Folder screen. 
 

NOTE 
Nsync folders will be created once the RAID is creat
used by Nsync server. It will be used for files ba

 ed. Nsync folder is 
cked up by Nsync. 

 
 

Adding Folders 
On the Folder screen, press the Add button 
and the Add Folder screen appears. This 
screen allows you to add a folder. After 
entering the information, press Apply to 
create new folder. Press Back to return to 
the Folder screen. 
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Add Folder 
Item Description 
RAID ID RAID volume where the new folder will reside. 
Folder Name Enter the name of the folder. 
Description Provide a description the folder. 
Browseable Enable or disable users from browsing the folder contents. If 

Yes is selected, then the share folder will be browseable. 
Public Admit or deny public access to this folder. If Yes is selected, 

then users do not need to have access permission to write to 
this folder. When accessing a public folder via FTP, the behavior 
is similar to anonymous FTP. Anonymous users can 
upload/download a file to the folder, but they cannot delete a 
file from the folder. 

Share Folder Limit Enter the maximum size of the folder in Gigabytes (GB). The 
folder cannot grow beyond this limit. You can enter a 0 to turn 
off the share folder limit. 

Apply Press Apply to create the folder. 
Back Press Back to return to the Folder screen. 

 
Folder names are limited to 60 characters. Systems running Windows 
98 or earlier may not support file names longer than 15 characters. NOTE  

 
 

Editing Folders 
On the Folder screen, press the Edit button and the Edit Folder screen appears. 
This screen allows you to change folder information. After entering the 
information, press Submit to apply the changes. Press Back to return to the 
Folder screen. 
 
Edit Folder 
Item Description 
Share Name Enter the name of the (Share) folder. 
Comment Provide a description the folder. 
Browseable Enable or disable users from browsing the folder contents. This 

setting will only apply while access via SMB/CIFS and web disk.  
Public Admit or deny public access to this folder. 
Share Limit Enter the maximum size of the folder. The folder will not grow 

beyond this limit. You can enter a 0 to turn off the share folder 
limit. 

Submit Press Submit to save your changes. 
Back Press Back to return to the Folder screen. 

Deleting Folders 
To delete a folder, press the Del button from the specified folder row. The system 
will confirm folder deletion. Press OK to delete the folder permanently or Cancel 
to go back to the folder list. 
 

All the data stored in the folder will be deleted once the folder is 
deleted. The data will not be recoverable. WARNING  
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NFS Share 
To allow NFS access to the share folder, enable the NFS Service, and then set up 
hosts with access rights by clicking Add. 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
NFS Share 
Item Description 
Hostname Enter the name or IP address of the host 
Privilege Host has either read only or writeable access to the folder. 
Guest System Support There are two selections available: 

• Unix / Linux System 
• AIX (Allow source port > 1024) 

Choose the one which best fits your needs. 
IO Mapping There are three selections available: 

• Guest system root account will have full access to this 
share (root:root). 

• Guest system root account will be mapped to 
anonymous user (nobody:nogroup) on NAS. 

• All user on guest system will be mapped to anonymous 
user (nobody:nogroup) on NAS. 

Choose the one which best fits your needs. 
Apply Click to save your changes. 
Back Click to abandon changes. 

 

Snap (Snapshot configuration) 
If added folder has located in the RAID volume with “ZFS” file system, then the 
folder management screen with “Snap” button will be configurable.  
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Clicking on “Snap” then screen appears as following.  
 

 
 
Snapshot 
Item Description 
Take Shot Click to take snapshot right away.  
Schedule Click to open snapshot schedule setup screen.  
Back Click to go back folder management screen. 

 
Clicking on schedule button then schedule setup screen appear. Checked the 
enable check box to activate the snapshot scheduled operation.  
 

 
 

 
 
 

39 



The N8800 snapshot is supported total 16 versions. Once checked 
“Automatically remove oldest snapshot”, the oldest will be removed to let newest 
to added on top. Otherwise, if the check box is unchecked and snapshot versions 
are up to 16 then system will appear warning message and won’t execute the 
task till available version count.  
 
The snapshot schedule rules can be setup for monthly, weekly or daily hour.  
 

 
 
Clicking on Apply after firmed with desired schedule or click back to Snap screen.  
 
If any snapshot has taken then it will listed in Snapshot list as example below. 
This example shows folder “test” has created under RAID volume in ZFS file 
system. It has been taken snapshot twice so far at time displayed.  
 

 
 
These taken snapshot is only accessible though CIFS/SMB by manually type 
\\NAS IP address\snapshot and invisible from normal access. Also, the taken 
snapshot version is read only can not be deleted under CIFS/SMB access but only 
click the “Del” button showing on the screen shot above.  
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Folder Access Control List (ACL) 
On the Folder screen, press the ACL button, 
and the Access Control List screen 
appears. This screen allows you to configure 
access to the specific folder for users and
groups. Select a user or a group from the 
left hand column and then choose Deny, 
Read Only, or Writable to configure their 
access level. Press the Submit button to 
confirm yo

 

ur settings. 
 
 
 
 
Access Control List 
Item Description 
Deny Denies access to users or groups who are displayed in this 

column. 
Read Only Provides Read Only access to users or groups who are displayed 

in this column. 
Writable Provides Write access to users or groups who are displayed in 

this column. 
Remove Removes the selected user or group from the column in order to 

reset their access privileges. 
Sync AD account Press this button when there is no list from ADS/PDC or more 

ADS user has been added but yet appear from list.  
Submit Submits and confirms settings. 
Reset Cancel your settings and return to the Folder screen.  

 
To configure folder access, follow the steps below: 
 

1. On the ACL screen, all network groups and users are listed in the left hand 
column. Select a group or user from this list. 

 
2. With the group or user selected, press one of the buttons from the three 

access level columns at the top. The group or user then appears in that 
column and has that level of access to the folder.  

 
3. Continue selecting groups and users and assigning them access levels 

using the column buttons. 
 

4. To remove a group or user from an access level column, press the 
Remove button in that column. 

 
5. When you are finished, press Submit to submit and confirm your ACL 

settings. 
 

NOTE 
If one user has belonged to more than one group but different privilege 
than the priority Deny > Read Only > Writable 

 
 
 
The ACL screen also allows you to search for a particular user. To do this, follow 
the steps below: 
 

1. In the blank, enter the name of the user 
you would like to find.  

 
2. From the drop down select the group you 

would like to search for the user in. 
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3. Click Search. 
 

NOTE 
The system will list up to 1,000 users from the chosen category. To 
narrow your search, enter a search term in the blank provided.  

 
 

File System Check 
 
The File System Check allows you to perform a 
check on the integrity of your disks’ file system. 
Under the Storage menu, click Filesystm Check 
and the File System Check prompt appears.  
 
To perform a file system check, click Apply. 
 
Once clicked, the following prompt will appear: 
 

 
 
Click Yes to reboot the system.  
 
Once the system has rebooted, you will be returned to the File System Check 
prompt. There you will see the available RAID volumes to run the file system 
check on. Check the desired RAID volumes and click Next to proceed with the file 
system check. Click Reboot to reboot without running the check. 
 

 
 
Once you click Next, you will see the following screen: 
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Click Start to begin the file system check. Click Back to return to the previous 
screen. Click Reboot to reboot the system. 
When the file system check is run, the system will show 20 lines of information 
until it is complete. Once complete, the results will be shown at the bottom. 
 

 
 
 

NOTE 
The system must be rebooted before the N8800 can function normally. 

 
 

Advance Option 
 
There are 5 items is currently allow 
Admin to Enable/Disable to operate 
N8800. The details as listed in 
following screenshot. With the option 
changed, it will need to reboot 
system to activate.  
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File Access Cache 
 

 
 
File Access Cache is default Enable. This option will help to increase the 
performance while single client access share folder in writing under SMB/CIFS 
protocol.  
 

Samba Recycle Bin 

 
 
The N8800 is supported recycle bin via SMB/CIFS protocol. Simply enable it then 
all of deleted files/folders will reside in the “.recycle” folder with hidden 
attribution in each share.  
 

 
 
In general, Windows has default to invisible all of hidden folders/files. So please 
enable this option to view “.recycle” folder.  

Samba Anonymous Login Authentication 
 

 
 
To enable this option, no matter there is share folder has been created in public 
access. The user account and password is needed from system to access under 
SMB/CIFS protocol. On the other hand, no more anonymous logAdvance Option 
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iSCSI Block Size 
 

 
 
Select the block size with 4K while the iSCSI volume size is over 2TB.  
 

iSCSI CRC/Checksum 
 

 
 
To enable this option, the initiator can connect with “Data digest” and “Header 
digest” enabled.  
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 Network Management 
Use the Network menu to make network configuration settings as well as service 
support settings. 

WAN Configuration 
From the Network menu, choose WAN, 
and the WAN Configuration screen 
appears. This screen displays the network 
parameters of the WAN connection. You 
may change any of these items and press 
Apply to confirm your settings. See a 
description of each item in the following 

ble: 

 

ta
 
 
 
 
 
 
 
 

WAN Configuration 
Item Description 
Host name Host name that identifies the N8800 on the network. 
Domain name Specifies the domain name of the N8800. 
MAC Address MAC address of the network interface. 
Jumbo Frame Support ble Jumbo Frame Support of the WAN interface on Enable or disa

your N8800. 
DHCP 

c IP, disable this feature and 
Enable or disable the N8800 from obtaining in IP address via 
DHCP server. If you require a stati
input your network configuration. 

IP IP address of the WAN interface. 
Netmask Network mask, which is generally: 255.255.255.0 
Gateway Default Gateway IP address. 
DNS Server Domain Name Service (DNS) server IP address. 
IP Sharing Mode LAN port will be able to When enabled, PCs connected to the 

access the WAN. Default is Enabled. 
Link Aggregation 
(N8800 only) 

 WAN and LAN ports will be aggregated and 

Ethernet traffic will flow alternative between two 

age two Ethernet ports in parallel to increase 
throughput.  

Specifies whether
act as one port. 
Failover: When one port fails, the other one will take over. 
Load Balance: 
Ethernet ports. 
802.3ad: Link

 
 

NOTE • 

 

TP 

• 
the other end of 

Ethernet cable also supports 802.3ad protocol. 

Only use Jumbo Frame settings when operating in a Gigabit 
environment where all other clients have Jumbo Frame Setting 
enabled. 
Enabling DHCP au• tomatically turns on UPnP—see the Service 
Support Screen. 
If you are only using the WAN port, we suggest that • you disable IP
Sharing Mode. This will result in higher throughput. 
A correct D• NS setting is vital to networks services, such as SM
and NTP. 
To use the Link Aggregation with “802.3ad selected” feature, 
please make sure the networking equipment on 
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Most Fast Ethernet (10/100) Switches/Routers do not support Jumbo 
Frame and you will not be able to connect to your N8800 after Jumbo 
Frame is turned on. If this happens, turn off the N8800. Then, power 
on the N8800 and immediately press and hold the Reset button on the 
back of the unit for 10 seconds. This will reset your network settings, 
password, and turn off Jumbo Frame Support. 

WARNING  

 

 

 

LAN Configuration 
The N8800 supports two Gigabit Ethernet 
ports for higher service availability. To 
configure these ports, choose LAN from the 
Network menu, and the LAN 
Configuration screen appears. Press Apply 
to save your changes. 
 
 
 
 
 
 
 
 
 
 
 
LAN Configuration 
Item Description 
MAC Address Displays the MAC address of the LAN interface. 
IP Specifies the IP address of the LAN interface. 
Netmask Specifies the Network Mask of the LAN interface. 
Jumbo Frame Support Enable or disable Jumbo Frame Support on the LAN interface. 

 

Before enabling Jumbo Frame Support, please make sure your network 
equipment supports Jumbo Frame. If your equipment is incompatible, 
you might not be able to connect to your N8800. In this case, you have 
to reset the system back to default by the holding down front panel 
reset button for 5 seconds during boot up process. 

NOTE 
 
 
 
 
 

DHCP Configuration 
A DHCP server can be configured to assign IP addresses to devices connected to 
the LAN port. To configure these ports, choose LAN from the Network menu. 
 
DHCP Configuration 
Item Description 
DHCP Server Enable or disable the DHCP server to automatically assign IP 

address to PCs connected to the LAN interface. 
Start IP Specifies the starting IP address of the DHCP range. 
End IP Specifies the ending IP address of the DHCP range. 
DNS Server Displayed the DNS server IP address. 

 

NOTE 

The IP address of the LAN interface should not be in the range of the 
Start IP address and End IP address. WARNING 

The IP Segment of WAN and LAN should not overlap.  
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WLAN Configuration 
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When a compatible wireless USB dongle is 
installed on the N8800, the N8800 will 
become an access point, and the Network 
dropdown menu will contain a WLAN menu 
item. From the Network menu, choose 
WLAN, and the WLAN Configuration 
screen appears. This screen displays the 
wireless network parameters of the system. 
You can change any of these items and press 
Apply to confirm your settings.  
 
 
 
 
 
 
 
 
 
 
 
WLAN Configuration 
Item Description 
MAC Address Displays the MAC Address of the USB wireless dongle. 
IP Specifies the IP address of the network connection. 
Netmask Specifies the network mask, which is generally: 255.255.255.0 
ESSID The ESSID (Extended Service Set Identification) is the 

identifying name of a wireless network. 
ESSID Broadcast Specifies whether the ESSID will be broadcasted by the N8800. 

This will prevent the Access Point from broadcasting the ESSID. 
The N8800 will still respond to a wireless device that wants to 
communicate if it sends a matching ESSID. 

Channel The channel that the N8800 uses to communicate with client 
devices. 

Auth Mode Authentication mode used by the N8800. 
Shared: Shared key authentication 
Open: Open key authentication 

WEP Enable Specifies whether to use encryption for transmission or not. 
Key Length Key length specifies the level of encryption used by the N8800. 

64 bit: 10 characters from 0 ~ 9 and A ~ F. 
128 bit: 26 characters from 0 ~ 9 and A ~ F. 

WEP KEY 1 
WEP KEY 2 
WEP KEY 3 
WEP KEY 4 

Input up to 4 WEP keys, and select the one you wish to use. 
When connecting, be sure to enter the same key and select the 
same index number on each client machine. 

NOTE • Currently supported USB 
wireless dongles are: 3Com 
3CRUSB10075, Zyxel G220USB, 
PCI GW-US54mini.  

• USB dongles have to be 
connected before N8800 is 
powered up. 

 
A DHCP server can be configured to assign IP addresses to devices connected to 
LAN ports. 
WLAN DHCP Configuration 
Item Description 
DHCP Server Select to enable or disable DHCP server. 
Start IP Specifies the starting IP address of the DHCP range. 
End IP Specifies the ending IP address of the DHCP range. 
DNS Server Specifies the DNS server IP address. 

 The IP Segment of WLAN, WAN and LAN should not overlap. 
NOTE  



 

NOTE Users should obey the international RF regulatory rules as they set up 
the wireless RF channel on the N8800. The RF operating channels for 
different regions have been specified as following. Thecus has no 
responsibility for users attempting to violate the international RF 
regulation. 
 

11  N. America  
14  Japan  
13  Europe (ETSI)  
2  Spain  
4  France 

 
 
 
 
 
 
 
 
 

Web Services Configuration 
From the Network menu, choose the 
Service item, and the Web Service screen 
appears. This screen displays the service 
support parameters of the system. You can 
change any of these items and press Apply 
to confirm your settings. A description of 
each item follows: 
 
 
 
 
 
 
 
 
 

• In some environments, due to 
security concerns, you may 
wish to disable SMB/CIFS as a 
precaution against computer 
viruses. 

• Disable HTTP support and 
Enable Secure HTTP support 
to guarantee secure access. 

NOTE 

 
Web Service 
Item Description 
HTTP (WebDisk) 
Support 

Enable or disable WebDisk support. Enter the port number if this 
option is enabled. The port number  

HTTPs (Secure 
WebDisk) Support 

Enable or disable secure WebDisk support. Enter the port if this 
option is enabled. 

SMB/CIFS Enable or Disable SMB/CIFS protocol for Windows, Apple, Unix 
drive mapping. 

UPnP Enable or disable Universal Plug and Play protocol. UPnP helps to 
find the IP address of the N8800. 

AFP (Apple Network Setup) 
From the Network menu, choose the AFP 
item, and the AFP Configuration screen 
appears. This screen displays the 
configuration items for the Apple Filing 
Protocol. You can change any of these items 
and press Apply to confirm your settings. A 
description of each item follows: 
 
 
 
 
 
 
Apple Network Configuration 
Item Description 
AFP Server Enable or disable Apple File Service to use the N8800 with MAC 
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OS-based systems. 
Zone Specifies Zone for Applet Talk service. 

If your AppleTalk network uses extended networks and is 
assigned with multiple zones, assign a zone name to the N8800. 
If you do not want to assign a network zone, enter an asterisk 
(*) to use the default setting. 

 

NFS Setup 
From the Network menu, choose the NFS 
item, and the NFS Server Setting screen 
appears. The N8800 can act as an NFS 
server, enabling users to download and 
upload files with the favorite NFS clients. 
Press Apply to confirm your settings. A 
description of each item follows: 
 
 
 
 
 
 
 
 
 
 
 
NFS Server Setting 
Item Description 
NFS Enable or Disable NFS support. 
Apply Click Apply to save your changes. 
Cancel Click Cancel to abandon your changes. 

 

User and Group Management 
The N8800 has built-in user database that allows administrators to manage user 
access using different group policies. From the Accounts menu, you can create, 
modify, and delete users, and assign them to groups that you designate.  

Local User Configuration 
From the Accounts menu, choose the 
Users item, and the Local User 
Configuration screen appears. This screen 
allows you to Add, Modify, and Delete 
local users.  
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Local User Configuration 
Item Description 
Add Press the Add button to add a user to the list of local users. 
Modify Press the Modify button to modify a local user. 
Delete Press the Delete button to delete a selected user from the 

system. 

Adding Users 
 
1. Click on the Add button on Local 

User Configuration screen, and 
Local User Setting screen appears. 
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2. On the Local User Setting screen, 

enter a name in the User Name box. 
 

3. Enter a User ID number. If left 
blank, the system will automatically 
assign one. 

 
4. Enter a password in the Password 

box and re-enter the password in the 
Confirm box. 

 
5. Select which group the user will 

belong to. Group Members is a list of groups this user belongs to. Group 
List is a list of groups this user does not belong to. Use the << or >> 
buttons to have this user join or leave a group. 

 
6. Press the Apply button and the user is created. 

 
All users are automatically assigned to the ‘users’ group. 

NOTE 
 
 
 



Modifying Users 
 

1. Select an existing user from the Local User Configuration screen. 
 
2. Click on the Modify button, and Local User Setting screen appears. 

 
3. From here, you can enter a new password and re-enter to confirm, or use 

the << or >> buttons to have this user join or leave a group. Click the 
Apply button to save your changes. 

 

Deleting Users 
 
1. Select an existing user from the Local User Configuration screen. 
 
2. Click on Delete button and the user is deleted from the system. 

 
 

Local Groups Configuration 
From the Accounts menu, choose the 
Groups item, and the Local Groups 
Configuration screen appears. This screen 
allows you to Add, Modify, and Delete 
local groups. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Local Groups Configuration 
Item Description 
Add Press the Add button to add a user to the list of local groups. 
Modify Press the Modify button to delete a selected group from the 

system. 
Delete Press the Delete button to delete a selected group from the 

system. 

 

Adding Groups 
 
1. On the Local Group Configuration screen, click on the Add button.  
2. The Local Group Setting screen appears. 
3. Enter a Group Name. 
4. Enter a Group ID number. If left blank, the system will automatically 

assign one. 
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5. Select users to be in this group from 
the Users List by adding them to 
the Members List using the << 
button.  

6. Click the Apply button to save your 
changes.  

Modifying Groups 
 

1. On the Local Group Configuration 
screen, select a group name from 
the list. 

2. Press the Modify button to modify 
the members in a group. 

3. To add a user into a group, select 
the user from the Users List, and 
press the << button to move the user into the Members List. 

4. To remove a user from a group, select the user from Members List, and 
press the >> button. 

5. Click the Apply button to save your changes. 

Deleting Groups 
 
1. On the Local Group Configuration screen, select a group name from the 

list. 
2. Press Delete to delete the group from the system. 

 

Batch User and Group Creation 
The N8800 can also add users and groups in 
batch mode. This enables you to 
conveniently add numerous users and 
groups automatically by importing a simple 
comma-separated plain text (*.txt) file.  
 
From the Accounts menu, click Batch 
Mgmt and the Batch Create Users and 
Groups dialogue will appear. To import 
your list of users and groups, follow these 
steps: 
 

1. Click Browse… to locate your 
comma-separated text file. 
The information in the text file 
should follow this format:  
 
[USERNAME], [PASSWORD], [GROUP] 

 
2. Click Open. 
3. Click Import to begin the user list import. 
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ADS/NT Configuration 
If you have a Windows Active Directory 
Server (ADS) or Windows NT server to 
handle the domain security in your network, 
you can simply enable the ADS/NT support 
feature; the N8800 will connect with the 
ADS/NT server and get all the information 
of the domain users and groups 
automatically. From the Accounts menu, 
choose Authentication item and the 
ADS/NT Support screen appears. You can 
to change any of these items and press 
Apply to confirm your settings. A 
description of each item follows: 
 
 
 
ADS/NT Support 
Item Description 
WINS Server Specifies the WINS server if necessary. 
Work Group / Domain 
Name 

Specifies the SMB/CIFS Work Group / ADS Domain Name (e.g. 
N8800). 

ADS/NT Support Select Disable to disable authentication through Windows Active 
Directory Server or Windows NT. 

Authentication Method Select ADS for Windows Active Directory Server, or select NT for 
Windows NT 

ADS/NT Server Name Specifies the ADS/NT server name (e.g. adservername). 
ADS/NT Realm Specifies the ADS/NT realm (e.g. example.com). 
Administrator ID Enter the administrators ID of Windows Active Directory or 

Windows NT, which is required for N8800 to join domain. 
Administrator 
Password 

Enter the ADS/NT Administrator password. 

Confirm Password For re-entering password to confirm. 
 
To join an AD domain, you can refer the figure and use the example below to 
configure the N8800 for associated 
filed input: 
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AD Domain Example 
Item Information 
Work Group / Domain 
Name 

domain 

ADS Support Enable 
ADS Server Name Computer1 
ADS/NT Realm Domain.local 
Administrator ID Administrator 
Administrator 
Password 

*********** 

Confirm Password *********** 
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System Settings 

NOTE • The DNS server specified in the WAN configuration page should be 
able to correctly resolve the ADS server name. 

• The time zone setting between N8800 and ADS should be identical.  
• The system time difference between N8800 and ADS should be less 

than five minutes. 
• The Administrator Password field is for the password of ADS (Active 

Directory Server) not N8800. 

The System menu gives you a wealth of settings that you can use to configure 
your N8800’s system administration functions. You can set up system 
notifications, view system logs, and even upgrade firmware from this menu. 

System Notifications 
From the System menu, choose the 
Notification item, and the Notification 
Configuration screen appears. This screen 
lets you have the N8800 notify you in case 
of any system malfunction. Press Apply to 
confirm all settings. See following table for 
a detailed description of each item. 
 
 
 
 
 

Consult with your mail server 
administrator for email server 
information. 

NOTE 

 
 
 

Notification Configuration 
Item Description 
Beep Notification Enable or disable the system beeper that beeps when a problem 

occurs. 
Email Notification Enable or disable email notifications of system problems. 
SMTP Server Specifies the hostname/IP address of the SMTP server. 
Port Specifies the port to send outgoing notification emails. 
Auth Type Select the SMTP Server account authentication type. 
SMTP Account ID Set the SMTP Server Email account ID. 
Account Password Enter a new password. 
Confirm Account 
Password 

Confirm a new password. 

Receiver’s E-mail 
Address 

Add one or more recipient’s email addresses to receive email 
notifications. 

Test E-Mail Click to send out a test e-mail to make sure the settings are 
correct. 

 



SNMP 
From the System menu, choose the 
SNMP item and the SNMP 
Supports screen appears. You could 
enable the SNMP function and filled 
in the related information in each 
fields. With the SNMP management 
software could get system basic 
information.  
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System Logs 
From the System menu, choose the Logs 
item and the System Logs screen appears. 
This screen shows a history of system usage 
and important events such as disk status, 
network information, and system booting. 
See the following table for a detailed 
description of each item: 
 
 
 
 
 
 
 
 
System Logs 
Item Description 
Truncate All Log File Clear all log files. 
|<<  <  >  >>| Use the forward ( >  >>| ) and backward ( |<<  < )  buttons 

to browse the log pages. 
INFO Provides all log information including warning messages and 

error messages. 
WARN Shows all warning messages and error messages. 
ERROR Shows only error messages. 
GO Specify the number of lines per page and press Go. 
Ascending Shows logs by date in ascending order. 
Descending Shows logs by date in descending order. 
Download All Log File Export all logs to an external file. 

Time and Date Settings 
From the System menu, choose the Time 
item and the Time screen appears. Set the 
desired Date, Time, and Time Zone. You 
can also elect to synchronize the system 
time on the N8800 with an NTP (Network 
Time Protocol) Server. You can change 
any of these items and press Apply to 
confirm your settings. 
  



See the following table for a detailed description of each item: 
 
Time 
Item Description 
Date Sets the system date. 
Time Sets the system time. 
Time Zone Sets the system time zone. 
NTP Server Select Yes to allow the N8800 to synchronize with the NTP 

server shown below. 
Select Manually to allow the N8800 to synchronize with an NTP 
server of your choice. 
Select No to not have the N8800 to synchronize with an NTP 
server. 

 

WARNING 
If an NTP server is selected, please make sure your N8800’s network 
has been setup to access the NTP server. 
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System Configuration Backup and Restore 
From the System menu, choose the Config 
Mgmt item and the System Configuration 
Download/Upload screen appears. From 
here, you can download or upload stored 
system configurations. See the following 
table for a detailed description of each item. 
 
 
 
 
 
 
 
 
 
 
 
 
System Configuration Download/Upload 
Item Description 
Download Save and export the current system configuration. 
Upload Import a saved configuration file to overwrite current system 

configuration. 
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Module Management 

NOTE 
Backing up your system configuration is a great way to ensure that you 
can revert to a working configuration when you are experimenting with 
new system settings. 
The system configuration you have backup can be only restore in same 
firmware version. And the backup details have excluded user/group 
accounts.  

From the System menu, choose the 
Module Mgmt item and the Module 
Management screen appears. From here, 
you can install separate software modules 
to extend the functionality of your N8800.  
 
 
 
 
 
 
 
 
 
 
Module Management 
Item Description 
Name Displays the name of the module. 
Version Displays the module version. 
Description The description of the module. 
Enable Displays whether the module has been enabled or not. 
Status Displays the status of the module. 
Uninstall Click to uninstall the module. 
Enable/Disable Click to enable a module. 
Check Update Click to look for updates for the selected module. 



Module File Location of the module file. 
Browse Click to browse the folder of your PC to locate the module files. 
Install Click to install the listed module into your N8800 

 

NOTE 
Modules can potentially harm your system. Only 
your vendor, or publishers you can trust. 

 install modules from 

 
 

Reset to Factory Default Settings 
From the System menu, choose the 
Factory Default item and the Reset to 
Factory Default screen appears. Press 
Apply to reset the N8800 to factory default 
settings. Press Cancel to go back to the 
main menu. 
 
 
 
 
 
 
 
 
 
 
 

WARNING 
Resetting to factory defaults will not erase the data
disks, but WILL revert all the settings to the factor

  stored in the hard 
y default values.  

 

Upgrading System Firmware 
From the System menu, choose the 
Firmware Upgrade item and the 
Firmware Upgrade screen appears.  
 
Follow the steps below to upgrade your 
firmware: 
 

1. Use the Browse button to find the 
firmware file. 

 
2. Press Apply. 

 
3. The beeper beeps and the Busy LED 

blinks until the upgrade is complete. 
 
 
 
 
 • The beeper only beeps if it is enabled in the System Notification 

menu. NOTE  
• Check Thecus website for the latest firmware release and release 

notes.  
 
 Do NOT turn off the system during the firmware upgrade process. This 

will lead to a catastrophic result that may render the system inoperable. WARNING  
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Change Administrator Password 
From the System menu, choose the 
Administrator Password item and the 
Change Administrator Password screen 
appears. Enter a new password in the New 
Password box and confirm your new 
password in the Confirm Password box. 
Press Apply to confirm password changes. 
See the following table for a detailed 
description of each item. 
 
 
 
 
 
 
 
 
 
Change Administrator Password 
Item Description 
New Password Type in a new administrator password. 
Confirm Password Type the new password again to confirm. 
Apply Press this to save your changes. 

 

Reboot and Shutdown System 
From the System menu, choose Reboot & 
Shutdown item, and the 
Shutdown/Reboot System screen 
appears. Press Reboot to restart the 
system or Shutdown to turn the system off. 
 
 
 
 
 
 
 

 
 
 
 
 

Logout 
To logout of the Web Administration Interface, navigate to System > Logout. 
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Chapter 5: Additional Feature Setup 

Overview 
The N8800 can also act as an FTP Server, allowing employees and clients to 
transfer files using their favorite FTP programs. The integrated Print Server allows 
you to share a single USB printer will all users on the network. The following 
section shows you how. 

FTP Server 
N8800 can act as a FTP server, enabling users to download and upload files with 
their favorite FTP programs. From the Network menu, choose the FTP item, and 
the FTP screen appears. You can change any of these items and press Apply to 
confirm your settings. A description of each item follows: 
 

 
 
 
FTP 
Item Description 
FTP Enable FTP Service on the N8800. 
Port Specifies the port number of an incoming connection on a non-

standard port. 
FTP ENCODE If your FTP client or operating system does not support Unicode 

(e.g. Windows® 95/98/ME or MAC OS9/8), select the same 
encoding as your OS here in order to properly view the files and 
directories on the server. Available options are BIG5, HZ, 
GB2312, GB18030, ISO, EUC-JP, SHIFT-JIS and UTF-8. 

Allow Anonymous FTP 
Access 

Upload/Download: Allow anonymous FTP users to upload or 
download files to/from public folders. 
Download: Allow anonymous FTP users to download files from 
public folders. 
No access: Block anonymous FTP user access. 

Auto Rename If checked, the system will automatically rename files that are 
uploaded with a duplicate file name. The renaming scheme is 
[filename].#, where # represents an integer.  

Upload Bandwidth You may set the maximum bandwidth allocated to file uploads. 
Selections include Unlimited, 1, 2, 4, 8, 16 and 32 MB/s. 

Download Bandwidth You may set the maximum bandwidth allocated to file 
downloads. Selections include Unlimited, 1, 2, 4, 8, 16 and 32 
MB/s. 

To access the share folder on the N8800, use the appropriate user login and 
password set up on the Users page (Accounts > Users). Access control to each 
share folder is set up on the ACL page (Storage > Folder > ACL). 
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iTunes® Server 
With the built-in iTunes server capability, 
the N8800 enables digital music to be 
shared and played anywhere on the net
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work!  
 
From the Network menu, choose the 
iTunes item, and the iTunes 
Configuration screen appears. You may 
enable or disable the iTunes Service from 
here. Once enabled, enter correct 
information for each field and press Apply 
to save your changes. See the following 
table for detailed descriptions of each field:  
 
 
 
iTunes Configuration 
Item Description 
iTunes Enable or disable the iTunes Service. 
Server Name Name used to identify the N8800 to iTunes clients. 
Password Enter password to control access to your iTunes music. 
Rescan Interval Rescan interval in seconds. 
MP3 Tag Encode Specify tag encoding for MP3 files stored in N8800. All ID3 tags 

will be sent out in UTF-8 format. 
 
Once the iTunes service is enabled, the N8800 will make all music located in the 
Music folder available for iTunes-equipped computers on the network. 
 

Media Server 
With the built-in Media Server capability, 
the N8800 provides media streaming 
service to stand-alone networked home 
media adapters that support the UPnP AV 
protocol or are Digital Living Network 
Alliance (DLNA) standard compliant.  
 
With the N8800’s built-in media server 
capability, you can share digital media such 
as music, pictures, and movies with any 
compatible device throughout your entire 
home. 
 
To configure the media server, under the 
Network menu, click Media Server and the 
Media Manager Settings window will appear. 
A description of each field follows: 
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Media Manager Settings 
Item Description 
Media Server Enable or disable the Media Server service. 
Shared Media Folders Select the folder(s) that contains media files to be shared. 
Rescan Click the Rescan button to have the N8800 for new contents in 

the selected media folder. 

Adding Media Share Folders 
Once the Media Server software is installed, you can start adding folders that 
contain the media that you would like to share. To create a media share folder, 
follow the steps below: 
 

1. Click on Network > Media Server in the menu bar.  
 

2. From the Shared Media Folders window, select the folder that contains 
your media files, and click its checkbox. 

 
3. The contents in the folder will be scanned for the Media Server. The time 

required for scanning depends on the size of the folder. 
 

Connecting DMAs to the Media Server 
Next, it’s time to connect your Digital Media Adapter (DMA) to the media server: 
 

1. Connect your DMA to your Media Server 
 

a. Configure your DMA to use a Dynamic IP address. The IP address 
will be assigned by the router. 

b. Some DMAs are wireless enabled. You can connect the DMA to a 
wireless router. For instructions on how to connect your DMA to a 
wireless router, please refer to your DMA’s user manual. 

 
2. Connect your DMA’s video output to video input of your TV set. 
 
3. Turn on the TV and change the video signal input to DMA. 

 
4. Setup the DMA (These steps will be different if you use a different DMA) 

 
a. From the Server List screen, select “N8800:Mediabolic Server” 

as the server. 
b. Go to My Media 
c. Click on the Up/Down Arrow buttons to select Music Jukebox, 

Photo Albums, or Video Clips 
d. Start enjoying the contents stored in your N8800. 



Printer Server 
You can configure the N8800 to act as a 
printer server. That way, all PCs connected 
to the network can utilize the same printer.  
 

Windows XP SP2 
To set up the Printer Server in Windows XP 
SP2, follow the steps below: 
 

1. Connect the USB printer to one of 
the USB ports (preferably the rear 
USB ports; front USB ports can be 
used for external HDD enclosures). 

 
2. Go to Start > Printers and Faxes. 

 
3. Click on File > Add Printer. 
 
4. The Add Printer Wizard appears on your screen. Click Next. 

 
5. Select the “A network printer, or a printer attached to another 

computer” option. 
 

6. Select “Connect to a printer on the Internet or on a home or office 
network”, and enter “http://N8800_IP_ADDRESS:631/printers/usb-
printer” into the URL field. 

 
7. Your Windows system will ask you to install drivers for your printer. Select 

correct driver for your printer. 
 

8. Your Windows system will ask you if you want to set this printer as 
“Default Printer”. Select Yes and all your print jobs will be submitted to 
this printer by default. Click Next. 

 
9. Click Finish. 

 
 • Not all USB printers are supported. Please check Thecus website for 

a list of supported printers. NOTE  
• Note that if a multi-function (all-in-one) printer is attached to the 

N8800, usually only the printing and fax functions will work. Other 
features, such as scanning, will probably not function. 

 
 

 
 
 

64 



Windows Vista 
To set up the Printer Server in Windows Vista, follow the steps below: 
 

1. Open Printer Folder from the Control Panel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Click the right mouse button in anywhere on the Printers folder and then 
select Add Printer. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select Add a network, wireless or Bluetooth printer. 
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4. Select The printer that I want isn’t listed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can press The printer that I want isn’t listed to go into next page 
without waiting for Searching for available printers to finish. 

 
5. Click Select a shared printer by name. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Type http://<Thecus_NAS>:631/printers/usb-printer in the box, 
where <Thecus_NAS_IP> is the IP address of the N8800. Click Next. 

 
6. Select or install a printer and then press OK. 
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If your printer model is not listed, please contact your printer 
manufacturer for help. 

 
7. Windows will attempt to connect to the printer. 

 
 
 
 
 
 
 
 
 
 
 

 
8. You can choose to set this printer as the default printer by checking the 

Set as the default printer box. Click Next to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
9. Done! Click Finish. 
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Download Manager 
With the built-in Download Manager, you 
can have the N8800 download HTTP, FTP, 
and BT files without having full PC powered 
on. What’s more, you can even schedule 
your downloads for off-peak hours, ensu
efficient use of bandwidth. To access the 
Download Manager, go to Network, choose 
the Download Manager option, and the 
Download Tasks and Download 
Schedule windows

ring 

 appear.  
 
 
 
 
 
Download Tasks 
Item Description 

 Click to start the specified task. 

 Click to pause the specified task. 

 
Click to delete the specified task. A prompt will appear asking you 
if you would like to delete the task itself, or the task and all 
related downloaded files. 

Task Name of the task. Click to see more information about this task. 

Type Type of transfer. Can be HTTP, FTP, or BT. 

Rate 
Transfer rate of the task in kilobytes per second (KB/s). 
DL: Download rate 
UL: Upload rate 

Status 
Status of the task. 
Complete: Percentage complete (%) 
Completed / Total download size 

Task Type 
Use this dropdown to select the type of transfer. HTTP, FTP, and 
BT are available. 

Add Task Click to add the kind of task specified beside “Task Type”. 

Enable Refresh Click to refresh the task list. 
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Adding an HTTP Task 
To add a new HTTP task to the Download Manager, follow these steps: 
 

1. Using the Task Type dropdown, select HTTP and click Add Task.  
 

 
 
2. In the HTTP Task window, start by inputting the target URL in the 

Website URL box. This is the link to the download you want to queue. 
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3. Next, select the destination folder from the Destination Folder dropdown. 

This is where the download will reside. 
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4. Select the maximum download bandwidth from the Max. Download 

Bandwidth dropdown. 
 

 
 

5. Press Apply to add the task. 



 
6. Once added, your download will appear in the list of download tasks. To 

start the download, simply click the Start icon ( ) and the download will 
begin. 
 

 
 
7. The download status will continually update in the Download Tasks 

window. To pause the download, click the Pause icon ( ).  
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Adding an FTP Task 
To add a new FTP task to the Download Manager, follow these steps: 
 

1. Using the Task Type dropdown, select FTP and click Add Task.  
 

 
 
2. In the FTP Task window, start by inputting the target URL in the FTP File 

box. This is the link to the download you want to queue. 
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3. Next, select the destination folder from the Destination Folder dropdown. 

This is where the download will reside. 
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4. The next step depends if you are using an anonymous login for your FTP 

download. If you are logging in anonymously, select Anonymous Login 
and move on to step 5. 

 

 
 



If you are required to login with a user name and password, select 
Username and input your user name and password into the appropriate 
fields.  
 

 
 

5. Select the maximum download bandwidth from the Max. Download 
Bandwidth dropdown. 
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6. Press Apply to add the task. 



 
7. Once added, your download will appear in the list of download tasks. To 

start the download, simply click the Start icon ( ) and the download will 
begin. 
 

 
 
8. The download status will continually update in the Download Tasks 

window. To pause the download, click the Pause icon ( ).  
 

 

 
 
 

75 



 

Adding a BT Task 
To add a new BT task to the Download Manager, follow these steps: 
 

1. Using the Task Type dropdown, select BT and click Add Task.  
 

 
 
2. In the BT Task window, start by clicking Browse… and selecting the 

torrent file you wish to start. 
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3. Next, select the destination folder from the Destination Folder dropdown. 

This is where the download will reside. 
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4. Next, you can select the maximum and minimum number of peers from 

selecting the counts from the appropriate dropdowns. 
 

 
 



 
5. Next, you can set the maximum download and upload bandwidths from 

the dropdowns below. 
 

 
 

6. Press Apply to add the task. 
 
7. Once added, your download will appear in the list of download tasks. To 

start the download, simply click the Start icon ( ) and the download will 
begin. 
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8. The download status will continually update in the Download Tasks window. 

To pause the download, click the Pause icon ( ).  
 

 

Deleting Tasks 
To delete a task, simply follow the steps below: 
 

1. Click the delete icon ( ) beside the task that you wish to delete. The 
Delete Task dialogue box will appear. 

 
2. Select Delete Task only if you wish to remove only the torrent file and all 

transient files, leaving the unfinished download files intact. 
 

3. Select Delete Task and Files if you wish to remove the torrent file and 
all transient files, and the unfinished download files. 

4. Click OK to delete the task. Click Cancel to return to the Download 
Manager. 

Scheduling Downloads 
With the Download Manager, you can schedule your downloads to begin at 
different times of the day. This is useful if you wish to complete your downloads 
during off-peak hours, reserving your bandwidth for other applications. A table 
describing the Download Schedule window appears below: 
 
Download Schedule 
Item Description 
Scheduler Enable or disable the Download Scheduler. 

Daily/Weekly 
Choose to have the Download Scheduler activate on a daily or 
weekly basis. 

Start: Day/Hour 
/Minute 

Specify the start day/hour/minute for the download task. 

End: 
Day/Hour/Minute 

Specify the end day/hour/minute for the download task. 

 

 
 
 

79 



 
To schedule downloads, follow these steps: 
 

1. Under Download Schedule, set Scheduler to Enable. 
 

 
 
2. To schedule a daily download period, select Daily and select a start time 

and end time.  
To schedule a weekly download period, select Weekly and select a start 
day/time and end time/day.  

 

 
 

3. Click Apply to save your changes. 
 

NOTE 
If the Download Scheduler is enabled, ALL download tasks 
designated schedule. 

 will adhere to the 
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Chapter 6: Using the N8800 

Overview 
Once the N8800 is setup and operating, users on the network may manage all 
varieties of digital music, photos, or files by simply using their web browsers. To 
manage your personal files or access public files on the N8800, just enter its IP 
address into your browser (default IP address is http://192.168.1.100), and 
you will be taken to the N8800 Login page. 
 

NOTE 
Before proceeding, make sure that WebDisk Support or Secure 
WebDisk Support is enabled in the Service Support screen in the 
system’s Network menu. See Service Support in Chapter 4: System 
Management > Network Management > Web Services Configuration. 

 
 
 
 

Login Page 
To login to the system, enter your user name and password, and select Web Disk 
or Photo server then click Login to log into the system. You will be taken to the 
selected interface. 
 

 

Using WebDisk 
The N8800 provides a WebDisk function that allows you to access the system 
over the Internet from any browser. 
 

1. In the Login page, type in the User ID and password that were previously 
set for you in the Accounts menu. See Chapter 4: System Management 
> User and Group Management > Local User Configuration. 

 
2. The WebDisk page appears showing folders made currently available to 

you via the Access Control List (ACL). 
 
3. Click on a folder name to enter the folder.  

 
4. The folder’s page appears displaying files and folders. Click on a file to 

download the file. 
 
Folder Page 
Item Description 
Name Displays the names of folders and files. 
Size Shows the size of folders and files. 
Type Displays the type of folders and files. 
Modified Date Shows the time of most recent modification of folders and files. 

 
5. Buttons on the folder page allow you to create a new folder, upload files 

and delete files in the folder. 
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Folder Page Buttons 
Button Description 
Up Goes to the previous folder level. 
New folder Creates a new folder. 
New file (upload) Uploads a file from your computer to the current folder. 
Delete Selected Items Deletes selected files and folders. 

 
6. To create a new folder within the current folder, press the New folder 

button. When the screen appears enter a name for the folder. Press OK to 
create the folder. 

 
7. To upload a file from your computer to the current folder, press the New 

file (upload) button. When the screen appears, press Browse and locate 
the file to upload. Press OK and the file is uploaded to the current folder. 

 
8. To delete a file or folder, select the file or folder’s check box. Press the 

Delete selected items button. You can also check the check box as the red 
circle indicates to select all files and folders in this folder. 

 
To access folders with access control, you must first login with a local user 
account. 
 
For more information on how to setup user rights to the folders, please check 
Chapter 4: System Management > Folder Management > Folder Access 
Control List (ACL).  
 
 

Photo Server 
Using the Photo Server, users can 
view and share photos, and even 
create their own albums right on the 
N8800.  
 
You will see your own Photo Gallery 
and all public Photo Albums on the 
network. 
 
To manage any picture files, you 
must first select the item by clicking 
the box. 
 
 
 
 
 
 

Windows XP Publishing Wizard 
There are many ways for a local user to upload pictures into their photo album. 
Users of Windows XP can upload their pictures using the Windows XP Publishing 
Wizard. 
 

1. Click on the XP Publishing Wizard icon on top right corner.  
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2. The XP Web Publishing Wizard Client screen appears. Click on the link 

to install the Publishing Wizard.  
 

 
 
 
 

3. Windows XP will ask whether you want to run or save this file. Click Save 
to save the register file. . 

  

 
 

4. Once the register file is installed, use the Windows file manager to browse 
the folder that contains the picture you want to publish. On the left pane, 
there will be an icon labeled “Publish this folder to the Web”.  
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5. Click on this icon and Web Publishing Wizard will start.  
 

 
 
 
 

 
6. Select the pictures you want to publish to the Photo Web Server by placing 

a check mark on the top left hand corner of the picture. Click Next.  

 
 

7. Your PC will start to connect to the Photo Web Server. 
 

8. Select N8800 Photo Gallery Wizard to publish your pictures to the 
N8800.  
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9. Login into the N8800 with your local user name and password. 
 

 
 

10. Create your album by entering an album name and clicking on the Create 
Album button.  

 

 
 

11. Select the album you want to upload your pictures to. 
 

12. Confirm the target album.  
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13. Windows will show you that the picture upload is in progress. 

 
 

 
14. When the upload is finished, the Wizard will ask you whether if you want 

to go to the website. Click Finish to go to your Photo Web Server. 
 

  
 

15. Click on the user’s icon to go to that user’s album.  
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16. You will see the user’s album list. Click on Album.  

 

 
 

17. Finished! You will see the pictures just selected in the album.  
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Managing Albums and Photos 
 
Photo 
Icon Function Description 

 
Make Cover Make selected photo your cover picture. 

 
Back Return to the previous screen. 

 
Add Add a new album or photos. 

 
Modify 
 

Edit the name and description of the selected album or 
photo. Each name is limited to 20 characters and each 
description is limited to 255 characters. 

 
Delete Delete the selected albums or photos. 

 

NOTE • Only logged in users will see these icons. 
• To prevent system errors, the N8800 sets the following

files: 
• Each file upload is limited to a size of 4MB. Files e

be uploaded and no error message will appear. 
• Only these photo file types will be uploaded: *.jp

*.pcx, *.psd, *.bmp. 
• If duplicate file names exist during upload proce

number in front of the ori

 
  limitations on photo 

xceeding 4MB will NOT 

g, *.gif, *.bmp, *.png, 

ss, system will add a 
ginal file name (abc Æ

 
 
 
 1abc). 

Creating Albums 
To create a photo album, follow the steps below: 
 

1. Click the Add button to create a new album. 
 

2. Enter a name for the album, and enter a description if you wish. Then, 
click on the Create Album button. 

Password Protecting Albums 
If you would like to put a password on a particular album, follow these steps: 
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1. Select the album to be protected, click on the Edit button, and the Album 
Edit screen will appear.  

 
2. The owner of the album can enter an album password to protect the 

album, so that only people with the correct password can view the album.  

Uploading Pictures to Albums 
Uploading pictures to albums using the Web User Interface is easy: 
 

1. When the album is created, click the album icon to enter the album. 
Initially the album is empty.  

 
2. Click the Add button to upload pictures into the album. The Upload 

Photos screen will appear. Users can select and upload up to 8 pictures at 
a time. 

 
3. Once the picture is uploaded, you can view it in the album. The owner of 

the album can delete or modify the pictures with the Delete or Modify 
buttons on the top right hand corner 

EXIF Information 
While viewing pictures, you can also have the N8800 display the EXIF information 
for each photo. 
 

 
 
Simply click the EXIF button to display EXIF information. To hide this information, 
click the EXIF button again. 

Slide Shows 
Slide shows are a great way to enjoy pictures stored on your N8800.  
 
You can click on the Start Slide Show icon on the top right hand corner to start 
the slide show. 
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To stop the slide show, click on the Stop Slide Show icon on the top right hand 
corner.  
 
 

Mapping a Client PC to the N8800 
You can map share folders on the N8800 so that you can access them as if they 
were drives on your computer. You can connect to the shared network folders on 
the N8800 as follows:  

Windows 
1. Go to the My Computer folder in Windows. 
 
2. In the menu bar, select Tools and then Map Network Drive… 

 
3. The Map Network Drive window appears. 

 
4. Assign a drive letter for the share folder.   

 
5. Click the Browse button to find the folder over your network. Alternatively, 

you may enter the folder name you wish to connect to or enter its IP 
address. (i.e. \\192.168.1.100\share) 

 
6. Click Finish. When the Connect As… window appears, enter your user 

name and password. 
 

7. Click OK. The share folder appears as the drive you assigned. You can now 
access this folder as though it were a drive on your computer.  

Apple OS X 
On an Apple computer, you can connect to shared computers and servers using a 
network address.  
 

1. Choose Go > Connect to Server… 
 
2. Enter the network address for the server in the Server Address text box. 
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When connecting using SMB/CIFS protocol, type: 
smb://192.168.1.100/Folder1 
When connecting using AFP protocol, type: 
afp://192.168.1.100/Folder1 
Click Connect. 
 

3. When MAC OS X is trying to connect N8800, it will ask for a User Name 
and Password which has access to the folder. 

 
4. When MAC OS X has connected to the N8800 successfully, an icon 

representing the folder will appear on the MAC OS X desktop. You can 
access the folder by double clicking on the icon. 

 

Mapping the N8800 as an iSCSI Drive 
With the N8800, you are able to map it as an iSCSI drive. With iSCSI, you can 
remotely access the N8800 at great speeds, as if it were installed as a local drive 
in your computer.  
 
To do this, simply follow the steps below: 

Windows 2000/XP 
 

1. First, download the iSCSI Initiator from the Microsoft website 
(http://www.microsoft.com). You can find this software by entering iSCSI 
Initiator into the search box on their homepage. 

 
2. Once the download is complete, install the iSCSI Initiator by double-

clicking the EXE file. You may be presented with the following security 
warning. Click Run to continue. 

 

 
 

3. You will now install the iSCSI Initiator using the Setup Wizard. Click Next 
to continue. 
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4. Leave the default selections and click Next. 
 

 
 
5. Read the license agreement. To continue with the installation, click I 

Agree and then click Next. 
 

 
 
6. The iSCSI Initiator will now install automatically. Click Finish once 

completed. 
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7. Start the iSCSI Initiator by double-clicking its icon on the desktop. The 
iSCSI Initiator properties window will appear. 

 

 
 
 

 
8. Select the Discovery tab. Under Target Portals, click Add. 
 

 
 
9. Enter the IP address of the N8800. Click OK. 

 

 
 

 
 
 

93 



10. On the iSCSI Initiator Properties window, select the Targets tab. With 
the iSCSI target highlighted, click Log On. The Log On to Target 
dialogue will appear. 

 

 
 
 
11. If you have not enabled CHAP, click OK to continue. 

 

 
 

If you have enabled CHAP, click Advanced. Under Advanced Settings, 
check the CHAP login information checkbox and enter your username 
and password. Click OK.  
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12. Right click My Computer on the desktop and select Manage. 
 

 
 
 
 
 
 
13. Click on Disk Management and you will see a new hard disk listed. 
 

 
 
14. Initialize the new hard disk and you will then be able to use the iSCSI 

target as a local drive. 
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Windows Vista 
Because Windows Vista has the Microsoft iSCSI Initiator pre-installed, you will not 
have to install this piece of software. Instead, start the iSCSI Initiator and follow 
steps 8-14 to map the N8800 as an iSCSI drive. 
 

File Backup 
There are a number of ways to back up data with the N8800.  

Nsync 
You can backup a share folder to another N8800 (Nsync Target) or any FTP 
server for safe keeping as long as you have appropriate access right on that 
target. When using Nsync between two N8800s, you have the option to transmit 
files securely between two N8800s.  
 
If the files on your N8800 are lost for any reason, you can restore those files from 
the target N8800. To backup files regularly, you can set up a scheduled task to 
run only once, daily, weekly, or monthly. You can also limit the bandwidth of your 
Nsync tasks, so other users on the network can share the bandwidth equally. 
 
Under the Storage menu, click Nsync and the Nsync window appears. Below is 
a description of each field: 
 
Nsync 
Item Description 
Task name The name of your Nsync task. 
Server The IP address of your target server 
Share folder The share folder you would want to backup. 
Last Time The time when the last Nsync task was executed. 
Last Status The status of your last Nsync task. 
Action Administrator can run or stop an Nsync task by pressing the 

action button. 
Bandwidth Setting Bandwidth control on Nsync tasks. 
Add Click to add a Nsync task 
Modify Click to modify an Nsync task. 
Restore Restore share folder from an Nsync target. 
Delete Click to delete an Nsync task. Backup files on Nsync target is 

also deleted. 

Adding an Nsync Task 
From the Nsync Information screen, click Add to display the Add Nsync Task 
screen. 
 
Add Nsync Task 
Item Description 
Task Name The name of your Nsync task. 
Manufacturer Select whether the target is a Thecus Product (e.g. N8800) or 

FTP server. 
Target Server IP 
Address 

The IP address of your target server. 

Source Folder The share folder you want to backup. 
Nsync Task Name The name of your Nsync task. 
Authorized Username 
on Target Server 

The account name on the target server. 

Password on Target The password for the username on the target server. 



Server 
Test Connection Click to check the connection to the Target Server. 
Schedule Schedule backup of your share folders. 
Time The time when the Nsync task will run. 
Type Select whether to run the Nsync task daily, weekly, or monthly.  

Daily: input the time of day to execute Nsync task. 
Weekly: input which day of the week to execute the task.  
Monthly: decide which day of the month to execute the task. 

Apply Click to submit the task. 
 

NOTE 
Before starting an Nsync Task, make sure the targ
Server (or FTP Server) is enabled.  et server’s Nsync 

 
 

Setting Up an Nsync Target on an Nsync Device 
On the Nsync target server, the administrator of that server has to set up a user 
account with a folder named “nsync” and grant write access. 
  

1. On the Nsync server, add a user for Nsync source (ex. nsyncsource1). For 
instructions on how to add a user on the N8800, see Chapter 4: System 
Management > User and Groups Management > Local User 
Configuration > Adding Users. 

 
2. On the Nsync server, grant that user (ex. nsyncsource1) write access to 

the nsync folder. For instructions on how to set up a folder’s ACL, see 
Chapter 4: System Management > Folder Management > Folder 
Access Control List (ACL). 

 
3. Once this is done, the target server will start accepting Nsync tasks from 

server using that ID and password. 

Setting Up an Nsync Target on Another Device 
If you selected “Other Device” when setting up your Nsync task, the N8800 will 
use the FTP protocol to back up the share folder. On the external storage device, 
make sure there is a folder named “nsync”, and the Auth ID has writable 
permission in that folder. 

Designating N8800 as an Nsync Target 
The N8800 can act as an Nsync server, enabling another Nsync-equipped Thecus 
NAS at a remote location backup their files to this N8800. From the Network 
menu, choose the Nsync Target item, and the Nsync Target Server Setting 
screen appears. 
 
Nsync Target Server Setting 
Item Description 
Nsync Target Server Enable or Disable Nsync Target support. 

 

NOTE 
To enable Nsync task to go thru firewall, you have 
TCP/1194 on your firewall in both directions. 

 to open port 
 
 

Thecus Backup Utility 
The Thecus Backup Utility is on your Installation CD. When you click on the CD, 
the Backup Utility will be installed under Program Groups > Thecus > Thecus 
Backup Utility. If it is not installed, you can copy the file (Thecus Backup 
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Utility.exe) to a convenient location on your hard disk and double click to 
execute it. 
 

 
 

NOTE 
If you can not find Thecus Backup Utility on your C
from the Thecus website (http://www.thecus.com

 D, please download it 
). 

 
 
When you execute this utility for the first time, it will ask you whether to create a 
DB file. Click Yes. 
 

1. Click Add to create a Backup task. The Add New Task dialog box appears. 
 
Add New Task 
Item Description 
Task Specifies a name for the current task. 
Source Click to specify the source folder/file location. 
Incremental Click to specify whether the backup will be incremental. 

If unchecked, the backup will be a full backup. 
Destination Click to specify the destination folder/file location. 
Excluded extensions Files with these file name extensions will be skipped and not 

back up to the destination. 
Comments If you wish, enter comments here for your records. 

 
2. To schedule the task to run at regular intervals, click on the Schedule 

icon for that task. You can schedule the task to run Monthly or Weekly. 
 

3. To check the log for that task, click on the Log icon for that task. 
 

NOTE 
Thecus Backup Utility also supports MAC OS X. Just copy the Thecus 
Backup Utility.dmg to your MAC OS X machine and double click to 
execute it. 
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Windows XP Data Backup 
If you use Windows XP Professional, you can also use the Windows Backup Utility 
(Ntbackup.exe) to backup your files. 
 
If you use Windows XP Home Edition, follow these steps to install the utility: 
 

1. Insert the Windows XP CD into a drive and double-click the CD icon in My 
Computer. 

 
2. When the Welcome to Microsoft Windows XP screen appears, click 

Perform Additional Tasks.  
 

3. Click Browse this CD.  
 

4. In Windows Explorer, navigate to ValueAdd > Msft > Ntbackup.  
 

5. Double-click Ntbackup.msi to install the backup utility. 
 
Once installed, you can use the Windows Backup Utility by following the steps 
below: 
 

1. Click Start, and point to All Programs > Accessories > System Tools 
> Backup to start the wizard. 

 
2. Click Next to skip past the opening page. Choose Backup files and 

settings from the second page, and then click Next.  
 

3. Select which option you want to back up. 
 

4. Click Next and in the Backup Type, Destination, and Name page, specify a 
back up location using the Browse button. 

 
5. Find and select the drive that specifies your N8800 as your backup 

destination and click Next. 
 

6. Click Next to display the wizard’s final page and click Finish to start 
backing up.  

Apple OS X Backup Utilities 
Mac OS X does not include any backup software. However, there are a number of 
backup solutions available for the Mac OS X, including: iBackup, Psyncx, iMSafe, 
Rsyncx, Folder Synchronizer X, Tri-BACKUP, Impression, Intego Personal Backup, 
SilverKeeper, and Apple's dotMac Backup utility to name just a few. To find even 
more freeware and shareware backup utilities to choose from, go to 
VersionTracker or MacUpdate and search on "backup". 
 

http://www.grapefruit.ch/grapefruit/iBackup/
http://sourceforge.net/projects/psyncx
http://homepage.mac.com/sweetcocoa/imsafe/
http://www.macosxlabs.org/rsyncx/rsyncx.html
http://www.softobe.com/products/flsy/pp.html
http://www.tri-edre.com/english/tribackup.html
http://babelcompany.com/impression/
http://www.intego.com/personalbackup/home.html
http://www.lacie.com/silverkeeper/
http://www.versiontracker.com/
http://www.macupdate.com/


Chapter 7: Tips and Tricks 

USB and eSATA Storage Expansion 
The N8800 supports external USB hard disks through its four USB ports. Once a 
USB hard disk has successfully mounted, the entire volume will be copied 
automatically to the default USB HDD folder. The N8800 supports up to 4 USB 
external storage devices. All file names on the USB disk volume are case sensitive. 
 
The N8800 also supports eSATA hard disks with its eSATA port. 
 
Before attaching an eSATA or USB disk drive to N8800, you have to partition and 
format it on a desktop computer or a notebook first. The attached device will be 
located at \\192.168.1.100\usbhdd\sdf1 where 192.168.1.100 means the IP 
address of N8800 and sdf1 stands for the first partition on disk #6, the eSATA or 
USB disk drive. If it is an NTFS partition, NAS users can open or copy files from 
\\192.168.1.100\usbhdd\sdf1 but cannot add new files or modify existing files.  
 

NOTE If you want to write to an USB storage device, the file system must be 
FAT32. 
 

USB Storage FAT32 Partition NTFS Partition 
Read OK OK 
Write OK - 

 

 
 
 
 
 
 

Adding a Spare Disk  
With a RAID 1, RAID 5, RAID 6, or RAID 10 volume, you can add a spare disk 
after the initial RAID is setup. To add a spare disk, follow the steps below: 
 

1. On the RAID Configuration Screen, tick the checkbox of the hard disk 
you wish to designate as a spare disk. 

 
2. Click Add Spare. The disk will be configured as a spare disk. The system 

automatically rebuilds the spare disk when one of the disks in the RAID set 
fails.  

 

Remote Administration 
You can set up your N8800 for remote administration. With remote administration, 
you can access your N8800 over the Internet, even if your N8800 is behind a 
router. This is especially useful if you are traveling and suddenly need a file from 
your N8800.  
 
Setting up remote administration is a three-part process, and will require the 
following equipment: 
 
• Thecus N8800 NAS device 
• Cable/DSL Router with Dynamic DNS support 
• Home PC 
• Internet Connection 
 
 Router setup will differ slightly depending on router used. For this 

example, we will use the Asus WL500g because it has support for 
Dynamic DNS. Contact your router hardware vendor for setup help. 

NOTE  
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Part I - Setup a DynDNS Account 
 

1. Go to http://www.dyndns.org from your home PC. 
2. Click on the Sign Up Now link. 
3. Check the Check boxes, select a user name (i.e.: N8800), enter your 

email address (i.e.: xxx@example.com), check Enable Wildcard, and 
create a password (i.e.: xxxx). 

4. Wait for an email from www.dyndns.org. 
5. Open the email and click on the link to activate your account 

Part II - Enable DDNS on the Router 
 

1. Go to the router setup screen and select IP Config > Miscellaneous 
DDNS Setting from your Home PC. 

2. Click on Yes for Enable the DDNS Client? 
3. Select www.dyndns.org. 
4. Go to router setup screen, and enter the following information: 

a. User Name or E-mail Address: xxx@example.com 
b. Password or DDNS Key: xxxx 
c. Host Name: www.N8800.dyndns.org 
d. Enable wildcard? Select Yes 
e. Update Manually: Click Update 

Part III - Setting up Virtual Servers (HTTPS) 
 

1. Navigate to NAT Setting > Virtual Server. 
2. For Enable Virtual Server?, select Yes 
3. Setup the HTTPS Server 

a. Well-Known Applications: Select User Defined 
b. Local IP: Enter 192.168.1.100 
c. Port Range: 443 (the default HTTPS port setting on the N8800) 
d. Protocol: select TCP 
e. Click Add. 
f. Click Apply. 

4. Test the HTTPS connection from another computer on the Internet 
a. From a remote computer, open your browser and enter 

https://www.N8800.dyndns.org 
b. You should see the login page of N8800. 

Firewall Software Configuration 
If you are using a software firewall (i.e. Norton Internet Security) and are having 
trouble connecting to the N8800, you can try the following steps: 
 

1. Double click the NIS icon on system tray, and then configure the 
Personal Firewall. 

 
2. On the Programs page, find the SetupWizard.exe and change its 

permission to "Permit All". If it's not in the program list, use the Add or 
Program Scan buttons to find it. 

 
3. On the Networking page, manually add N8800 IP address (i.e. 

192.168.1.100) to the Trusted list.  
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Replacing Damaged Hard Drives 
If you are using RAID 1, RAID 5, RAID 6, or RAID 10, you can easily replace a 
damaged hard drive in the Thecus N8800 while keeping your data secure with the 
system’s automatic data recovery.  

Hard Drive Damage 
When a hard drive is damaged and data in the RAID volume, the system LCD will 
display warning message also the system beeps. 

Replacing a Hard Drive  
To replace a hard disk drive in the N8800: 
 

1. Remove the tray with the damaged hard disk. 
2. Unscrew the damaged hard disk and remove it from the tray. 

 
3. Slide a new hard disk into the tray and fasten the screws. 

 
4. Insert the hard disk tray back into the N8800 until it snaps into place. You 

can also lock it with a key if desired. 
 

5. The LED blinks green when the HDD is accessed. 

RAID Auto-Rebuild 
When using RAID 1, 5, 6, or 10 on the N8800, you can use the auto-rebuild 
function when an error is detected.  
 

1. When a hard disk fails the system beeps and/or an email notification is 
sent to specified receivers. 

 
2. Check the LCD to see which disk has failed. 

 
3. Follow the steps mentioned above to replace the failed hard disk. 

 
4. The system automatically recognizes the new hard disk and starts the 

auto-rebuild sequence to resume its status before the hard disk crash. 



Chapter 8: Troubleshooting 

Forgot My Network IP Address 
If you forget your network IP address and have no physical access to the system, 
you can find out the IP address by either looking directly onto the N8800’s LCD 
panel, or by using the setup wizard to retrieve the IP of your N8800. 
 

1. Start the Setup Wizard, and it will automatically detect all Thecus IP 
storage products on your network. 

 
2. You should be able to find the IP address of the N8800 which you have 

forgotten in the Device Discovery screen. 

Can't Map a Network Drive in Windows XP 
You may have problems mapping a network drive under the following conditions: 
 

1. The network folder is currently mapped using a different user name and 
password. To connect using a different user name and password, first 
disconnect any existing mappings to this network share. 

 
2. The mapped network drive could not be created because the following 

error has occurred: Multiple connections to a server or shared 
resource by the same user, using more than one user name, are 
not allowed. Disconnect all previous connections to the server or shared 
resource and try again. 

 
To check out existing network connections, type net use under the DOS prompt.  
You may refer the URL below for more network mapping information.  
 
http://esupport.thecus.com/support/index.php?_m=downloads&_a=viewdownload&
downloaditemid=57&nav=0 
 

Restoring Factory Defaults 
From the System menu, choose the Factory Default item and the Reset to 
Factory Default screen appears. Press Apply to reset the N8800 to factory 
default settings. 
 
 

WARNING 
Resetting to factory defaults will not erase the data
disks, but WILL revert all the settings to the factor

 stored in the hard 
y default values.  

 

Problems with Time and Date Settings 
The administrator is able to select an NTP Server to keep the N8800’s time 
synchronized. However, if the N8800 can not access the Internet, you may 
encounter a problem when setting the Time and Time Zone. If this happens: 
  

1. Login to the Web Administration Interface. 
 
2. Navigate to System > Time. 

 
3. Under NTP Server, select No. 
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http://esupport.thecus.com/support/index.php?_m=downloads&_a=viewdownload&downloaditemid=57&nav=0
http://esupport.thecus.com/support/index.php?_m=downloads&_a=viewdownload&downloaditemid=57&nav=0
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4. Set the Date, Time, and Time Zone. 
 

5. Click Apply. 
 
In addition, if the N8800 is able to access the Internet and you want to keep the 
NTP Server clock.isc.org by default, please make sure the DNS Server is correctly 
entered, thereby allowing the NTP Server name to correctly resolve. (See 
Network > WAN > DNS Server) 
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Appendix A: Product Specifications 

Hardware Specifications 
 
Product Model N8800 
Network Interfaces 
WAN Gigabit RJ-45 connector 
LAN  Gigabit RJ-45 connector 
Storage 
HDD Bays 8 x 3.5” SATA II HDD, hot-swappable 
HDD Support SATA II HDDs up to 1000GB 
eSATA 1 x eSATA connector for capacity expansion 
I/O Interfaces 
USB Ports 4 x USB type A ports (Host mode) 
System Information 
LCD Control Panel For basic configurations and status display 
System LED Display 2 x LED (Power, System fan failed) 
Physical 
Height 87 mm 
Width 430 mm 
Depth 600 mm 
Power Supply Server-rated AC redundant power supply 

100/220V AC, 50/60Hz, Auto-detect 
Security Lockable disk trays 
Environment 
Temperature 5 ~ 40°C 
Humidity 20 ~ 85% relative humidity (non-condensing) 
Certifications CE, FCC, BSMI, C-Tick, RoHS Compliant 

 
 

Software Specifications 
 
Network File Protocols Microsoft Networks (CIFS/SMB) 

Apple Filing Protocol (AFP 3.0) 
Network File System (NFS v3) 
File Transfer Protocol (FTP) 
Hyper Text Transfer Protocol (HTTP) 
Secure Hyper Text Transfer Protocol (HTTPs) 

Authentication Local User Account 
Microsoft Active Directory Authentication (AD)* 

Network Client Type Microsoft Windows NT/2000/XP/2003/Vista 
Unix/Linux/BSD 
MAC OS X/9 

Network Configuration Fixed IP address 
Dynamic IP address 
802.3ad based failover and link aggregation 

Disk Management Disk status monitoring (S.M.A.R.T.) 
Disk idle spin-down 

RAID RAID 0, 1, 5, 6, 10 and JBOD 
Supports multiple RAID modes – users can create 
multiple RAID volumes with different RAID levels in 
one system 
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Auto rebuild 
Hot swappable 
Hot spare 
Disk roaming 
RAID level migration 
RAID expansion 

iSCSI Target Supports: 
Microsoft iSCSI Initiator v2.0.4 
StarPort Initiator V3.5.2 
MAC OS: globalSAN iSCSI initiator version 3.0 
(1150) 
Linux: open-iscsi 2.0-865 

Folder Management Share folder level permission 
Public folder 

Quota Management Share folder quota control 
Backup Thecus Backup Utility (Windows XP/2000 and MAC 

OS X) 
Thecus Nsync 

System Management Web GUI 
Multilingual support (English, French, German, 
Italian, Traditional Chinese, Simplified Chinese, 
Japanese, Korean, and Spanish) 
NTP support 
Wake-on-LAN 
Scheduled Power On/Off 

Event Notification Email notification 
Buzzer notification 
LCD 

UPS Support UPS monitoring via RS-232 and system shutdown 
on low battery 

Printer Server USB Printer (IPP support) 
Supported USB Devices USB Printer 

External HDD/flash disk 
USB IEEE 802.11 b/g dongle w/AP mode support** 

Setup Utility Windows 2000/XP/2003 
MAC OS X 

 
*AD support: Works as a client member in a Microsoft Active Directory domain, 
allowing the N8800 to utilize the domain users and groups setting for 
authentication to the system and authorization to the share folders. 
 
**For supported USB dongles, please contact sales@thecus.com 
 
 

mailto:sales@thecus.com


Appendix B: Customer Support 
 
If your N8800 is not working properly, we encourage you to check out Chapter 8: 
Troubleshooting, located in this manual. You can also try to ensure that you are 
using the latest firmware version for your N8800. Thecus is committed to 
providing free firmware upgrades to our customers. Our newest firmware is 
available on our Download Center: 
 
http://www.thecus.com/download.php 
 
If you are still experiencing problems with your N8800, or require a Return 
Merchandise Authorization (RMA), feel free to contact technical support via our 
Technical Support Website: 
 
http://www.thecus.com/support_tech.php 
 
Customers in the US should send all technical support enquiries to this email 
address: 
 
support-us@thecus.com 
 
 
For Sales Information you can e-mail us at: 
 
sales@thecus.com 
 
 
 
 

Thank you for choosing 
Thecus! 
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http://www.thecus.com/download.php
http://www.thecus.com/support_tech.php
mailto:support-us@thecus.com?subject=N1200%20Support
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Appendix C: RAID Basics 

Overview 
A Redundant Array of Independent Disks (RAID) is an array of several hard disks 
that provide data security and high performance. A RAID system accesses several 
hard disks simultaneously, which improves I/O performance over a single hard 
disk. Data security is enhanced by a RAID, since data loss due to a hard disk 
failure is minimized by regenerating redundant data from the other RAID hard 
disks. 
 

Benefits 
RAID improves I/O performance, and increases data security through fault 
tolerance and redundant data storage. 

Improved Performance 
RAID provides access to several hard disk drives simultaneously, which greatly 
increases I/O performance. 

Data Security 
Hard disk drive failure unfortunately is a common occurrence. A RAID helps 
prevent against the loss of data due to hard disk failure. A RAID offers additional 
hard disk drives that can avert data loss from a hard disk drive failure. If a hard 
drive fails, the RAID volume can regenerate data from the data and parity stored 
on its other hard disk drives. 
 

RAID Levels 
The Thecus N8800 supports standard RAID levels 0, 1, 5, 6, 10, and JBOD. You 
choose a RAID level when you create a system volume. The factors for selecting a 
RAID level are: 
 

• Your requirements for performance 
• Your need for data security 
• Number of hard disk drives in the system, capacity of hard disk drives in 

the system 
 
The following is a description of each RAID level: 

RAID 0 
RAID 0 is best suited for applications that need high bandwidth but do not require 
a high level of data security. The RAID 0 level provides the best performance of 
all the RAID levels, but it does not provide data redundancy.  
 
RAID 0 uses disk striping and breaking up data into blocks to write across all hard 
drives in the volume. The system can then use multiple hard drives for faster 
read and write. The stripe size parameter that was set when the RAID was 
created determines the size of each block. No parity calculations complicate the 
write operation.  
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RAID 1 
RAID 1 mirrors all data from one hard disk drive to a second one hard disk drive, 
thus providing complete data redundancy. However, the cost of data storage 
capacity is doubled.  
 
This is excellent for complete data security. 

RAID 5 
RAID 5 offers data security and it is best suited for networks that perform many 
small I/O transactions at the same time, as well as applications that require data 
security such as office automation and online customer service. Use it also for 
applications with high read requests but low write requests. 
 
RAID 5 includes disk striping at the byte level and parity information is written to 
several hard disk drives. If a hard disk fails the system uses parity stored on each 
of the other hard disks to recreate all missing information. 

RAID 6 
RAID 6 is essentially an extension of RAID level 5 which allows for additional fault 
tolerance by using a second independent distributed parity scheme (dual parity) 
Data is striped on a block level across a set of drives, just like in RAID 5, and a 
second set of parity is calculated and written across all the drives; RAID 6 
provides for an extremely high data fault tolerance and can sustain two 
simultaneous drive failures. 
 
This is a perfect solution for mission critical applications. 

RAID 10 
RAID 10 is implemented as a striped array whose segments are RAID 1 arrays. 
RAID 10 has the same fault tolerance as RAID level 1. 
RAID 10 has the same overhead for fault-tolerance as mirroring alone. High I/O 
rates are achieved by striping RAID 1 segments. 
Under certain circumstances, RAID 10 array can sustain up to 2 simultaneous 
drive failures 
 
Excellent solution for applications that would have otherwise gone with RAID 1 
but need an additional performance boost. 

JBOD 
Although a concatenation of disks (also called JBOD, or "Just a Bunch of Disks") is 
not one of the numbered RAID levels, it is a popular method for combining 
multiple physical disk drives into a single virtual one. As the name implies, disks 
are merely concatenated together, end to beginning, so they appear to be a 
single large disk. 
 
As the data on JBOD is not protected, one drive failure could result total data loss. 
 

Stripe Size 
The length of the data segments being written across multiple hard disks. Data is 
written in stripes across the multiple hard disks of a RAID. Since multiple disks 
are accessed at the same time, disk striping enhances performance. The stripes 
can vary in size.   
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Disk Usage 
When all 8 disks are of the same size, and used in RAID, N8800 disk usage 
percentage is listed below: 
 

RAID Level Percentage Used 
RAID 0 100% 
RAID 1 20% 
RAID 5 80% 
RAID 6 60% 
RAID 10 50% 

JBOD 100% 
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Appendix D: Active Directory Basics 

Overview 
With Windows 2000, Microsoft introduced Active Directory (ADS), which is a large 
database/information store. Prior to Active Directory the Windows OS could not 
store additional information in its domain database. Active Directory also solved 
the problem of locating resources; which previously relied on Network 
Neighborhood, and was slow. Managing users and groups were among other 
issues Active Directory solved. 

What is Active Directory? 
Active Directory was built as a scalable, extensible directory service that was 
designed to meet corporate needs. A repository for storing user information, 
accounts, passwords, printers, computers, network information and other data, 
Microsoft calls Active Directory a "namespace" where names can be resolved. 

ADS Benefits 
ADS lets the N8800 integrate itself with the existing ADS in an office environment. 
This means the N8800 is able to recognize your office users and passwords on the 
ADS server. Other major benefits ADS support provides include: 
 

1. Easy integration of the N8800 into the existing office IT infrastructure 
 

The N8800 acts as a member of the ADS. This feature significantly lowers 
the overhead of the system administrator. For example, corporate security 
policies and user privileges on an ADS server can be enforced 
automatically on the N8800. 

 
2. Centralized user/password database 
 

The N8800 does not maintain its own copy of the user/password database. 
This avoids data inconsistency between the N8800 and other servers. For 
example, without ADS support, an administrator might need to remove a 
specific user privilege on the N8800 and each individual server. With ADS 
support, the change on an ADS server is known to all of its ADS members. 
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Appendix E: UPS Compatibility List 
 

Brand Series Model Notes 
Ablerex MS-RT     

ActivePower 1400VA     

AEC MiniGuard UPS 700 M2501 
cable     

Back-UPS Pro     
Matrix-UPS     
Smart-UPS     
Back-UPS 940-0095A/C cables, 940-0020B/C cables, 940-0023A cable   
Back-UPS Office 940-0119A cable   
Masterswitch Not a UPS - 940-
0020 cable     

APC 

Back-UPS RS 500 custom non-
USB cable     

Regulator Pro serial     
Resource     
Home Office F6H350-SER, F6H500-SER, F6H650-SER   

Belkin 

Universal UPS F6C800-UNV, F6C120-UNV, F6C1100-UNV, F6H500ukUNV   
Fortress (newer)     
Fortress Telecom     
Axxium Rackmount     
Patriot Pro     
Patriot Pro II     
Patriot INT51 cable     
Micro-Ferrups     

Best Power 

Fortress/Ferrups f-command 
support     

Centralion Blazer     
Clary ST-800     

Compaq T1500h     

Cyber Power 
Systems   

320AVR, 500AVR, 650AVR, 700AVR, 800AVR 
850AVR, 900AVR, 1250AVR,. 1500AVR, Power99 
550SL, 725SL, CPS825VA, 1100AVR, 1500AVR-HO 

  

Deltec PowerRite Pro II     
Dynex 975AVR     
Effekta MI/MT/MH 2502 cable     

Energy Sistem (various)     
ETA mini+UPS WinNT/Upsoft cable     

ETA mini+UPS PRO UPS Explorer 
cable     

NET *-DPC     
Ever UPS 

AP *-PRO     
Ever-Power 625/1000     

Exide NetUPS SE     
PowerPal P-series     
PowerPal L-series     
PowerOn     

Fenton 
Technologies 

PowerPure     
Fairstone   L525/L625/L750   

Ares 700 and larger     
Fideltronik 

Other Ares models     
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Brand Series Model Notes 
PowerRite MAX     

Fiskars 
PowerServer 10, 30   
All models with alarm interface     
MP110/210     
MS-T     
MS     

Gamatronic 

µPS3/1     
Gemini UPS625/UPS1000     

R3000 XR     
HP 

R5500 XR     
INELT Monolith 1000LT     
Infosec iPEL 350, 500, 750, 1000   
Ippon (various)     

Liebert UPStation GXT2 contact-closure 
cable     

Masterguard (various)     
HF Line 1..4 boards, /2 5..8 boards   
HF Millennium 810, 820   
HF TOP Line 910, 920, 930, 940, 950, 960, 970, 980   

ECO Network 750, M1000, M1050, M1500, M1800 
M2000, M2100, M2500, M3000   

ECO 305, 308, 311, 511, 516, 519, 522   
ally HF 800, 1000, 1250, 1600, 2000, 2500   

Meta System 

Megaline 1250, 2500, 3750, 5000, 6250, 7500, 8750, 10000   
NOVA AVR 600 Serial     
NOVA AVR 1100 Serial     
Pulsar Ellipse USBS Serial cable, S, Premium USBS Serial cable, Premium S   

Ellipse Office 600 Serial cable, 750 Serial cable, 1000 Serial cable, 1500 Serial 
cable   

Pulsar EXtreme C / EX RT     
Comet EX RT  Serial port, 3:1 Serial port   
Pulsar Esprit     
Evolution S 1250, 1750, 2500, 3000 Serial Port 
Pulsar M 2200, 3000, 3000 XL Serial Port 

700, 1000, 1500, 1000 RT2U, 1500 RT2U, MX 4000 RT, MX 5000 
RT Pulsar Evolution, EXtreme C, ES+, ESV+, SV, ESV, EX, EXL, PSX, SX, 
Extreme 

Serial Port 

Comet EXtreme     

MGE UPS 
SYSTEMS 

Comet / Galaxy (Serial)  Utalk Serial Card (ref 66060), HID COM Serial Card (ref 66066)   
MicroDowell B.Box BP 500, 750, 1000, 1500   

Solis 1.0 1000VA, 1.5 1500VA, 2.0 2000VA, 3.0 3000VA   
Microsol 

Rhino 6.0 6000VA, 7.5 7500VA, 10.0 10000VA, 20.0 20000VA   
Various     

Mustek 
Powermust 400VA Plus, 600VA Plus, 800VA Pro 

1000VA Plus, 1400VA Plus, 2000VA USB   

Nitram Elite 500, 2002   

Oneac EG/ON Series advanced 
interface     

Online P-Series     
OnLite AQUA 50     
Orvaldi various not 400 or 600     

SMK-800A     Powercom 
 

ULT-1000     



Brand Series Model Notes 
TrustTrust 425/625     
BNT-1000AP     
Advice Partner/King Pr750     

Powercom 

BNT-2000AP     
PowerGuard PG-600     

PowerKinetics 9001     
PowerTech Comp1000 DTR cable power     

Power Walker Line-Interactive VI1000     

Powerware   3110, 3115, 5119, 5125, 5119 RM, PW5115 
PW5125PW9120, PW9125, 9120, 9150, 9305   

Powerwell PM525A/-625A/-800A/-1000A/-
1250A     

RPF525/625/800/1000     
RPT-800A     Repotec 

RPT-162A     
SMS (Brazil) Manager III     

SOLA   325, 520, 610, 620, 330   
SOLA/BASIC 

Mexico various ISBMEX protocol     

Socomec 
Sicon Egys 420 VA     

Soltec Winmate 525/625/800/1000     
Soyntec Sekury C 500, 800   

SquareOne 
Power QP1000     

SuperPower HP360, Hope-550     
500/1000 smart - shipped with 
SafeNet     

500/1000 contact closure - 
shipped with UPSmart     Sweex 

BC100060 800VA     
Sysgration UPGUARDS Pro650     

Tecnoware Easy Power 1200     
SmartUPS     
SmartOnline     Tripp-Lite 
(various) Lan 2.2 interface - 
black 73-0844 cable     

Trust UPS 1000 Management PW-
4105     

UNITEK Alpha 500 IC, 1000is, 500 ipE   
LAN Saver 600     

UPSonic 
Power Guardian     
(various)     

Victron/IMV 
Lite crack cable     

 
 

• The UPSes marked Blue have been tested and work well 
• If your UPS is not in the support list, be sure that the UPS supports 

one of following protocols: 
o SEC protocol 
o Generic RUPS model 
o Generic RUPS 2000 (Megatec M2501 cable) 
o PhoenixTec protocol 
o Safenet software 

NOTE  
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Appendix F: Licensing Information 

Overview 
This product included copyrighted third-party software licensed under the terms 
of GNU General Public License. Please see THE GNU General Public License for 
extra terms and conditions of this license. 

Source Code Availability 
Thecus Technology Corp. has exposed the full source code of the GPL licensed 
software. For more information on how you can obtain our source code, please 
visit our web site, http://www.thecus.com. 
 
Copyrights  
 

• This product includes cryptographic software written by Eric Young 
(eay@cryptsoft.com). 

• This product includes software developed by Mark Murray. 

• This product includes software developed by Eric Young 
(eay@cryptsoft.com). 

• This product includes software developed by the OpenSSL Project for use in 
the OpenSSL Toolkit (http://www.openssl.org/). 

• This product includes PHP, freely available from (http://www.php.net/). 

• This product includes software developed by the University of California, 
Berkeley and its contributors. 

• This product includes software developed by Winning Strategies, Inc. 

• This product includes software developed by the Apache Group for use in 
the Apache HTTP server project (http://www.apache.org/). 

• This product includes software developed by Softweyr LLC, the University 
of California, Berkeley, and its contributors. 

• This product includes software developed by Bodo Moeller. 

• This product includes software developed by Greg Roelofs and contributors 
for the book, "PNG: The Definitive Guide," published by O'Reilly and 
Associates. 

• This product includes software developed by the NetBSD Foundation, Inc. 
and its contributors. 

• This product includes software developed by Yen Yen Lim and North Dakota 
State University. 

• This product includes software developed by the Computer Systems 
Engineering Group at Lawrence Berkeley Laboratory. 

• This product includes software developed by the Kungliga Tekniska 
Högskolan and its contributors. 

• This product includes software developed by the Nick Simicich. 

• This product includes software written by Tim Hudson (tjh@cryptsoft.com). 

• This product includes software developed by Christopher G. Demetriou for 
the NetBSD Project. 

http://www.thecus.com/
mailto:eay@cryptsoft.com
mailto:eay@cryptsoft.com
http://www.openssl.org/
http://www.php.net/
http://www.apache.org/
mailto:tjh@cryptsoft.com
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CGIC License Terms 
Basic License 
 
CGIC, copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by 
Thomas Boutell and Boutell.Com, Inc. 
 
Permission is granted to use CGIC in any application, commercial or 
noncommercial, at no cost. HOWEVER, this copyright paragraph must appear on 
a "credits" page accessible in the public online and offline documentation of the 
program. Modified versions of the CGIC library should not be distributed without 
the attachment of a clear statement regarding the author of the modifications, 
and this notice may in no case be removed. Modifications may also be submitted 
to the author for inclusion in the main CGIC distribution. 

GNU General Public License 
Version 2, June 1991 
 
Copyright © 1989, 1991 Free Software Foundation, Inc. 
51 Franklin St, Fifth Floor, Boston, MA  02110-1301  USA 
 
Everyone is permitted to copy and distribute verbatim copies of this license 
document, but changing it is not allowed. 
 

PREAMBLE 
 
The licenses for most software are designed to take away your freedom to share 
and change it.  By contrast, the GNU General Public License is intended to 
guarantee your freedom to share and change free software--to make sure the 
software is free for all its users.  This General Public License applies to most of 
the Free Software 
Foundation's software and to any other program whose authors commit to using 
it.  (Some other Free Software Foundation software is covered by the GNU Library 
General Public License instead.)  You can apply it to your programs, too. 
 
When we speak of free software, we are referring to freedom, not price.  Our 
General Public Licenses are designed to make sure that you have the freedom to 
distribute copies of free software (and charge for this service if you wish), that 
you receive source code or can get it if you want it, that you can change the 
software or use pieces of it in new free programs; and that you know you can do 
these things. 
 
To protect your rights, we need to make restrictions that forbid anyone to deny 
you these rights or to ask you to surrender the rights. These restrictions translate 
to certain responsibilities for you if you distribute copies of the software, or if you 
modify it. 
 
For example, if you distribute copies of such a program, whether gratis or for a 
fee, you must give the recipients all the rights that you have. You must make 
sure that they, too, receive or can get the source code.  And you must show them 
these terms so they know their rights. 
 
We protect your rights with two steps: (1) copyright the software, and (2) offer 
you this license which gives you legal permission to copy, distribute and/or 
modify the software. 
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Also, for each author's protection and ours, we want to make certain that 
everyone understands that there is no warranty for this free software.  If the 
software is modified by someone else and passed on, we want its recipients to 
know that what they have is not the original, so that any problems introduced by 
others will not reflect on the original authors' reputations. 
 
Finally, any free program is threatened constantly by software patents.  We wish 
to avoid the danger that redistributors of a free program will individually obtain 
patent licenses, in effect making the program proprietary.  To prevent this, we 
have made it clear that any patent must be licensed for everyone's free use or 
not licensed at all. 
 
The precise terms and conditions for copying, distribution and modification follow. 
 

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 
 
0. This License applies to any program or other work which contains a notice 

placed by the copyright holder saying it may be distributed under the terms of 
this General Public License.  The "Program", below, refers to any such 
program or work, and a "work based on the Program" means either the 
Program or any derivative work under copyright law: that is to say, a work 
containing the Program or a portion of it, either verbatim or with modifications 
and/or translated into another language.  (Hereinafter, translation is included 
without limitation in the term "modification".)  Each licensee is addressed as 
"you". 

 
Activities other than copying, distribution and modification are not covered by 
this License; they are outside its scope.  The act of running the Program is not 
restricted, and the output from the Program is covered only if its contents 
constitute a work based on the Program (independent of having been made 
by running the Program). 
 
Whether that is true depends on what the Program does. 

 
1. You may copy and distribute verbatim copies of the Program's source code as 

you receive it, in any medium, provided that you conspicuously and 
appropriately publish on each copy an appropriate copyright notice and 
disclaimer of warranty; keep intact all the notices that refer to this License 
and to the absence of any warranty; and give any other recipients of the 
Program a copy of this License along with the Program. 

 
You may charge a fee for the physical act of transferring a copy, and you may 
at your option offer warranty protection in exchange for a fee. 

 
2. You may modify your copy or copies of the Program or any portion of it, thus 

forming a work based on the Program, and copy and distribute such 
modifications or work under the terms of Section 1 above, provided that you 
also meet all of these conditions: 

 
a) You must cause the modified files to carry prominent notices stating that 

you changed the files and the date of any change. 
 
b) You must cause any work that you distribute or publish, that in whole or in 

part contains or is derived from the Program or any part thereof, to be 
licensed as a whole at no charge to all third parties under the terms of this 
License. 
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c) If the modified program normally reads commands interactively when run, 
you must cause it, when started running for such interactive use in the 
most ordinary way, to print or display an announcement including an 
appropriate copyright notice and a notice that there is no warranty (or else, 
saying that you provide a warranty) and that users may redistribute the 
program under these conditions, and telling the user how to view a copy of 
this License.  (Exception: if the Program itself is interactive but does not 
normally print such an announcement, your work based on the Program is 
not required to print an announcement.) 

 
These requirements apply to the modified work as a whole.  If identifiable 
sections of that work are not derived from the Program, and can be 
reasonably considered independent and separate works in themselves, then 
this License, and its terms, do not apply to those sections when you distribute 
them as separate works.  But when you distribute the same sections as part 
of a whole which is a work based on the Program, the distribution of the whole 
must be on the terms of this License, whose permissions for other licensees 
extend to the entire whole, and thus to each and every part regardless of who 
wrote it. 
 
Thus, it is not the intent of this section to claim rights or contest your rights to 
work written entirely by you; rather, the intent is to exercise the right to 
control the distribution of derivative or collective works based on the Program. 
 
In addition, mere aggregation of another work not based on the Program with 
the Program (or with a work based on the Program) on a volume of a storage 
or distribution medium does not bring the other work under the scope of this 
License. 

 
3. You may copy and distribute the Program (or a work based on it, under 

Section 2) in object code or executable form under the terms of Sections 1 
and 2 above provided that you also do one of the following: 

 
a) Accompany it with the complete corresponding machine-readable source 
code, which must be distributed under the terms of Sections 1 and 2 above on 
a medium customarily used for software interchange; or, 
 
b) Accompany it with a written offer, valid for at least three years, to give 
any third party, for a charge no more than your cost of physically performing 
source distribution, a complete machine-readable copy of the corresponding 
source code, to be distributed under the terms of Sections 1 and 2 above on a 
medium customarily used for software interchange; or, 
 
c) Accompany it with the information you received as to the offer to 
distribute corresponding source code.  (This alternative is allowed only for 
noncommercial distribution and only if you received the program in object 
code or executable form with such an offer, in accord with Subsection b 
above.) 
 
The source code for a work means the preferred form of the work for making 
modifications to it.  For an executable work, complete source code means all 
the source code for all modules it contains, plus any associated interface 
definition files, plus the scripts used to control compilation and installation of 
the executable.  However, as a special exception, the source code distributed 
need not include anything that is normally distributed (in either source or 
binary form) with the major components (compiler, kernel, and so on) of the 
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operating system on which the executable runs, unless that component itself 
accompanies the executable. 
 
If distribution of executable or object code is made by offering access to copy 
from a designated place, then offering equivalent access to copy the source 
code from the same place counts as distribution of the source code, even 
though third parties are not compelled to copy the source along with the 
object code. 

 
4. You may not copy, modify, sublicense, or distribute the Program except as 

expressly provided under this License.  Any attempt otherwise to copy, modify, 
sublicense or distribute the Program is void, and will automatically terminate 
your rights under this License. However, parties who have received copies, or 
rights, from you under this License will not have their licenses terminated so 
long as such parties remain in full compliance. 

 
5. You are not required to accept this License, since you have not signed it.  

However, nothing else grants you permission to modify or distribute the 
Program or its derivative works.  These actions are prohibited by law if you do 
not accept this License.  Therefore, by modifying or distributing the Program 
(or any work based on the Program), you indicate your acceptance of this 
License to do so, and all its terms and conditions for copying, distributing or 
modifying the Program or works based on it. 

 
6. Each time you redistribute the Program (or any work based on the Program), 

the recipient automatically receives a license from the original licensor to copy, 
distribute or modify the Program subject to these terms and conditions.  You 
may not impose any further restrictions on the recipients' exercise of the 
rights granted herein. You are not responsible for enforcing compliance by 
third parties to this License. 

 
7. If, as a consequence of a court judgment or allegation of patent infringement 

or for any other reason (not limited to patent issues), conditions are imposed 
on you (whether by court order, agreement or otherwise) that contradict the 
conditions of this License, they do not excuse you from the conditions of this 
License.  If you cannot distribute so as to satisfy simultaneously your 
obligations under this License and any other pertinent obligations, then as a 
consequence you may not distribute the Program at all.  For example, if a 
patent license would not permit royalty-free redistribution of the Program by 
all those who receive copies directly or indirectly through you, then the only 
way you could satisfy both it and this License would be to refrain entirely from 
distribution of the Program. 

 
If any portion of this section is held invalid or unenforceable under any 
particular circumstance, the balance of the section is intended to apply and 
the section as a whole is intended to apply in other circumstances. 
 
It is not the purpose of this section to induce you to infringe any patents or 
other property right claims or to contest validity of any such claims; this 
section has the sole purpose of protecting the integrity of the free software 
distribution system, which is implemented by public license practices.  Many 
people have made generous contributions to the wide range of software 
distributed through that system in reliance on consistent application of that 
system; it is up to the author/donor to decide if he or she is willing to 
distribute software through any other system and a licensee cannot impose 
that choice. 
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This section is intended to make thoroughly clear what is believed to be a 
consequence of the rest of this License. 

 
8. If the distribution and/or use of the Program is restricted in certain countries 

either by patents or by copyrighted interfaces, the original copyright holder 
who places the Program under this License may add an explicit geographical 
distribution limitation excluding those countries, so that distribution is 
permitted only in or among countries not thus excluded.  In such case, this 
License incorporates the limitation as if written in the body of this License. 

 
9. The Free Software Foundation may publish revised and/or new versions of the 

General Public License from time to time.  Such new versions will be similar in 
spirit to the present version, but may differ in detail to address new problems 
or concerns. 

 
Each version is given a distinguishing version number.  If the Program 
specifies a version number of this License which applies to it and "any later 
version", you have the option of following the terms and conditions either of 
that version or of any later version published by the Free Software Foundation.  
If the Program does not specify a version number of this License, you may 
choose any version ever published by the Free Software Foundation. 

 
10. If you wish to incorporate parts of the Program into other free programs 

whose distribution conditions are different, write to the author to ask for 
permission.  For software which is copyrighted by the Free Software 
Foundation, write to the Free Software Foundation; we sometimes make 
exceptions for this.  Our decision will be guided by the two goals of preserving 
the free status of all derivatives of our free software and of promoting the 
sharing and reuse of software generally. 

 
NO WARRANTY 

 
11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO 

WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE 
LAW.  EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT 
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE 
RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH 
YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF 
ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

 
12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 

WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY 
MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE 
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS 
OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED 
BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE 
WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

 
END OF TERMS AND CONDITIONS 
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	Chapter 1: Introduction
	Overview

	Thank you for choosing the Thecus N8800 IP Storage Server. The Thecus N8800 is an easy-to-use storage server that allows a dedicated approach to storing and distributing data on a network. Data reliability is ensured with RAID features that provide data security and recovery—over one Terabyte of storage is available using RAID 5 and RAID 6. Gigabit Ethernet ports enhance network efficiency, allowing the N8800 to take over file management functions, increase application and data sharing and provide faster data response. The N8800 offers data mobility with a disk roaming feature that lets you hot swap working hard drives for use in another N8800, securing the continuity of data in the event of hardware failure. The N8800 allows data consolidation and sharing between Windows (SMB/CIFS), UNIX/Linux, and Apple OS X environments. The N8800’s user-friendly GUI supports multiple languages.
	Product Highlights
	File Server


	First and foremost, the N8800 allows you to store and share files over an IP network. With a Network Attached Storage (NAS) device, you can centralize your files and share them easily over your network. With the easy-to-use web-based interface, users on your network can access these files in a snap.
	To learn about the Web User Interface, go to Chapter 6: Using the N8800 > Using WebDisk.
	FTP Server

	With the built-in FTP Server, friends, clients, and customers can upload and download files to your N8800 over the Internet with their favorite FTP programs. You can create user accounts so that only authorized users have access. 
	To set up the FTP Server, refer to Chapter 5: Additional Feature Setup > FTP Server.
	Backup Server

	Don’t leave precious data to chance. With advanced backup capabilities, you can easily upload mission critical files to the N8800, and even automate your backup tasks for true peace-of-mind.
	To find out how to backup your files with the N8800, refer to Chapter 6: Using the N8800 > File Backup.
	Printer Server

	With the N8800’s Printer Server, you can easily share an IPP printer with other PCs connected to your network. 
	To set up the Printer Server, refer to Chapter 5: Additional Feature Setup > Printer Server.
	Multiple RAID

	N8800 supports multiple RAID volumes on one system. So, you can create RAID 0 for your non-critical data, and create RAID 5 for mission-critical data. Create the RAID levels depending on your needs.  
	To configure RAID modes on the N8800, refer to Chapter 4: System Management > Storage Management > RAID List.
	Dual Mode Support

	N8800 is not only a file server, but it also supports iSCSI initiators. Your server can access N8800 as a direct-attached-storage over the LAN or Internet. There is no easier way to expand the capacity of your current application servers. All the storage needs can be centrally managed and deployed. This brings ultimate flexibility to users.
	To set up an iSCSI volume, refer to Chapter 4: System Management > Storage Management > Space Allocation > Allocating Space for iSCSI Volume.
	Superior Power Management

	N8800 supports schedule power on/off. With this feature, administrator can set at what time to turn on or off the system. This feature is a big plus for people who want to conserve energy. Wake-On-LAN enables administrator to remotely turn on the system without even leaving their own seat.
	To schedule system on and off, refer to Chapter 4: System Management > System Settings > Reboot and Shutdown System > Scheduled Power On/Off.
	Package Contents

	Your N8800 package should contain the following items:
	 QIG
	 CD-Title
	 Ethernet Cable
	 Screw Kit
	 Rack slider
	Please check to see if your package is complete. If you find that some items are missing, contact your dealer.
	Front Panel

	The Thecus N8800’s front panel has the device’s controls, indicators, and hard disk trays:
	Hard Disk Trays

	Each of the N8800’s hard disk trays has a lock, a latch, and two LED indicators:
	Rear Panel 

	The Thecus ’s rear panel features ports and connectors.
	 Chapter 2: Hardware Installation
	Overview

	Your N8800 is designed for easy installation. To help you get started, the following chapter will help you quickly get your N8800 up and running. Please read it carefully to prevent damaging your unit during installation.
	Before You Begin

	Before you begin, be sure to take the following precautions:
	1. Read and understand the Safety Warnings outlined in the beginning of the manual.
	2. If possible, wear an anti-static wrist strap during installation to prevent static discharge from damaging the sensitive electronic components on the N8800.
	3. Be careful not to use magnetized screwdrivers around the N8800’s electronic components.
	Hard Disk Installation

	The N8800 supports seven standard 3.5” Serial ATA (SATA) hard disks. To install a hard disk into the N8800, follow the steps below:
	1. Remove a hard disk tray from the N8800.
	2. Slide the new SATA hard disk into the tray and fasten the screws.
	3. Insert the hard disk and tray back into the N8800 until it snaps into place and lock it with a key if desired.
	4. The LED blinks green when the hard disk is accessed. 
	Cable Connections

	To connect the N8800 to your network, follow the steps below:
	1. Connect an Ethernet cable from your network to the WAN port on the back panel of the N8800.
	2. Connect the provided power cord into the universal power socket on the back panel. Plug the other end of the cord into a surge protector socket. Press the power supply switch to turn on the power supply. 
	3. Press the power button on the Front Panel to boot up the N8800. 
	Checking System Status

	After making connections on the N8800 and powering up, check whether the system status is normal or has trouble by observing indicators on the front panel and hard disk trays.
	System Status Normal

	The system status is normal if:
	1. The Power LED on the Front Panel glows green.
	2. The HDD Power LED on each HDD tray glows blue (assuming all disks are installed).
	3. The default IP address of the WAN port is 192.168.1.100 on LCD.
	System Trouble

	The system has trouble if:
	1. Disk Busy LED glows red.
	If the system has trouble, please refer to Chapter 8: Troubleshooting.
	 Chapter 3: First Time Setup
	Overview

	Once the hardware is installed, physically connected to your network, and powered on, you can configure the N8800 so that it is accessible to your network users. There are two ways to set up your N8800: using the Thecus Setup Wizard or the LCD display. Follow the steps below for initial software setup.
	Thecus Setup Wizard

	The handy Thecus Setup Wizard makes configuring N8800 a snap. To configure the N8800 using the Setup Wizard, perform the following steps:
	1. Insert the installation CD into your CD-ROM drive (the host PC must be connected to the network).
	2. The Setup Wizard should launch automatically. If not, please browse your CD-ROM drive and double click on Setup.exe.
	3. The Setup Wizard will start and automatically detect all Thecus storage devices on your network. If none are found, please check your connection and refer to Chapter 8: Troubleshooting for assistance.
	4. Select the N8800 that you like to configure.
	5. Login with the administrator account and password. The default account and password are both “admin”. 
	6. Name your N8800 and configure the network IP address. If your switch or router is configured as a DHCP Server, configuring the N8800 to automatically obtain an IP address is recommended. You may also use a static IP address and enter the DNS Server address manually. 
	7. Change the default administrator password.
	8. Finished! Access the N8800 Web Administrator Interface by pressing the Start Browser button. You can also configure another N8800 at this point by clicking the Setup Other Device button. Press Exit to exit the wizard.
	LCD Operation

	The N8800 is equipped with an LCD on the front for easy status display and setup. There are four buttons on the front panel to control the LCD functions.
	LCD Controls

	Use the Up (▲), Down (▼), Enter () and Escape (ESC) keys to select various configuration settings and menu options for N8800 configuration. 
	The following table illustrates the keys on the front control panel:
	There are two modes of operation for the LCD: Display Mode and Management Mode.
	Display Mode

	During normal operation, the LCD will be in Display Mode.
	The N8800 will rotate these messages every one-two seconds on the LCD display.
	USB Copy

	The USB Copy function enables you to copy files stored on USB devices such as USB disks and digital cameras to the N8800 with a press of a button. To use USB copy, follow the steps below:
	1. Plug your USB device into an available USB port on the Front Panel.
	2. In Display Mode, press the Down Button (▼).
	3. The LCD will display “USB Copy?” 
	4. Press Enter () and the N8800 will start copying USB disks connected to the front USB port.
	5. All of data will be copied into system folder named “USBcopy”. 
	Management Mode

	During setup and configuration, the LCD will be in Management Mode.
	To enter into Management Mode, press Enter () and an “Enter Password” prompt will show on the LCD.
	At this time, the administrator has to enter the correct LCD password. System will check whether the correct LCD password has been entered. The default LCD password is “0000”. If correct password is entered, you will enter into the Management Mode menu.
	Typical Setup Procedure

	From the Web Administration Interface, you can begin to setup your N8800 for use on your network. Setting up the N8800 typically follows the five steps outlined below.
	For more on how to use the Web Administration Interface, see Chapter 4: System Management > Web Administration Interface.
	Step 1: Network Setup

	From the Web Administration Interface, you can configure the network settings of the N8800 for your network. You can access the Network menu from the menu bar. 
	For details on how to configure your network settings, refer to Chapter 4: System Management > Network Management.
	Step 2: RAID Creation

	Next, administrators can configure their preferred RAID setting and build their RAID volume. You can access RAID settings from the menu bar of the Web Administration Interface by navigating to Storage > RAID.
	For more information on configuring RAID, see Chapter 4: System Management > RAID Configuration.
	Don’t know which RAID level to use? Find out more about the different RAID levels from Appendix C: RAID Basics.
	Step 3: Create Local Users or Setup Authentication

	Once the RAID is ready, you can begin to create local users for the N8800, or choose to setup authentication protocols such as Active Directory (AD).
	For more on managing users, go to Chapter 4: System Management > User and Group Management.
	For more information on configuring Active Directory, see Chapter 4: System Management > User and Group Management > ADS/NT Configuration.
	For information about the benefits of Active Directory, see Appendix D: Active Directory Basics.
	Step 4: Create Folders and Set Up ACLs

	Once users are introduced into your network, you can begin to create various folders on the N8800 and control user access to each using Folder Access Control Lists. 
	More information on managing folders, see Chapter 4: System Management > Folder Management.
	To find out about configuring Folder Access Control Lists, see Chapter 4: System Management > Folder Management > Folder Access Control List (ACL).
	Step 5: Start Services

	Finally, you can start to setup the different services of the N8800 for the users on your network. You can find out more about each of these services by clicking below:
	SMB/CIFS
	Apple File Protocol (AFP)
	Network File System (NFS)
	File Transfer Protocol (FTP)
	iTunes Server
	Media Server
	Printer Server
	Download Manager
	Photo Server
	Chapter 4: System Management
	Overview

	The N8800 provides an easily accessible Web Administration Interface. With it, you can configure and monitor the N8800 anywhere on the network.
	Web Administration Interface

	Make sure your network is connected to the Internet. To access the N8800 Web Administration Interface:
	1. Type the N8800’s IP address into your browser. (Default IP address is http://192.168.1.100)  
	2. Login to the system using the administrator user name and password. The factory defaults are: 
	User Name: admin
	Password: admin
	If you changed your password in the setup wizard, use the new password.
	Once you are logged in as an administrator, you will see the Web Administration Interface. From here, you can configure and monitor virtually every aspect of the N8800 from anywhere on the network.
	Menu Bar

	The Menu Bar is where you will find all of the information screens and system settings of the N8800. The various settings are placed in the following groups on the menu bar:
	Moving your cursor over any of these items will display the dropdown menu selections for each group.
	In the following sections, you will find detailed explanations of each function, and how to configure your N8800.
	Language Selection

	The N8800 supports multiple languages, including:
	 English
	 French
	 German
	 Italian
	 Traditional Chinese
	 Simplified Chinese
	 Japanese
	 Korean
	 Spanish
	On the menu bar, click Language and the Change Language screen appears. This screen allows you to select preferred language for the N8800. Press Apply to confirm your selection.
	Status Menu

	The Status Menu on the menu bar allows you to see various aspects of the N8800. From here, you can discover the status of the N8800, and even find out other details like firmware version and up time. 
	Product Information

	Once you login, you will first see the basic Product Information screen providing Manufacturer, Product No., Firmware Version, and Up Time information.
	To access this screen again, navigate to Status > About.
	System/Service Status

	From the Status menu, choose the System item, and the System Status and Service Status screens appear. These screens provide basic system and service status information.
	System Information

	From Status menu, choose the Info item, and the System Information screen appears. You can change the system information that appears on the Login page by entering the new information here and pressing Apply to confirm.
	Printer Status

	From the Status menu, choose the Printer item, and the Printer Information screen appears. This screen provides the following information about the USB printer connected to the USB port.
	If a corrupt print job is sent to a printer, printing may suddenly fail. If your print jobs seem to be locked up, pressing the Remove All Documents button to clear the print queue may resolve the issue.
	For information on how to set up the Printer Server, refer to Chapter 5: Additional Feature Setup > Printer Server.
	UPS Settings

	The N8800 can also support various uninterruptible power supply units, providing extra data security and accessibility in the case of a power failure.
	From the Status menu, choose the UPS item and the UPS Setting screen appears. Make any changes you wish, and press Apply to confirm changes. See the following table for a detailed description of each item.
	For a list of supported UPS units, see Appendix E: UPS Compatibility List.
	Wake-Up On Lan (WOL)

	The N8800 has the ability to be awoken from sleep mode via WAN port. 
	From the Status menu, choose the WOL item, and the Wake-up On Lan Configuration screen appears. From here, you can Enable or Disable.
	Power Management

	Using the N8800’s Power Management, you can save energy and money by scheduling the N8800 to turn itself on and off during certain times of the day.
	From the Status menu, choose the Power Mgmt item and the Schedule Power On/Off screen appears. 
	To designate a schedule for the N8800 to turn on and off, first enable the feature by checking the Enable Schedule Power On/Off checkbox. 
	Then, simply choose an on and off time for each day of the week that you would like to designate a schedule by using the various dropdowns. 
	Finally, click Apply to save your changes.
	Example - Monday: On: 8:00; Off: 16:00
	System will turn on at 8:00 AM on Monday, and off at 16:00 on Monday. System will turn on for the rest of the week.
	If you choose an on time, but do not assign an off time, the system will turn on and remain on until a scheduled off time is reached, or if the unit is shutdown manually.
	Example - Monday: On: 8:00
	System will turn on at 8:00 AM on Monday, and will not shut down unless powered down manually.
	You may also choose two on times or two off times on a particular day, and the system will act accordingly.
	Example - Monday: Off: 8:00; Off: 16:00
	System will turn off at 8:00 AM on Monday. System will turn off at 16:00 PM on Monday, if it was on. If the system was already off at 16:00 PM on Monday, system will stay off.
	Storage Management

	The Storage Menu displays the status of storage devices installed in the N8800, and includes storage configuration options such as RAID and disk settings, folder configuration, and Nsync settings. 
	Disks Information

	From the Storage menu, choose the Disks item and the Disks Information screen appears. From here, you can see various items about installed SATA hard disks. Blank lines indicate that a SATA hard disk is not currently installed in that particular disk slot. 
	S.M.A.R.T. Information

	On the Disks Information screen, the status of each disk will be displayed in the Status column. Clicking on an OK or Warning link will display the S.M.A.R.T Information window for that particular disk. 
	RAID Information

	From the Storage menu, choose the RAID item and the RAID List screen appears. 
	This screen lists the RAID volumes currently residing on the N8800. From this screen, you can get information about the status of your RAID volumes, as well as the capacities allocated for data and iSCSI. There is also a graph which represents how the RAID volume is currently allocated.
	To configure your RAID settings, press the RAID Config button to go to the RAID Configuration screen.
	RAID Configuration

	On the RAID List screen, press the RAID Config button to go to the RAID Configuration screen. In addition to RAID disk information and status, this screen lets you make RAID configuration settings. 
	For more information on RAID, see Appendix C: RAID Basics.
	RAID Level

	You can set the storage volume as JBOD, RAID 0, RAID 1, RAID 5, RAID 6 or RAID 10. RAID configuration is usually required only when you first set up the device. A brief description of each RAID setting follows:
	RAID Configuration

	Using RAID Settings, you can select stripe size, choose which disks are RAID disks or the Spare Disk. .
	Creating a RAID

	To create a RAID volume, follow the steps below:
	1. On the RAID Information screen, click New.
	2. On the RAID Configuration screen, set the RAID storage space as JBOD, RAID 0, RAID 1, RAID 5, RAID 6, or RAID 10 — see Appendix C: RAID Basics for a detailed description of each.
	3. Specify a RAID ID. 
	4. If this RAID volume is meant to be the Master RAID volume, tick the Master RAID checkbox.
	5. Tick the checkboxes under the “member” heading of the hard disks you wish to use to create a RAID. 
	6. Specify a stripe size — 64K is the default setting. 
	7. Specify the percentage allocated for user data. The remaining space will be made available for iSCSI target.
	8. Selected the file system you like to have for this RAID volume. 
	9. Press Apply to build the RAID storage volume.
	With a RAID 1, RAID 5, RAID 6, or RAID 10 volume, you can also add a spare disk after the RAID is created. See Chapter 7: Tips and Tricks > Adding a Spare Disk for details.
	Expanding a RAID

	To expand a RAID 1, RAID 5, RAID 6, or RAID 10 volume, follow the steps below:
	1. Replace one of the hard drives in the RAID volume and allow it to automatically rebuild.
	2. Once rebuilt, you can continue to replace any remaining disks in the RAID array. 
	3. When you are done replacing hard drives, log on to Web Management. Navigate to Storage > RAID to open the RAID List screen. 
	4. On the RAID List screen, select the RAID volume by clicking on its radio button, and click RAID Config to open the RAID Configuration screen.
	5. On the RAID Configuration screen, click Expand.
	Migrating a RAID

	Once a RAID volume has been created, you may want to move it to other physical drives or change the RAID array all together. To migrate a RAID 0, RAID 1, or RAID 5 volume, follow the steps below:
	1. From the RAID Configuration screen, click Migrate RAID.
	2. A list of possible RAID migration configurations will be listed. Select the desired migration scheme and click OK.
	3. The system will begin migrating the RAID volume.
	Below is a table listing of possible RAID migration schemes:
	   To
	 From
	RAID 0 
	RAID 5 
	RAID 0 
	[RAID 0] HDDx2 to [RAID 0] HDDx3 
	[RAID 0] HDDx2 to [RAID 0] HDDx4 
	[RAID 0] HDDx2 to [RAID 0] HDDx5
	[RAID 0] HDDx2 to [RAID 0] HDDx6
	[RAID 0] HDDx2 to [RAID 0] HDDx7 
	[RAID 0] HDDx2 to [RAID 0] HDDx8 
	[RAID 0] HDDx3 to [RAID 0] HDDx4 
	[RAID 0] HDDx3 to [RAID 0] HDDx5
	[RAID 0] HDDx3 to [RAID 0] HDDx6
	[RAID 0] HDDx3 to [RAID 0] HDDx7 
	[RAID 0] HDDx3 to [RAID 0] HDDx8 
	[RAID 0] HDDx4 to [RAID 0] HDDx5
	[RAID 0] HDDx4 to [RAID 0] HDDx6
	[RAID 0] HDDx4 to [RAID 0] HDDx7
	[RAID 0] HDDx3 to [RAID 0] HDDx8 
	[RAID 0] HDDx5 to [RAID 0] HDDx6
	[RAID 0] HDDx5 to [RAID 0] HDDx7
	[RAID 0] HDDx5 to [RAID 0] HDDx8 
	[RAID 0] HDDx6 to [RAID 0] HDDx7 
	[RAID 0] HDDx6 to [RAID 0] HDDx8
	[RAID 0] HDDx7 to [RAID 0] HDDx8 
	[RAID 0] HDDx2 to [RAID 5] HDDx3 
	[RAID 0] HDDx2 to [RAID 5] HDDx4 
	[RAID 0] HDDx2 to [RAID 5] HDDx5
	[RAID 0] HDDx2 to [RAID 5] HDDx6
	[RAID 0] HDDx2 to [RAID 5] HDDx7
	[RAID 0] HDDx2 to [RAID 5] HDDx8 
	[RAID 0] HDDx3 to [RAID 5] HDDx4 
	[RAID 0] HDDx3 to [RAID 5] HDDx5
	[RAID 0] HDDx3 to [RAID 5] HDDx6
	[RAID 0] HDDx3 to [RAID 5] HDDx7 
	[RAID 0] HDDx3 to [RAID 5] HDDx8 
	[RAID 0] HDDx4 to [RAID 5] HDDx5
	[RAID 0] HDDx4 to [RAID 5] HDDx6
	[RAID 0] HDDx4 to [RAID 5] HDDx7
	[RAID 0] HDDx4 to [RAID 5] HDDx8
	[RAID 0] HDDx5 to [RAID 5] HDDx6
	[RAID 0] HDDx5 to [RAID 5] HDDx7
	[RAID 0] HDDx5 to [RAID 5] HDDx8
	[RAID 0] HDDx6 to [RAID 5] HDDx7 
	[RAID 0] HDDx6 to [RAID 5] HDDx8
	[RAID 0] HDDx7 to [RAID 5] HDDx8
	RAID 1 
	[RAID 1] HDDx2 to [RAID 0] HDDx2 
	[RAID 1] HDDx2 to [RAID 0] HDDx3 
	[RAID 1] HDDx2 to [RAID 0] HDDx4 
	[RAID 1] HDDx2 to [RAID 0] HDDx5
	[RAID 1] HDDx2 to [RAID 0] HDDx6
	[RAID 1] HDDx2 to [RAID 0] HDDx7
	[RAID 1] HDDx2 to [RAID 0] HDDx8
	[RAID 1] HDDx3 to [RAID 0] HDDx3
	[RAID 1] HDDx3 to [RAID 0] HDDx4
	[RAID 1] HDDx3 to [RAID 0] HDDx5
	[RAID 1] HDDx3 to [RAID 0] HDDx6
	[RAID 1] HDDx3 to [RAID 0] HDDx7
	[RAID 1] HDDx3 to [RAID 0] HDDx8
	[RAID 1] HDDx4 to [RAID 0] HDDx4
	[RAID 1] HDDx4 to [RAID 0] HDDx5
	[RAID 1] HDDx4 to [RAID 0] HDDx6
	[RAID 1] HDDx4 to [RAID 0] HDDx7
	[RAID 1] HDDx4 to [RAID 0] HDDx8
	[RAID 1] HDDx5 to [RAID 0] HDDx5
	[RAID 1] HDDx5 to [RAID 0] HDDx6
	[RAID 1] HDDx5 to [RAID 0] HDDx7
	[RAID 1] HDDx5 to [RAID 0] HDDx8
	[RAID 1] HDDx6 to [RAID 0] HDDx6
	[RAID 1] HDDx6 to [RAID 0] HDDx7
	[RAID 1] HDDx6 to [RAID 0] HDDx8
	[RAID 1] HDDx7 to [RAID 0] HDDx7 
	[RAID 1] HDDx7 to [RAID 0] HDDx8
	[RAID 1] HDDx2 to [RAID 5] HDDx3 
	[RAID 1] HDDx2 to [RAID 5] HDDx4 
	[RAID 1] HDDx2 to [RAID 5] HDDx5
	[RAID 1] HDDx2 to [RAID 5] HDDx6
	[RAID 1] HDDx2 to [RAID 5] HDDx7
	[RAID 1] HDDx2 to [RAID 5] HDDx8
	[RAID 1] HDDx3 to [RAID 5] HDDx3
	[RAID 1] HDDx3 to [RAID 5] HDDx4
	[RAID 1] HDDx3 to [RAID 5] HDDx5
	[RAID 1] HDDx3 to [RAID 5] HDDx6
	[RAID 1] HDDx3 to [RAID 5] HDDx7
	[RAID 1] HDDx3 to [RAID 5] HDDx8
	[RAID 1] HDDx4 to [RAID 5] HDDx4
	[RAID 1] HDDx4 to [RAID 5] HDDx5
	[RAID 1] HDDx4 to [RAID 5] HDDx6
	[RAID 1] HDDx4 to [RAID 5] HDDx7
	[RAID 1] HDDx4 to [RAID 5] HDDx8
	[RAID 1] HDDx5 to [RAID 5] HDDx5
	[RAID 1] HDDx5 to [RAID 5] HDDx6
	[RAID 1] HDDx5 to [RAID 5] HDDx7
	[RAID 1] HDDx5 to [RAID 5] HDDx8
	[RAID 1] HDDx6 to [RAID 5] HDDx6
	[RAID 1] HDDx6 to [RAID 5] HDDx7
	[RAID 1] HDDx6 to [RAID 5] HDDx8
	[RAID 1] HDDx7 to [RAID 5] HDDx7 
	[RAID 1] HDDx7 to [RAID 5] HDDx8
	RAID 5 
	X 
	[RAID 5] HDDx3 to [RAID 5] HDDx4 
	[RAID 5] HDDx3 to [RAID 5] HDDx5
	[RAID 5] HDDx3 to [RAID 5] HDDx6
	[RAID 5] HDDx3 to [RAID 5] HDDx7 
	[RAID 5] HDDx3 to [RAID 5] HDDx8 
	[RAID 5] HDDx4 to [RAID 5] HDDx5
	[RAID 5] HDDx4 to [RAID 5] HDDx6
	[RAID 5] HDDx4 to [RAID 5] HDDx7
	[RAID 5] HDDx4 to [RAID 5] HDDx8
	[RAID 5] HDDx5 to [RAID 5] HDDx6
	[RAID 5] HDDx5 to [RAID 5] HDDx7
	[RAID 5] HDDx5 to [RAID 5] HDDx8
	[RAID 5] HDDx6 to [RAID 5] HDDx7
	[RAID 5] HDDx6 to [RAID 5] HDDx8
	Deleting a RAID

	To delete a RAID volume, follow the steps below:
	1. On the RAID List screen, select the RAID volume by clicking on its radio button, and click RAID Config to open the RAID Configuration screen.
	2. On the RAID Configuration screen, click Remove RAID.
	3. The confirmation screen appear, you will have to input “Yes” with exactly wording case to complete “Remove RAID” operation 
	Space Allocation

	You may specify the space allocated for iSCSI volume. 
	To do this, under the Storage menu, click RAID and the RAID List window appears. Select the RAID volume you wish to reallocate by clicking on its radio button, and click Space Allocation. The RAID Information and Volume Allocation List windows will appear.
	The Volume Allocation List displays the space allocated for iSCSI volumes on the current RAID volume. The N8800 supports up to 5 iSCSI volumes in each RAID volume.
	Allocating Space for iSCSI Volume

	To allocate space for an iSCSI volume on the current RAID volume, follow the steps below:
	1. Under the Volume Allocation List, click iSCSI Target.
	 The Create iSCSI Volume screen appears.
	2. Designate the percentage to be allocated from the Allocation dropdown.
	3. Enable the iSCSI Target Service by selecting Enable.
	4. Choose to enable CHAP authentication or choose None. 
	5. Enter a Target Name. This will be used by the Stackable NAS function to identify this export share.
	6. Choose the current year from the Year dropdown.
	7. Choose the current month from the Month dropdown.
	8. If you’ve enabled CHAP authentication, enter a username and a password. Confirm your chosen password be reentering it in the Password Confirm box.
	9. Click OK to create the iSCSI volume.
	Stackable NAS

	The N8800’s capacity can be expanded even further using the stackable function. With it, users can expand the capacity of their network storage systems with up to 5 other stack target volumes which are located in different systems. These can be stacked through single network access like SMB or AFP acting as a share folder type.
	For detailed instructions on how to use this feature, please refer to the Stackable User Guide.
	Snapshot

	The N8800 is capable for snapshot version control supported. To have snapshot to work on the file system creation for RAID volume has to be “ZFS”. For more information how to using snapshot, please refer to next section “Folder management”. 
	Folder Management

	From the Storage menu, choose Folder, and the Folder screen appears. This screen allows you to create and configure folders on the N8800 volume.
	Adding Folders

	On the Folder screen, press the Add button and the Add Folder screen appears. This screen allows you to add a folder. After entering the information, press Apply to create new folder. Press Back to return to the Folder screen.
	Editing Folders

	On the Folder screen, press the Edit button and the Edit Folder screen appears. This screen allows you to change folder information. After entering the information, press Submit to apply the changes. Press Back to return to the Folder screen.
	Deleting Folders

	To delete a folder, press the Del button from the specified folder row. The system will confirm folder deletion. Press OK to delete the folder permanently or Cancel to go back to the folder list.
	NFS Share

	To allow NFS access to the share folder, enable the NFS Service, and then set up hosts with access rights by clicking Add.
	Snap (Snapshot configuration)

	If added folder has located in the RAID volume with “ZFS” file system, then the folder management screen with “Snap” button will be configurable. 
	Clicking on “Snap” then screen appears as following. 
	Clicking on schedule button then schedule setup screen appear. Checked the enable check box to activate the snapshot scheduled operation. 
	The N8800 snapshot is supported total 16 versions. Once checked “Automatically remove oldest snapshot”, the oldest will be removed to let newest to added on top. Otherwise, if the check box is unchecked and snapshot versions are up to 16 then system will appear warning message and won’t execute the task till available version count. 
	The snapshot schedule rules can be setup for monthly, weekly or daily hour. 
	Clicking on Apply after firmed with desired schedule or click back to Snap screen. 
	If any snapshot has taken then it will listed in Snapshot list as example below. This example shows folder “test” has created under RAID volume in ZFS file system. It has been taken snapshot twice so far at time displayed. 
	These taken snapshot is only accessible though CIFS/SMB by manually type \\NAS IP address\snapshot and invisible from normal access. Also, the taken snapshot version is read only can not be deleted under CIFS/SMB access but only click the “Del” button showing on the screen shot above. 
	Folder Access Control List (ACL)
	On the Folder screen, press the ACL button, and the Access Control List screen appears. This screen allows you to configure access to the specific folder for users and groups. Select a user or a group from the left hand column and then choose Deny, Read Only, or Writable to configure their access level. Press the Submit button to confirm your settings.
	To configure folder access, follow the steps below:
	1. On the ACL screen, all network groups and users are listed in the left hand column. Select a group or user from this list.
	2. With the group or user selected, press one of the buttons from the three access level columns at the top. The group or user then appears in that column and has that level of access to the folder. 
	3. Continue selecting groups and users and assigning them access levels using the column buttons.
	4. To remove a group or user from an access level column, press the Remove button in that column.
	5. When you are finished, press Submit to submit and confirm your ACL settings.
	The ACL screen also allows you to search for a particular user. To do this, follow the steps below:
	1. In the blank, enter the name of the user you would like to find. 
	2. From the drop down select the group you would like to search for the user in.
	3. Click Search.
	File System Check

	The File System Check allows you to perform a check on the integrity of your disks’ file system. Under the Storage menu, click Filesystm Check and the File System Check prompt appears. 
	To perform a file system check, click Apply.
	Once clicked, the following prompt will appear:
	Click Yes to reboot the system. 
	Once the system has rebooted, you will be returned to the File System Check prompt. There you will see the available RAID volumes to run the file system check on. Check the desired RAID volumes and click Next to proceed with the file system check. Click Reboot to reboot without running the check.
	Once you click Next, you will see the following screen:
	Click Start to begin the file system check. Click Back to return to the previous screen. Click Reboot to reboot the system.
	When the file system check is run, the system will show 20 lines of information until it is complete. Once complete, the results will be shown at the bottom.
	Advance Option

	There are 5 items is currently allow Admin to Enable/Disable to operate N8800. The details as listed in following screenshot. With the option changed, it will need to reboot system to activate. 
	File Access Cache

	File Access Cache is default Enable. This option will help to increase the performance while single client access share folder in writing under SMB/CIFS protocol. 
	Samba Recycle Bin

	The N8800 is supported recycle bin via SMB/CIFS protocol. Simply enable it then all of deleted files/folders will reside in the “.recycle” folder with hidden attribution in each share. 
	In general, Windows has default to invisible all of hidden folders/files. So please enable this option to view “.recycle” folder. 
	Samba Anonymous Login Authentication

	To enable this option, no matter there is share folder has been created in public access. The user account and password is needed from system to access under SMB/CIFS protocol. On the other hand, no more anonymous logAdvance Option
	iSCSI Block Size

	Select the block size with 4K while the iSCSI volume size is over 2TB. 
	iSCSI CRC/Checksum

	To enable this option, the initiator can connect with “Data digest” and “Header digest” enabled. 
	 Network Management

	Use the Network menu to make network configuration settings as well as service support settings.
	WAN Configuration

	From the Network menu, choose WAN, and the WAN Configuration screen appears. This screen displays the network parameters of the WAN connection. You may change any of these items and press Apply to confirm your settings. See a description of each item in the following table:
	LAN Configuration

	The N8800 supports two Gigabit Ethernet ports for higher service availability. To configure these ports, choose LAN from the Network menu, and the LAN Configuration screen appears. Press Apply to save your changes.
	DHCP Configuration

	A DHCP server can be configured to assign IP addresses to devices connected to the LAN port. To configure these ports, choose LAN from the Network menu.
	WLAN Configuration

	When a compatible wireless USB dongle is installed on the N8800, the N8800 will become an access point, and the Network dropdown menu will contain a WLAN menu item. From the Network menu, choose WLAN, and the WLAN Configuration screen appears. This screen displays the wireless network parameters of the system. You can change any of these items and press Apply to confirm your settings. 
	Web Services Configuration

	From the Network menu, choose the Service item, and the Web Service screen appears. This screen displays the service support parameters of the system. You can change any of these items and press Apply to confirm your settings. A description of each item follows:
	AFP (Apple Network Setup)

	From the Network menu, choose the AFP item, and the AFP Configuration screen appears. This screen displays the configuration items for the Apple Filing Protocol. You can change any of these items and press Apply to confirm your settings. A description of each item follows:
	NFS Setup

	From the Network menu, choose the NFS item, and the NFS Server Setting screen appears. The N8800 can act as an NFS server, enabling users to download and upload files with the favorite NFS clients. Press Apply to confirm your settings. A description of each item follows:
	User and Group Management

	The N8800 has built-in user database that allows administrators to manage user access using different group policies. From the Accounts menu, you can create, modify, and delete users, and assign them to groups that you designate. 
	Local User Configuration

	From the Accounts menu, choose the Users item, and the Local User Configuration screen appears. This screen allows you to Add, Modify, and Delete local users. 
	Adding Users

	Click on the Add button on Local User Configuration screen, and Local User Setting screen appears.
	2. On the Local User Setting screen, enter a name in the User Name box.
	3. Enter a User ID number. If left blank, the system will automatically assign one.
	4. Enter a password in the Password box and re-enter the password in the Confirm box.
	5. Select which group the user will belong to. Group Members is a list of groups this user belongs to. Group List is a list of groups this user does not belong to. Use the << or >> buttons to have this user join or leave a group.
	6. Press the Apply button and the user is created.
	Modifying Users

	1. Select an existing user from the Local User Configuration screen.
	2. Click on the Modify button, and Local User Setting screen appears.
	3. From here, you can enter a new password and re-enter to confirm, or use the << or >> buttons to have this user join or leave a group. Click the Apply button to save your changes.
	Deleting Users

	1. Select an existing user from the Local User Configuration screen.
	2. Click on Delete button and the user is deleted from the system.
	Local Groups Configuration

	From the Accounts menu, choose the Groups item, and the Local Groups Configuration screen appears. This screen allows you to Add, Modify, and Delete local groups.
	Adding Groups

	1. On the Local Group Configuration screen, click on the Add button. 
	2. The Local Group Setting screen appears.
	3. Enter a Group Name.
	4. Enter a Group ID number. If left blank, the system will automatically assign one.
	Select users to be in this group from the Users List by adding them to the Members List using the << button. 
	6. Click the Apply button to save your changes. 
	Modifying Groups

	1. On the Local Group Configuration screen, select a group name from the list.
	2. Press the Modify button to modify the members in a group.
	3. To add a user into a group, select the user from the Users List, and press the << button to move the user into the Members List.
	4. To remove a user from a group, select the user from Members List, and press the >> button.
	5. Click the Apply button to save your changes.
	Deleting Groups

	1. On the Local Group Configuration screen, select a group name from the list.
	2. Press Delete to delete the group from the system.
	Batch User and Group Creation

	The N8800 can also add users and groups in batch mode. This enables you to conveniently add numerous users and groups automatically by importing a simple comma-separated plain text (*.txt) file. 
	From the Accounts menu, click Batch Mgmt and the Batch Create Users and Groups dialogue will appear. To import your list of users and groups, follow these steps:
	1. Click Browse… to locate your comma-separated text file.
	The information in the text file should follow this format: 
	[USERNAME], [PASSWORD], [GROUP]
	2. Click Open.
	3. Click Import to begin the user list import.
	ADS/NT Configuration

	If you have a Windows Active Directory Server (ADS) or Windows NT server to handle the domain security in your network, you can simply enable the ADS/NT support feature; the N8800 will connect with the ADS/NT server and get all the information of the domain users and groups automatically. From the Accounts menu, choose Authentication item and the ADS/NT Support screen appears. You can to change any of these items and press Apply to confirm your settings. A description of each item follows:
	To join an AD domain, you can refer the figure and use the example below to configure the N8800 for associated filed input:
	System Settings

	The System menu gives you a wealth of settings that you can use to configure your N8800’s system administration functions. You can set up system notifications, view system logs, and even upgrade firmware from this menu.
	System Notifications

	From the System menu, choose the Notification item, and the Notification Configuration screen appears. This screen lets you have the N8800 notify you in case of any system malfunction. Press Apply to confirm all settings. See following table for a detailed description of each item.
	SNMP

	From the System menu, choose the SNMP item and the SNMP Supports screen appears. You could enable the SNMP function and filled in the related information in each fields. With the SNMP management software could get system basic information. 
	System Logs

	From the System menu, choose the Logs item and the System Logs screen appears. This screen shows a history of system usage and important events such as disk status, network information, and system booting. See the following table for a detailed description of each item:
	Time and Date Settings

	From the System menu, choose the Time item and the Time screen appears. Set the desired Date, Time, and Time Zone. You can also elect to synchronize the system time on the N8800 with an NTP (Network Time Protocol) Server. You can change any of these items and press Apply to confirm your settings.
	See the following table for a detailed description of each item:
	System Configuration Backup and Restore

	From the System menu, choose the Config Mgmt item and the System Configuration Download/Upload screen appears. From here, you can download or upload stored system configurations. See the following table for a detailed description of each item.
	Module Management

	From the System menu, choose the Module Mgmt item and the Module Management screen appears. From here, you can install separate software modules to extend the functionality of your N8800. 
	Reset to Factory Default Settings

	From the System menu, choose the Factory Default item and the Reset to Factory Default screen appears. Press Apply to reset the N8800 to factory default settings. Press Cancel to go back to the main menu.
	Upgrading System Firmware

	From the System menu, choose the Firmware Upgrade item and the Firmware Upgrade screen appears. 
	Follow the steps below to upgrade your firmware:
	1. Use the Browse button to find the firmware file.
	2. Press Apply.
	3. The beeper beeps and the Busy LED blinks until the upgrade is complete.
	Change Administrator Password

	From the System menu, choose the Administrator Password item and the Change Administrator Password screen appears. Enter a new password in the New Password box and confirm your new password in the Confirm Password box. Press Apply to confirm password changes. See the following table for a detailed description of each item.
	Reboot and Shutdown System

	From the System menu, choose Reboot & Shutdown item, and the Shutdown/Reboot System screen appears. Press Reboot to restart the system or Shutdown to turn the system off.
	Logout

	To logout of the Web Administration Interface, navigate to System > Logout.
	Chapter 5: Additional Feature Setup
	Overview

	The N8800 can also act as an FTP Server, allowing employees and clients to transfer files using their favorite FTP programs. The integrated Print Server allows you to share a single USB printer will all users on the network. The following section shows you how.
	FTP Server

	N8800 can act as a FTP server, enabling users to download and upload files with their favorite FTP programs. From the Network menu, choose the FTP item, and the FTP screen appears. You can change any of these items and press Apply to confirm your settings. A description of each item follows:
	To access the share folder on the N8800, use the appropriate user login and password set up on the Users page (Accounts > Users). Access control to each share folder is set up on the ACL page (Storage > Folder > ACL).
	iTunes® Server

	With the built-in iTunes server capability, the N8800 enables digital music to be shared and played anywhere on the network! 
	From the Network menu, choose the iTunes item, and the iTunes Configuration screen appears. You may enable or disable the iTunes Service from here. Once enabled, enter correct information for each field and press Apply to save your changes. See the following table for detailed descriptions of each field: 
	Once the iTunes service is enabled, the N8800 will make all music located in the Music folder available for iTunes-equipped computers on the network.
	Media Server

	With the built-in Media Server capability, the N8800 provides media streaming service to stand-alone networked home media adapters that support the UPnP AV protocol or are Digital Living Network Alliance (DLNA) standard compliant. 
	With the N8800’s built-in media server capability, you can share digital media such as music, pictures, and movies with any compatible device throughout your entire home.
	To configure the media server, under the Network menu, click Media Server and the Media Manager Settings window will appear. A description of each field follows:
	Adding Media Share Folders

	Once the Media Server software is installed, you can start adding folders that contain the media that you would like to share. To create a media share folder, follow the steps below:
	1. Click on Network > Media Server in the menu bar. 
	2. From the Shared Media Folders window, select the folder that contains your media files, and click its checkbox.
	3. The contents in the folder will be scanned for the Media Server. The time required for scanning depends on the size of the folder.
	Connecting DMAs to the Media Server

	Next, it’s time to connect your Digital Media Adapter (DMA) to the media server:
	1. Connect your DMA to your Media Server
	a. Configure your DMA to use a Dynamic IP address. The IP address will be assigned by the router.
	b. Some DMAs are wireless enabled. You can connect the DMA to a wireless router. For instructions on how to connect your DMA to a wireless router, please refer to your DMA’s user manual.
	2. Connect your DMA’s video output to video input of your TV set.
	3. Turn on the TV and change the video signal input to DMA.
	4. Setup the DMA (These steps will be different if you use a different DMA)
	a. From the Server List screen, select “N8800:Mediabolic Server” as the server.
	b. Go to My Media
	c. Click on the Up/Down Arrow buttons to select Music Jukebox, Photo Albums, or Video Clips
	d. Start enjoying the contents stored in your N8800.
	Printer Server

	You can configure the N8800 to act as a printer server. That way, all PCs connected to the network can utilize the same printer. 
	Windows XP SP2

	To set up the Printer Server in Windows XP SP2, follow the steps below:
	1. Connect the USB printer to one of the USB ports (preferably the rear USB ports; front USB ports can be used for external HDD enclosures).
	2. Go to Start > Printers and Faxes.
	3. Click on File > Add Printer.
	4. The Add Printer Wizard appears on your screen. Click Next.
	5. Select the “A network printer, or a printer attached to another computer” option.
	6. Select “Connect to a printer on the Internet or on a home or office network”, and enter “http://N8800_IP_ADDRESS:631/printers/usb-printer” into the URL field.
	7. Your Windows system will ask you to install drivers for your printer. Select correct driver for your printer.
	8. Your Windows system will ask you if you want to set this printer as “Default Printer”. Select Yes and all your print jobs will be submitted to this printer by default. Click Next.
	9. Click Finish.
	Windows Vista

	To set up the Printer Server in Windows Vista, follow the steps below:
	1. Open Printer Folder from the Control Panel.
	2. Click the right mouse button in anywhere on the Printers folder and then select Add Printer.
	3. Select Add a network, wireless or Bluetooth printer.
	4. Select The printer that I want isn’t listed.
	You can press The printer that I want isn’t listed to go into next page without waiting for Searching for available printers to finish.
	5. Click Select a shared printer by name.
	Type http://<Thecus_NAS>:631/printers/usb-printer in the box, where <Thecus_NAS_IP> is the IP address of the N8800. Click Next.
	6. Select or install a printer and then press OK.
	If your printer model is not listed, please contact your printer manufacturer for help.
	7. Windows will attempt to connect to the printer.
	8. You can choose to set this printer as the default printer by checking the Set as the default printer box. Click Next to continue.
	9. Done! Click Finish.
	Download Manager

	With the built-in Download Manager, you can have the N8800 download HTTP, FTP, and BT files without having full PC powered on. What’s more, you can even schedule your downloads for off-peak hours, ensuring efficient use of bandwidth. To access the Download Manager, go to Network, choose the Download Manager option, and the Download Tasks and Download Schedule windows appear. 
	Adding an HTTP Task

	To add a new HTTP task to the Download Manager, follow these steps:
	1. Using the Task Type dropdown, select HTTP and click Add Task. 
	2. In the HTTP Task window, start by inputting the target URL in the Website URL box. This is the link to the download you want to queue.
	3. Next, select the destination folder from the Destination Folder dropdown. This is where the download will reside.
	4. Select the maximum download bandwidth from the Max. Download Bandwidth dropdown.
	5. Press Apply to add the task.
	6. Once added, your download will appear in the list of download tasks. To start the download, simply click the Start icon () and the download will begin.
	7. The download status will continually update in the Download Tasks window. To pause the download, click the Pause icon (). 
	Adding an FTP Task

	To add a new FTP task to the Download Manager, follow these steps:
	1. Using the Task Type dropdown, select FTP and click Add Task. 
	2. In the FTP Task window, start by inputting the target URL in the FTP File box. This is the link to the download you want to queue.
	3. Next, select the destination folder from the Destination Folder dropdown. This is where the download will reside.
	4. The next step depends if you are using an anonymous login for your FTP download. If you are logging in anonymously, select Anonymous Login and move on to step 5.
	If you are required to login with a user name and password, select Username and input your user name and password into the appropriate fields. 
	5. Select the maximum download bandwidth from the Max. Download Bandwidth dropdown.
	6. Press Apply to add the task.
	7. Once added, your download will appear in the list of download tasks. To start the download, simply click the Start icon () and the download will begin.
	8. The download status will continually update in the Download Tasks window. To pause the download, click the Pause icon (). 
	Adding a BT Task

	To add a new BT task to the Download Manager, follow these steps:
	1. Using the Task Type dropdown, select BT and click Add Task. 
	2. In the BT Task window, start by clicking Browse… and selecting the torrent file you wish to start.
	3. Next, select the destination folder from the Destination Folder dropdown. This is where the download will reside.
	4. Next, you can select the maximum and minimum number of peers from selecting the counts from the appropriate dropdowns.
	5. Next, you can set the maximum download and upload bandwidths from the dropdowns below.
	6. Press Apply to add the task.
	7. Once added, your download will appear in the list of download tasks. To start the download, simply click the Start icon () and the download will begin.
	8. The download status will continually update in the Download Tasks window. To pause the download, click the Pause icon (). 
	Deleting Tasks

	To delete a task, simply follow the steps below:
	1. Click the delete icon () beside the task that you wish to delete. The Delete Task dialogue box will appear.
	2. Select Delete Task only if you wish to remove only the torrent file and all transient files, leaving the unfinished download files intact.
	3. Select Delete Task and Files if you wish to remove the torrent file and all transient files, and the unfinished download files.
	4. Click OK to delete the task. Click Cancel to return to the Download Manager.
	Scheduling Downloads

	With the Download Manager, you can schedule your downloads to begin at different times of the day. This is useful if you wish to complete your downloads during off-peak hours, reserving your bandwidth for other applications. A table describing the Download Schedule window appears below:
	To schedule downloads, follow these steps:
	1. Under Download Schedule, set Scheduler to Enable.
	2. To schedule a daily download period, select Daily and select a start time and end time. 
	To schedule a weekly download period, select Weekly and select a start day/time and end time/day. 
	3. Click Apply to save your changes.
	Chapter 6: Using the N8800
	Overview

	Once the N8800 is setup and operating, users on the network may manage all varieties of digital music, photos, or files by simply using their web browsers. To manage your personal files or access public files on the N8800, just enter its IP address into your browser (default IP address is http://192.168.1.100), and you will be taken to the N8800 Login page.
	Login Page

	To login to the system, enter your user name and password, and select Web Disk or Photo server then click Login to log into the system. You will be taken to the selected interface.
	Using WebDisk

	The N8800 provides a WebDisk function that allows you to access the system over the Internet from any browser.
	1. In the Login page, type in the User ID and password that were previously set for you in the Accounts menu. See Chapter 4: System Management > User and Group Management > Local User Configuration.
	2. The WebDisk page appears showing folders made currently available to you via the Access Control List (ACL).
	3. Click on a folder name to enter the folder. 
	4. The folder’s page appears displaying files and folders. Click on a file to download the file.
	5. Buttons on the folder page allow you to create a new folder, upload files and delete files in the folder.
	6. To create a new folder within the current folder, press the New folder button. When the screen appears enter a name for the folder. Press OK to create the folder.
	7. To upload a file from your computer to the current folder, press the New file (upload) button. When the screen appears, press Browse and locate the file to upload. Press OK and the file is uploaded to the current folder.
	8. To delete a file or folder, select the file or folder’s check box. Press the Delete selected items button. You can also check the check box as the red circle indicates to select all files and folders in this folder.
	To access folders with access control, you must first login with a local user account.
	For more information on how to setup user rights to the folders, please check Chapter 4: System Management > Folder Management > Folder Access Control List (ACL). 
	Photo Server

	Using the Photo Server, users can view and share photos, and even create their own albums right on the N8800. 
	You will see your own Photo Gallery and all public Photo Albums on the network.
	To manage any picture files, you must first select the item by clicking the box.
	Windows XP Publishing Wizard

	There are many ways for a local user to upload pictures into their photo album. Users of Windows XP can upload their pictures using the Windows XP Publishing Wizard.
	1. Click on the XP Publishing Wizard icon on top right corner.
	2. The XP Web Publishing Wizard Client screen appears. Click on the link to install the Publishing Wizard. 
	3. Windows XP will ask whether you want to run or save this file. Click Save to save the register file. .
	4. Once the register file is installed, use the Windows file manager to browse the folder that contains the picture you want to publish. On the left pane, there will be an icon labeled “Publish this folder to the Web”. 
	5. Click on this icon and Web Publishing Wizard will start. 
	6. Select the pictures you want to publish to the Photo Web Server by placing a check mark on the top left hand corner of the picture. Click Next. 
	7. Your PC will start to connect to the Photo Web Server.
	8. Select N8800 Photo Gallery Wizard to publish your pictures to the N8800. 
	9. Login into the N8800 with your local user name and password.
	10. Create your album by entering an album name and clicking on the Create Album button. 
	11. Select the album you want to upload your pictures to.
	12. Confirm the target album. 
	13. Windows will show you that the picture upload is in progress.
	14. When the upload is finished, the Wizard will ask you whether if you want to go to the website. Click Finish to go to your Photo Web Server.
	15. Click on the user’s icon to go to that user’s album. 
	16. You will see the user’s album list. Click on Album. 
	17. Finished! You will see the pictures just selected in the album. 
	Managing Albums and Photos
	Creating Albums

	To create a photo album, follow the steps below:
	1. Click the Add button to create a new album.
	2. Enter a name for the album, and enter a description if you wish. Then, click on the Create Album button.
	Password Protecting Albums

	If you would like to put a password on a particular album, follow these steps:
	1. Select the album to be protected, click on the Edit button, and the Album Edit screen will appear. 
	2. The owner of the album can enter an album password to protect the album, so that only people with the correct password can view the album. 
	Uploading Pictures to Albums

	Uploading pictures to albums using the Web User Interface is easy:
	1. When the album is created, click the album icon to enter the album. Initially the album is empty. 
	2. Click the Add button to upload pictures into the album. The Upload Photos screen will appear. Users can select and upload up to 8 pictures at a time.
	3. Once the picture is uploaded, you can view it in the album. The owner of the album can delete or modify the pictures with the Delete or Modify buttons on the top right hand corner
	EXIF Information

	While viewing pictures, you can also have the N8800 display the EXIF information for each photo.
	Simply click the EXIF button to display EXIF information. To hide this information, click the EXIF button again.
	Slide Shows

	Slide shows are a great way to enjoy pictures stored on your N8800. 
	You can click on the Start Slide Show icon on the top right hand corner to start the slide show.
	To stop the slide show, click on the Stop Slide Show icon on the top right hand corner. 
	Mapping a Client PC to the N8800

	You can map share folders on the N8800 so that you can access them as if they were drives on your computer. You can connect to the shared network folders on the N8800 as follows: 
	Windows

	1. Go to the My Computer folder in Windows.
	2. In the menu bar, select Tools and then Map Network Drive…
	3. The Map Network Drive window appears.
	4. Assign a drive letter for the share folder.  
	5. Click the Browse button to find the folder over your network. Alternatively, you may enter the folder name you wish to connect to or enter its IP address. (i.e. \\192.168.1.100\share)
	6. Click Finish. When the Connect As… window appears, enter your user name and password.
	7. Click OK. The share folder appears as the drive you assigned. You can now access this folder as though it were a drive on your computer. 
	Apple OS X

	On an Apple computer, you can connect to shared computers and servers using a network address. 
	1. Choose Go > Connect to Server…
	2. Enter the network address for the server in the Server Address text box.
	When connecting using SMB/CIFS protocol, type:
	smb://192.168.1.100/Folder1
	When connecting using AFP protocol, type:
	afp://192.168.1.100/Folder1
	Click Connect.
	3. When MAC OS X is trying to connect N8800, it will ask for a User Name and Password which has access to the folder.
	4. When MAC OS X has connected to the N8800 successfully, an icon representing the folder will appear on the MAC OS X desktop. You can access the folder by double clicking on the icon.
	Mapping the N8800 as an iSCSI Drive

	With the N8800, you are able to map it as an iSCSI drive. With iSCSI, you can remotely access the N8800 at great speeds, as if it were installed as a local drive in your computer. 
	To do this, simply follow the steps below:
	Windows 2000/XP

	1. First, download the iSCSI Initiator from the Microsoft website (http://www.microsoft.com). You can find this software by entering iSCSI Initiator into the search box on their homepage.
	2. Once the download is complete, install the iSCSI Initiator by double-clicking the EXE file. You may be presented with the following security warning. Click Run to continue.
	3. You will now install the iSCSI Initiator using the Setup Wizard. Click Next to continue.
	4. Leave the default selections and click Next.
	5. Read the license agreement. To continue with the installation, click I Agree and then click Next.
	6. The iSCSI Initiator will now install automatically. Click Finish once completed.
	7. Start the iSCSI Initiator by double-clicking its icon on the desktop. The iSCSI Initiator properties window will appear.
	8. Select the Discovery tab. Under Target Portals, click Add.
	9. Enter the IP address of the N8800. Click OK.
	10. On the iSCSI Initiator Properties window, select the Targets tab. With the iSCSI target highlighted, click Log On. The Log On to Target dialogue will appear.
	11. If you have not enabled CHAP, click OK to continue.
	If you have enabled CHAP, click Advanced. Under Advanced Settings, check the CHAP login information checkbox and enter your username and password. Click OK. 
	12. Right click My Computer on the desktop and select Manage.
	13. Click on Disk Management and you will see a new hard disk listed.
	14. Initialize the new hard disk and you will then be able to use the iSCSI target as a local drive.
	Windows Vista

	Because Windows Vista has the Microsoft iSCSI Initiator pre-installed, you will not have to install this piece of software. Instead, start the iSCSI Initiator and follow steps 8-14 to map the N8800 as an iSCSI drive.
	File Backup

	There are a number of ways to back up data with the N8800. 
	Nsync

	You can backup a share folder to another N8800 (Nsync Target) or any FTP server for safe keeping as long as you have appropriate access right on that target. When using Nsync between two N8800s, you have the option to transmit files securely between two N8800s. 
	If the files on your N8800 are lost for any reason, you can restore those files from the target N8800. To backup files regularly, you can set up a scheduled task to run only once, daily, weekly, or monthly. You can also limit the bandwidth of your Nsync tasks, so other users on the network can share the bandwidth equally.
	Under the Storage menu, click Nsync and the Nsync window appears. Below is a description of each field:
	Adding an Nsync Task

	From the Nsync Information screen, click Add to display the Add Nsync Task screen.
	Setting Up an Nsync Target on an Nsync Device

	On the Nsync target server, the administrator of that server has to set up a user account with a folder named “nsync” and grant write access.
	1. On the Nsync server, add a user for Nsync source (ex. nsyncsource1). For instructions on how to add a user on the N8800, see Chapter 4: System Management > User and Groups Management > Local User Configuration > Adding Users.
	2. On the Nsync server, grant that user (ex. nsyncsource1) write access to the nsync folder. For instructions on how to set up a folder’s ACL, see Chapter 4: System Management > Folder Management > Folder Access Control List (ACL).
	3. Once this is done, the target server will start accepting Nsync tasks from server using that ID and password.
	Setting Up an Nsync Target on Another Device

	If you selected “Other Device” when setting up your Nsync task, the N8800 will use the FTP protocol to back up the share folder. On the external storage device, make sure there is a folder named “nsync”, and the Auth ID has writable permission in that folder.
	Designating N8800 as an Nsync Target

	The N8800 can act as an Nsync server, enabling another Nsync-equipped Thecus NAS at a remote location backup their files to this N8800. From the Network menu, choose the Nsync Target item, and the Nsync Target Server Setting screen appears.
	Thecus Backup Utility

	The Thecus Backup Utility is on your Installation CD. When you click on the CD, the Backup Utility will be installed under Program Groups > Thecus > Thecus Backup Utility. If it is not installed, you can copy the file (Thecus Backup Utility.exe) to a convenient location on your hard disk and double click to execute it.
	When you execute this utility for the first time, it will ask you whether to create a DB file. Click Yes.
	1. Click Add to create a Backup task. The Add New Task dialog box appears.
	2. To schedule the task to run at regular intervals, click on the Schedule icon for that task. You can schedule the task to run Monthly or Weekly.
	3. To check the log for that task, click on the Log icon for that task.
	Windows XP Data Backup

	If you use Windows XP Professional, you can also use the Windows Backup Utility (Ntbackup.exe) to backup your files.
	If you use Windows XP Home Edition, follow these steps to install the utility:
	1. Insert the Windows XP CD into a drive and double-click the CD icon in My Computer.
	2. When the Welcome to Microsoft Windows XP screen appears, click Perform Additional Tasks. 
	3. Click Browse this CD. 
	4. In Windows Explorer, navigate to ValueAdd > Msft > Ntbackup. 
	5. Double-click Ntbackup.msi to install the backup utility.
	Once installed, you can use the Windows Backup Utility by following the steps below:
	1. Click Start, and point to All Programs > Accessories > System Tools > Backup to start the wizard.
	2. Click Next to skip past the opening page. Choose Backup files and settings from the second page, and then click Next. 
	3. Select which option you want to back up.
	4. Click Next and in the Backup Type, Destination, and Name page, specify a back up location using the Browse button.
	5. Find and select the drive that specifies your N8800 as your backup destination and click Next.
	6. Click Next to display the wizard’s final page and click Finish to start backing up. 
	Apple OS X Backup Utilities

	Mac OS X does not include any backup software. However, there are a number of backup solutions available for the Mac OS X, including: iBackup, Psyncx, iMSafe, Rsyncx, Folder Synchronizer X, Tri-BACKUP, Impression, Intego Personal Backup, SilverKeeper, and Apple's dotMac Backup utility to name just a few. To find even more freeware and shareware backup utilities to choose from, go to VersionTracker or MacUpdate and search on "backup".
	Chapter 7: Tips and Tricks
	USB and eSATA Storage Expansion

	The N8800 supports external USB hard disks through its four USB ports. Once a USB hard disk has successfully mounted, the entire volume will be copied automatically to the default USB HDD folder. The N8800 supports up to 4 USB external storage devices. All file names on the USB disk volume are case sensitive.
	The N8800 also supports eSATA hard disks with its eSATA port.
	Before attaching an eSATA or USB disk drive to N8800, you have to partition and format it on a desktop computer or a notebook first. The attached device will be located at \\192.168.1.100\usbhdd\sdf1 where 192.168.1.100 means the IP address of N8800 and sdf1 stands for the first partition on disk #6, the eSATA or USB disk drive. If it is an NTFS partition, NAS users can open or copy files from \\192.168.1.100\usbhdd\sdf1 but cannot add new files or modify existing files. 
	Adding a Spare Disk 

	With a RAID 1, RAID 5, RAID 6, or RAID 10 volume, you can add a spare disk after the initial RAID is setup. To add a spare disk, follow the steps below:
	1. On the RAID Configuration Screen, tick the checkbox of the hard disk you wish to designate as a spare disk.
	2. Click Add Spare. The disk will be configured as a spare disk. The system automatically rebuilds the spare disk when one of the disks in the RAID set fails. 
	Remote Administration

	You can set up your N8800 for remote administration. With remote administration, you can access your N8800 over the Internet, even if your N8800 is behind a router. This is especially useful if you are traveling and suddenly need a file from your N8800. 
	Setting up remote administration is a three-part process, and will require the following equipment:
	 Thecus N8800 NAS device
	 Cable/DSL Router with Dynamic DNS support
	 Home PC
	 Internet Connection
	Part I - Setup a DynDNS Account

	1. Go to http://www.dyndns.org from your home PC.
	2. Click on the Sign Up Now link.
	3. Check the Check boxes, select a user name (i.e.: N8800), enter your email address (i.e.: xxx@example.com), check Enable Wildcard, and create a password (i.e.: xxxx).
	4. Wait for an email from www.dyndns.org.
	5. Open the email and click on the link to activate your account
	Part II - Enable DDNS on the Router

	1. Go to the router setup screen and select IP Config > Miscellaneous DDNS Setting from your Home PC.
	2. Click on Yes for Enable the DDNS Client?
	3. Select www.dyndns.org.
	4. Go to router setup screen, and enter the following information:
	a. User Name or E-mail Address: xxx@example.com
	b. Password or DDNS Key: xxxx
	c. Host Name: www.N8800.dyndns.org
	d. Enable wildcard? Select Yes
	e. Update Manually: Click Update
	Part III - Setting up Virtual Servers (HTTPS)

	1. Navigate to NAT Setting > Virtual Server.
	2. For Enable Virtual Server?, select Yes
	3. Setup the HTTPS Server
	a. Well-Known Applications: Select User Defined
	b. Local IP: Enter 192.168.1.100
	c. Port Range: 443 (the default HTTPS port setting on the N8800)
	d. Protocol: select TCP
	e. Click Add.
	f. Click Apply.
	4. Test the HTTPS connection from another computer on the Internet
	a. From a remote computer, open your browser and enter https://www.N8800.dyndns.org
	b. You should see the login page of N8800.
	Firewall Software Configuration

	If you are using a software firewall (i.e. Norton Internet Security) and are having trouble connecting to the N8800, you can try the following steps:
	1. Double click the NIS icon on system tray, and then configure the Personal Firewall.
	2. On the Programs page, find the SetupWizard.exe and change its permission to "Permit All". If it's not in the program list, use the Add or Program Scan buttons to find it.
	3. On the Networking page, manually add N8800 IP address (i.e. 192.168.1.100) to the Trusted list. 
	Replacing Damaged Hard Drives

	If you are using RAID 1, RAID 5, RAID 6, or RAID 10, you can easily replace a damaged hard drive in the Thecus N8800 while keeping your data secure with the system’s automatic data recovery. 
	Hard Drive Damage

	When a hard drive is damaged and data in the RAID volume, the system LCD will display warning message also the system beeps.
	Replacing a Hard Drive 

	To replace a hard disk drive in the N8800:
	1. Remove the tray with the damaged hard disk.
	2. Unscrew the damaged hard disk and remove it from the tray.
	3. Slide a new hard disk into the tray and fasten the screws.
	4. Insert the hard disk tray back into the N8800 until it snaps into place. You can also lock it with a key if desired.
	5. The LED blinks green when the HDD is accessed.
	RAID Auto-Rebuild

	When using RAID 1, 5, 6, or 10 on the N8800, you can use the auto-rebuild function when an error is detected. 
	1. When a hard disk fails the system beeps and/or an email notification is sent to specified receivers.
	2. Check the LCD to see which disk has failed.
	3. Follow the steps mentioned above to replace the failed hard disk.
	4. The system automatically recognizes the new hard disk and starts the auto-rebuild sequence to resume its status before the hard disk crash.
	Chapter 8: Troubleshooting
	Forgot My Network IP Address

	If you forget your network IP address and have no physical access to the system, you can find out the IP address by either looking directly onto the N8800’s LCD panel, or by using the setup wizard to retrieve the IP of your N8800.
	1. Start the Setup Wizard, and it will automatically detect all Thecus IP storage products on your network.
	2. You should be able to find the IP address of the N8800 which you have forgotten in the Device Discovery screen.
	Can't Map a Network Drive in Windows XP

	You may have problems mapping a network drive under the following conditions:
	1. The network folder is currently mapped using a different user name and password. To connect using a different user name and password, first disconnect any existing mappings to this network share.
	2. The mapped network drive could not be created because the following error has occurred: Multiple connections to a server or shared resource by the same user, using more than one user name, are not allowed. Disconnect all previous connections to the server or shared resource and try again.
	To check out existing network connections, type net use under the DOS prompt. 
	You may refer the URL below for more network mapping information. 
	http://esupport.thecus.com/support/index.php?_m=downloads&_a=viewdownload&downloaditemid=57&nav=0
	Restoring Factory Defaults

	From the System menu, choose the Factory Default item and the Reset to Factory Default screen appears. Press Apply to reset the N8800 to factory default settings.
	Problems with Time and Date Settings

	The administrator is able to select an NTP Server to keep the N8800’s time synchronized. However, if the N8800 can not access the Internet, you may encounter a problem when setting the Time and Time Zone. If this happens:
	1. Login to the Web Administration Interface.
	2. Navigate to System > Time.
	3. Under NTP Server, select No.
	4. Set the Date, Time, and Time Zone.
	5. Click Apply.
	In addition, if the N8800 is able to access the Internet and you want to keep the NTP Server clock.isc.org by default, please make sure the DNS Server is correctly entered, thereby allowing the NTP Server name to correctly resolve. (See Network > WAN > DNS Server)
	Appendix A: Product Specifications
	Hardware Specifications
	Software Specifications

	*AD support: Works as a client member in a Microsoft Active Directory domain, allowing the N8800 to utilize the domain users and groups setting for authentication to the system and authorization to the share folders.
	**For supported USB dongles, please contact sales@thecus.com
	Appendix B: Customer Support
	If your N8800 is not working properly, we encourage you to check out Chapter 8: Troubleshooting, located in this manual. You can also try to ensure that you are using the latest firmware version for your N8800. Thecus is committed to providing free firmware upgrades to our customers. Our newest firmware is available on our Download Center:
	http://www.thecus.com/download.php
	If you are still experiencing problems with your N8800, or require a Return Merchandise Authorization (RMA), feel free to contact technical support via our Technical Support Website:
	http://www.thecus.com/support_tech.php
	Customers in the US should send all technical support enquiries to this email address:
	support-us@thecus.com
	For Sales Information you can e-mail us at:
	sales@thecus.com
	Thank you for choosing Thecus!
	Appendix C: RAID Basics
	Overview

	A Redundant Array of Independent Disks (RAID) is an array of several hard disks that provide data security and high performance. A RAID system accesses several hard disks simultaneously, which improves I/O performance over a single hard disk. Data security is enhanced by a RAID, since data loss due to a hard disk failure is minimized by regenerating redundant data from the other RAID hard disks.
	Benefits

	RAID improves I/O performance, and increases data security through fault tolerance and redundant data storage.
	Improved Performance

	RAID provides access to several hard disk drives simultaneously, which greatly increases I/O performance.
	Data Security

	Hard disk drive failure unfortunately is a common occurrence. A RAID helps prevent against the loss of data due to hard disk failure. A RAID offers additional hard disk drives that can avert data loss from a hard disk drive failure. If a hard drive fails, the RAID volume can regenerate data from the data and parity stored on its other hard disk drives.
	RAID Levels

	The Thecus N8800 supports standard RAID levels 0, 1, 5, 6, 10, and JBOD. You choose a RAID level when you create a system volume. The factors for selecting a RAID level are:
	 Your requirements for performance
	 Your need for data security
	 Number of hard disk drives in the system, capacity of hard disk drives in the system
	The following is a description of each RAID level:
	RAID 0

	RAID 0 is best suited for applications that need high bandwidth but do not require a high level of data security. The RAID 0 level provides the best performance of all the RAID levels, but it does not provide data redundancy. 
	RAID 0 uses disk striping and breaking up data into blocks to write across all hard drives in the volume. The system can then use multiple hard drives for faster read and write. The stripe size parameter that was set when the RAID was created determines the size of each block. No parity calculations complicate the write operation. 
	RAID 1

	RAID 1 mirrors all data from one hard disk drive to a second one hard disk drive, thus providing complete data redundancy. However, the cost of data storage capacity is doubled. 
	This is excellent for complete data security.
	RAID 5

	RAID 5 offers data security and it is best suited for networks that perform many small I/O transactions at the same time, as well as applications that require data security such as office automation and online customer service. Use it also for applications with high read requests but low write requests.
	RAID 5 includes disk striping at the byte level and parity information is written to several hard disk drives. If a hard disk fails the system uses parity stored on each of the other hard disks to recreate all missing information.
	RAID 6

	RAID 6 is essentially an extension of RAID level 5 which allows for additional fault tolerance by using a second independent distributed parity scheme (dual parity)
	Data is striped on a block level across a set of drives, just like in RAID 5, and a second set of parity is calculated and written across all the drives; RAID 6 provides for an extremely high data fault tolerance and can sustain two simultaneous drive failures.
	This is a perfect solution for mission critical applications.
	RAID 10

	RAID 10 is implemented as a striped array whose segments are RAID 1 arrays. RAID 10 has the same fault tolerance as RAID level 1.
	RAID 10 has the same overhead for fault-tolerance as mirroring alone. High I/O rates are achieved by striping RAID 1 segments.
	Under certain circumstances, RAID 10 array can sustain up to 2 simultaneous drive failures
	Excellent solution for applications that would have otherwise gone with RAID 1 but need an additional performance boost.
	JBOD

	Although a concatenation of disks (also called JBOD, or "Just a Bunch of Disks") is not one of the numbered RAID levels, it is a popular method for combining multiple physical disk drives into a single virtual one. As the name implies, disks are merely concatenated together, end to beginning, so they appear to be a single large disk.
	As the data on JBOD is not protected, one drive failure could result total data loss.
	Stripe Size

	The length of the data segments being written across multiple hard disks. Data is written in stripes across the multiple hard disks of a RAID. Since multiple disks are accessed at the same time, disk striping enhances performance. The stripes can vary in size.  
	Disk Usage

	When all 8 disks are of the same size, and used in RAID, N8800 disk usage percentage is listed below:
	Appendix D: Active Directory Basics
	Overview

	With Windows 2000, Microsoft introduced Active Directory (ADS), which is a large database/information store. Prior to Active Directory the Windows OS could not store additional information in its domain database. Active Directory also solved the problem of locating resources; which previously relied on Network Neighborhood, and was slow. Managing users and groups were among other issues Active Directory solved.
	What is Active Directory?

	Active Directory was built as a scalable, extensible directory service that was designed to meet corporate needs. A repository for storing user information, accounts, passwords, printers, computers, network information and other data, Microsoft calls Active Directory a "namespace" where names can be resolved.
	ADS Benefits

	ADS lets the N8800 integrate itself with the existing ADS in an office environment. This means the N8800 is able to recognize your office users and passwords on the ADS server. Other major benefits ADS support provides include:
	1. Easy integration of the N8800 into the existing office IT infrastructure
	The N8800 acts as a member of the ADS. This feature significantly lowers the overhead of the system administrator. For example, corporate security policies and user privileges on an ADS server can be enforced automatically on the N8800.
	2. Centralized user/password database
	The N8800 does not maintain its own copy of the user/password database. This avoids data inconsistency between the N8800 and other servers. For example, without ADS support, an administrator might need to remove a specific user privilege on the N8800 and each individual server. With ADS support, the change on an ADS server is known to all of its ADS members.
	Appendix E: UPS Compatibility List
	Brand
	Series
	Model
	Notes
	Ablerex
	MS-RT
	 
	 
	ActivePower
	1400VA
	 
	 
	AEC
	MiniGuard UPS 700 M2501 cable
	 
	 
	APC
	Back-UPS Pro
	 
	 
	Matrix-UPS
	 
	 
	Smart-UPS
	 
	 
	Back-UPS
	940-0095A/C cables, 940-0020B/C cables, 940-0023A cable
	 
	Back-UPS Office
	940-0119A cable
	 
	Masterswitch Not a UPS - 940-0020 cable
	 
	 
	Back-UPS RS 500 custom non-USB cable
	 
	 
	Belkin
	Regulator Pro serial
	 
	 
	Resource
	 
	 
	Home Office
	F6H350-SER, F6H500-SER, F6H650-SER
	 
	Universal UPS
	F6C800-UNV, F6C120-UNV, F6C1100-UNV, F6H500ukUNV
	 
	Best Power
	Fortress (newer)
	 
	 
	Fortress Telecom
	 
	 
	Axxium Rackmount
	 
	 
	Patriot Pro
	 
	 
	Patriot Pro II
	 
	 
	Patriot INT51 cable
	 
	 
	Micro-Ferrups
	 
	 
	Fortress/Ferrups f-command support
	 
	 
	Centralion
	Blazer
	 
	 
	Clary
	ST-800
	 
	 
	Compaq
	T1500h
	 
	 
	Cyber Power Systems
	 
	320AVR, 500AVR, 650AVR, 700AVR, 800AVR850AVR, 900AVR, 1250AVR,. 1500AVR, Power99550SL, 725SL, CPS825VA, 1100AVR, 1500AVR-HO
	 
	Deltec
	PowerRite Pro II
	 
	 
	Dynex
	975AVR
	 
	 
	Effekta
	MI/MT/MH 2502 cable
	 
	 
	Energy Sistem
	(various)
	 
	 
	ETA
	mini+UPS WinNT/Upsoft cable
	 
	 
	ETA
	mini+UPS PRO UPS Explorer cable
	 
	 
	Ever UPS
	NET *-DPC
	 
	 
	AP *-PRO
	 
	 
	Ever-Power
	625/1000
	 
	 
	Exide
	NetUPS SE
	 
	 
	Fenton Technologies
	PowerPal P-series
	 
	 
	PowerPal L-series
	 
	 
	PowerOn
	 
	 
	PowerPure
	 
	 
	Fairstone
	 
	L525/L625/L750
	 
	Fideltronik
	Ares 700 and larger
	 
	 
	Other Ares models
	 
	 
	Fiskars
	PowerRite MAX
	 
	 
	PowerServer
	10, 30
	 
	Gamatronic
	All models with alarm interface
	 
	 
	MP110/210
	 
	 
	MS-T
	 
	 
	MS
	 
	 
	µPS3/1
	 
	 
	Gemini
	UPS625/UPS1000
	 
	 
	HP
	R3000 XR
	 
	 
	R5500 XR
	 
	 
	INELT
	Monolith 1000LT
	 
	 
	Infosec
	iPEL
	350, 500, 750, 1000
	 
	Ippon
	(various)
	 
	 
	Liebert
	UPStation GXT2 contact-closure cable
	 
	 
	Masterguard
	(various)
	 
	 
	Meta System
	HF Line
	1..4 boards, /2 5..8 boards
	 
	HF Millennium
	810, 820
	 
	HF TOP Line
	910, 920, 930, 940, 950, 960, 970, 980
	 
	ECO Network
	750, M1000, M1050, M1500, M1800M2000, M2100, M2500, M3000
	 
	ECO
	305, 308, 311, 511, 516, 519, 522
	 
	ally HF
	800, 1000, 1250, 1600, 2000, 2500
	 
	Megaline
	1250, 2500, 3750, 5000, 6250, 7500, 8750, 10000
	 
	MGE UPS SYSTEMS
	NOVA AVR 600 Serial
	 
	 
	NOVA AVR 1100 Serial
	 
	 
	Pulsar Ellipse
	USBS Serial cable, S, Premium USBS Serial cable, Premium S
	 
	Ellipse Office
	600 Serial cable, 750 Serial cable, 1000 Serial cable, 1500 Serial cable
	 
	Pulsar EXtreme C / EX RT
	 
	 
	Comet EX RT 
	Serial port, 3:1 Serial port
	 
	Pulsar Esprit
	 
	 
	Evolution S
	1250, 1750, 2500, 3000
	Serial Port
	Pulsar M
	2200, 3000, 3000 XL
	Serial Port
	Pulsar
	700, 1000, 1500, 1000 RT2U, 1500 RT2U, MX 4000 RT, MX 5000 RT
	Serial Port
	Evolution, EXtreme C, ES+, ESV+, SV, ESV, EX, EXL, PSX, SX, Extreme
	Comet EXtreme
	 
	 
	Comet / Galaxy (Serial) 
	Utalk Serial Card (ref 66060), HID COM Serial Card (ref 66066)
	 
	MicroDowell
	B.Box BP
	500, 750, 1000, 1500
	 
	Microsol
	Solis
	1.0 1000VA, 1.5 1500VA, 2.0 2000VA, 3.0 3000VA
	 
	Rhino
	6.0 6000VA, 7.5 7500VA, 10.0 10000VA, 20.0 20000VA
	 
	Mustek
	Various
	 
	 
	Powermust
	400VA Plus, 600VA Plus, 800VA Pro1000VA Plus, 1400VA Plus, 2000VA USB
	 
	Nitram
	Elite
	500, 2002
	 
	Oneac
	EG/ON Series advanced interface
	 
	 
	Online
	P-Series
	 
	 
	OnLite
	AQUA 50
	 
	 
	Orvaldi
	various not 400 or 600
	 
	 
	Powercom
	Powercom
	SMK-800A
	 
	 
	ULT-1000
	 
	 
	TrustTrust 425/625
	 
	 
	BNT-1000AP
	 
	 
	Advice Partner/King Pr750
	 
	 
	BNT-2000AP
	 
	 
	PowerGuard
	PG-600
	 
	 
	PowerKinetics
	9001
	 
	 
	PowerTech
	Comp1000 DTR cable power
	 
	 
	Power Walker
	Line-Interactive VI1000
	 
	 
	Powerware
	 
	3110, 3115, 5119, 5125, 5119 RM, PW5115PW5125PW9120, PW9125, 9120, 9150, 9305
	 
	Powerwell
	PM525A/-625A/-800A/-1000A/-1250A
	 
	 
	Repotec
	RPF525/625/800/1000
	 
	 
	RPT-800A
	 
	 
	RPT-162A
	 
	 
	SMS (Brazil)
	Manager III
	 
	 
	SOLA
	 
	325, 520, 610, 620, 330
	 
	SOLA/BASIC Mexico
	various ISBMEX protocol
	 
	 
	Socomec Sicon
	Egys 420 VA
	 
	 
	Soltec
	Winmate 525/625/800/1000
	 
	 
	Soyntec
	Sekury C
	500, 800
	 
	SquareOne Power
	QP1000
	 
	 
	SuperPower
	HP360, Hope-550
	 
	 
	Sweex
	500/1000 smart - shipped with SafeNet
	 
	 
	500/1000 contact closure - shipped with UPSmart
	 
	 
	BC100060 800VA
	 
	 
	Sysgration
	UPGUARDS Pro650
	 
	 
	Tecnoware
	Easy Power 1200
	 
	 
	Tripp-Lite
	SmartUPS
	 
	 
	SmartOnline
	 
	 
	(various) Lan 2.2 interface - black 73-0844 cable
	 
	 
	Trust
	UPS 1000 Management PW-4105
	 
	 
	UNITEK
	Alpha
	500 IC, 1000is, 500 ipE
	 
	UPSonic
	LAN Saver 600
	 
	 
	Power Guardian
	 
	 
	Victron/IMV
	(various)
	 
	 
	Lite crack cable
	 
	 
	Appendix F: Licensing Information
	Overview

	This product included copyrighted third-party software licensed under the terms of GNU General Public License. Please see THE GNU General Public License for extra terms and conditions of this license.
	Source Code Availability

	Thecus Technology Corp. has exposed the full source code of the GPL licensed software. For more information on how you can obtain our source code, please visit our web site, http://www.thecus.com.
	Copyrights 
	 This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).
	 This product includes software developed by Mark Murray.
	 This product includes software developed by Eric Young (eay@cryptsoft.com).
	 This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/).
	 This product includes PHP, freely available from (http://www.php.net/).
	 This product includes software developed by the University of California, Berkeley and its contributors.
	 This product includes software developed by Winning Strategies, Inc.
	 This product includes software developed by the Apache Group for use in the Apache HTTP server project (http://www.apache.org/).
	 This product includes software developed by Softweyr LLC, the University of California, Berkeley, and its contributors.
	 This product includes software developed by Bodo Moeller.
	 This product includes software developed by Greg Roelofs and contributors for the book, "PNG: The Definitive Guide," published by O'Reilly and Associates.
	 This product includes software developed by the NetBSD Foundation, Inc. and its contributors.
	 This product includes software developed by Yen Yen Lim and North Dakota State University.
	 This product includes software developed by the Computer Systems Engineering Group at Lawrence Berkeley Laboratory.
	 This product includes software developed by the Kungliga Tekniska Högskolan and its contributors.
	 This product includes software developed by the Nick Simicich.
	 This product includes software written by Tim Hudson (tjh@cryptsoft.com).
	 This product includes software developed by Christopher G. Demetriou for the NetBSD Project.
	CGIC License Terms

	Basic License
	CGIC, copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by Thomas Boutell and Boutell.Com, Inc.
	Permission is granted to use CGIC in any application, commercial or noncommercial, at no cost. HOWEVER, this copyright paragraph must appear on a "credits" page accessible in the public online and offline documentation of the program. Modified versions of the CGIC library should not be distributed without the attachment of a clear statement regarding the author of the modifications, and this notice may in no case be removed. Modifications may also be submitted to the author for inclusion in the main CGIC distribution.
	GNU General Public License

	Version 2, June 1991
	Copyright © 1989, 1991 Free Software Foundation, Inc.
	51 Franklin St, Fifth Floor, Boston, MA  02110-1301  USA
	Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
	PREAMBLE
	The licenses for most software are designed to take away your freedom to share and change it.  By contrast, the GNU General Public License is intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users.  This General Public License applies to most of the Free Software
	Foundation's software and to any other program whose authors commit to using it.  (Some other Free Software Foundation software is covered by the GNU Library General Public License instead.)  You can apply it to your programs, too.
	When we speak of free software, we are referring to freedom, not price.  Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and that you know you can do these things.
	To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.
	For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you have. You must make sure that they, too, receive or can get the source code.  And you must show them these terms so they know their rights.
	We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute and/or modify the software.
	Also, for each author's protection and ours, we want to make certain that everyone understands that there is no warranty for this free software.  If the software is modified by someone else and passed on, we want its recipients to know that what they have is not the original, so that any problems introduced by others will not reflect on the original authors' reputations.
	Finally, any free program is threatened constantly by software patents.  We wish to avoid the danger that redistributors of a free program will individually obtain patent licenses, in effect making the program proprietary.  To prevent this, we have made it clear that any patent must be licensed for everyone's free use or not licensed at all.
	The precise terms and conditions for copying, distribution and modification follow.
	TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
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